BD FACSaria II
User’s Guide
FCC Information

WARNING: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his or her own expense.

Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits.

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Change Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>643245</td>
<td>12/07</td>
<td>Initial release</td>
</tr>
</tbody>
</table>
Contents

Conventions ................................................................. xiv
Technical Assistance ....................................................... xv
Limitations .................................................................. xvi

Chapter 1: Cytometer Components 17

Fluidics Cart ................................................................. 18
  Containers and Connectors ............................................. 18
  Connecting to an External Air Supply .......................... 20
  Power and Operation .................................................. 21
Flow Cytometer ............................................................. 22
  Fluidics Components ................................................... 23
  Optics System ............................................................ 33
  Cytometer Electronics ................................................ 39
  Emergency Stop Button .............................................. 40
Workstation ................................................................. 41

Chapter 2: Theory of Operation 43

Fluid Movement ........................................................... 44
  Sheath Flow ............................................................. 44
  Sample Flow ........................................................... 46
Signal Generation .......................................................... 48
  Light Scatter ........................................................... 48
  Fluorescent Signals ................................................... 49
Signal Detection ............................................................ 50
Starting the Stream ........................................ 118
Setting Up the Breakoff ................................. 119
Setting Up the Fluidics Cart ......................... 122
Checking Cytometer Performance ................. 130
  Preparing the CS&T Workspace .................. 130
  Preparing the CS&T Beads ......................... 133
  Running a Performance Check .................... 134
  Reviewing the Results .......................... 134
Application Settings ................................. 136
  Creating Application Settings ................. 136
Data Collection ....................................... 144
  Setting Up the Workspace ....................... 144
  Calculating Compensation ....................... 148
Data Recording and Analysis ...................... 151
  Setting Up the Experiment ...................... 152
  Setting Up the Global Worksheet ............... 153
  Recording Data ................................. 155
  Analyzing Data ................................ 156
  Performing a Batch Analysis ................. 159

Chapter 5: Sorting .................................... 161
  Setting Up for Sorting .......................... 162
  Setting Up for Bulk Sorting ................. 164
Determining the Drop Delay – Manual Method ..... 166
  Setting Up the Experiment .................... 167
  Using Manual Drop Delay ....................... 168
Determining the Drop Delay – Automatic Method ..... 171
  Overview of Auto Drop Delay ............... 171
  Using Auto Drop Delay ....................... 171
Sorting .................................................. 173
  Setting Up the Experiment .................... 174
Lubricating the Sample Injection Chamber O-Ring ......................... 229
Using Custom Optical Filters ................................................. 230
Cleaning the Optical Filters ................................................. 231
Removing or Installing the FSC ND Filter ................................ 232

Chapter 7: Troubleshooting .................................................. 233
Troubleshooting the Stream .................................................. 234
Troubleshooting the Breakoff ............................................... 238
Sorting Troubleshooting ..................................................... 239
Acquisition Troubleshooting ................................................ 244
Fluidics Troubleshooting .................................................... 251
Electronics Troubleshooting ................................................ 252

Chapter 8: Technical Specifications ........................................ 253
Cytometer Specifications ..................................................... 254
Environment ................................................................. 254
Performance ................................................................. 255
Emission Optics ............................................................. 257
Fluidics Cart Specifications ................................................ 259

Appendix A: Supplies and Consumables .................................. 261
Cytometer Supplies .......................................................... 262
Optical Components ......................................................... 262
Accessory Kit ................................................................. 264
Other Replacement Parts ................................................... 266
Consumables ................................................................. 267
Cytometer Setup Particles ................................................... 267
Reagents ................................................................. 268
Labware ................................................................. 269

Appendix B: Near UV Laser Option ........................................ 271
System Laser Configurations ................................................. 272
<table>
<thead>
<tr>
<th>Specifications</th>
<th>273</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety</td>
<td>273</td>
</tr>
<tr>
<td>Operation</td>
<td>274</td>
</tr>
<tr>
<td>Selecting Optical Filters</td>
<td>274</td>
</tr>
<tr>
<td>Creating a Custom Configuration</td>
<td>275</td>
</tr>
<tr>
<td>Switching From the Violet to the Near UV Laser</td>
<td>276</td>
</tr>
<tr>
<td>Switching Back to the Violet Laser</td>
<td>277</td>
</tr>
<tr>
<td>Side Population Application Guidelines</td>
<td>278</td>
</tr>
<tr>
<td>Instrument Setup</td>
<td>278</td>
</tr>
<tr>
<td>Experiment Setup Tips</td>
<td>278</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>280</td>
</tr>
</tbody>
</table>

**Appendix C: BD Aerosol Management Option**

<table>
<thead>
<tr>
<th>Option Components</th>
<th>282</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evacuator</td>
<td>282</td>
</tr>
<tr>
<td>ULPA Filter</td>
<td>283</td>
</tr>
<tr>
<td>Operating the BD Aerosol Management Option</td>
<td>284</td>
</tr>
<tr>
<td>Starting Up the Evacuator</td>
<td>284</td>
</tr>
<tr>
<td>Setting Up for Sorting</td>
<td>287</td>
</tr>
<tr>
<td>Opening the Sort Collection Chamber Door</td>
<td>288</td>
</tr>
<tr>
<td>Turning Off the Evacuator</td>
<td>289</td>
</tr>
<tr>
<td>Maintenance</td>
<td>289</td>
</tr>
<tr>
<td>Replacing the ULPA Filter</td>
<td>290</td>
</tr>
<tr>
<td>Replacing the Air Filter</td>
<td>294</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>296</td>
</tr>
<tr>
<td>Control Panel Troubleshooting</td>
<td>296</td>
</tr>
<tr>
<td>Filter Flow Gauge Troubleshooting</td>
<td>298</td>
</tr>
<tr>
<td>Specifications</td>
<td>299</td>
</tr>
</tbody>
</table>

**Appendix D: Temperature Control Option**

| Option Components | 302 |

---

BD FACSaria II User’s Guide

Draft #5.1, October 2007
Using the BD Temperature Control Option ........................................... 303
Setting Up the Water Bath ................................................................. 303
Setting Up the Tube Holder ............................................................... 305
Setting Up the ACDU Stage ............................................................... 307
Starting Up the Water Bath ............................................................... 309
Maintenance ..................................................................................... 310
Tube Holders ..................................................................................... 310
Recirculating the Water Tubing ......................................................... 310
Specifications ................................................................................... 311

Appendix E: QC Using BD FACSDiva Software 313
Cytometer Quality Control Using BD FACSDiva Software ................. 314
Setting Up the Cytometer Configuration ........................................... 314
Preparing QC Particles ..................................................................... 316
Adjusting Area Scaling and Laser Delay .......................................... 316
Reusing the QC Experiment ............................................................. 328
Tracking QC Results ......................................................................... 329
THIS PAGE INTENTIONALLY LEFT BLANK
About This Guide

This user's guide contains the instructions necessary to operate and maintain your BD FACSArray™ II flow cytometer. Because many instrument functions are controlled by BD FACSDiva™ software, this guide also contains basic software information needed for instrument setup. To familiarize yourself with the software, do the tutorials in the Getting Started with BD FACSDiva Software guide. For detailed information on software features, refer to the BD FACSDiva Software Reference Manual.

The BD FACSArray II User's Guide assumes you have a working knowledge of basic Microsoft® Windows® operation. If you are not familiar with the Windows operating system, refer to the documentation provided with your computer.

New users of the BD FACSArray II flow cytometer should read:

- Chapter 1 to become familiar with instrument components
- Chapter 2 to understand how the instrument works and to learn about the software components used to control different subsystems
- Chapter 3 to see where software components are located

Instructions for routine acquisition, analysis, and sorting can be found in Chapters 4 and 5.

Once you become familiar with routine operation and need only a quick reminder of the main steps, use the quick reference guide provided with this user's guide.
Conventions

The following tables list conventions used throughout this guide. Table 1 lists the symbols that are used in this guide or on safety labels to alert you to a potential hazard. Text and keyboard conventions are shown in Table 2.

Table 1 Hazard symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Caution: hazard or unsafe practice that could result in material damage, data loss, minor or severe injury, or death</td>
</tr>
<tr>
<td>!</td>
<td>Electrical danger</td>
</tr>
<tr>
<td>!</td>
<td>Laser radiation</td>
</tr>
<tr>
<td>!</td>
<td>Biological risk</td>
</tr>
</tbody>
</table>

a. Although these symbols appear in color on the instrument, they are in black and white throughout this user’s guide; their meaning remains unchanged.

Table 2 Text and keyboard conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tip</strong></td>
<td>Highlights features or hints that can save time and prevent difficulties</td>
</tr>
</tbody>
</table>

**NOTE**

Describes important features or instructions

*Italics*

Italics are used to highlight book titles and new or unfamiliar terms on their first appearance in the text.

> The arrow indicates a menu choice. For example, “select File > Print” means to select Print from the File menu.

Ctrl+X When used with key names, a dash means to press two keys simultaneously. For example, Ctrl+P means to hold down the Control key while pressing the letter p.
Technical Assistance

For technical questions or assistance in solving a problem:

- Read the section of the user’s guide specific to the operation you are performing.
- See Chapter 7, Troubleshooting.

If additional assistance is required, contact your local BD Biosciences technical support representative or supplier.

When contacting BD Biosciences, have the following information available:

- Product name, part number, and serial number
- Any error messages
- Details of recent system performance

For instrument support from within the US, call (877) 232-8995.

For support from within Canada, call (888) 259-0187.

Customers outside the US and Canada, contact your local BD representative or distributor.
Limitations

This instrument is for Research Use Only. Not for use in diagnostic or therapeutic procedures.

BD Biosciences is providing software without warranty of any kind on an as-is basis. The software and workstations are intended for running the instruments supplied by BD Biosciences. It is the responsibility of the buyer/user to ensure that all added electronic files including software and transport media are virus free. If the workstation is used for Internet access or purposes other than those specified by BD Biosciences, it is the buyer/user’s responsibility to install and maintain up-to-date virus protection software. BD Biosciences does not make any warranty with respect to the workstation remaining virus free after installation. BD Biosciences is not liable for any claims related to or resulting from the buyer/user's failure to install and maintain virus protection.
The BD FACSaria II flow cytometer is a high-speed fixed-alignment benchtop cell sorter. The cytometer can be operated at varied pressures and can acquire up to 70,000 events per second. With its fixed-optics design and digital electronics, the BD FACSaria II flow cytometer enables multicolor analysis of up to 13 fluorescent markers and two scatter parameters at a time.

The BD FACSaria II system consists of three major components: a fluidics cart, a benchtop flow cytometer, and a workstation (see Figure 1-1 on page 18). Nearly all cytometer functions are operated from within BD FACSDiva software.

For a description of the system components, see the following sections. For technical information about how the cytometer works, see Chapter 2.

- Fluidics Cart on page 18
- Flow Cytometer on page 22
- Workstation on page 41
Fluidics Cart

A separate fluidics cart supplies sheath and cleaning fluids and collects waste from the cytometer. The self-contained fluidics cart supplies the required air pressure and vacuum, which eliminates the need for an external source (although the cart can be hooked up to an in-house air source, if one is available). The air pumps provide pressure from 5 to 75 psi to accommodate a variety of cell sorting applications. Air pressure is adjusted within BD FACSDiva software.

Containers and Connectors

The fluidics cart holds a 10-L stainless steel sheath tank, a 5-L stainless steel ethanol shutdown tank, a 10-L waste container, and three 5-L auxiliary cleaning fluid containers (Figure 1-2).
To prevent foaming, do not fill the containers with solutions containing a high concentration of detergent.

The fluidics cart connects directly to the flow cytometer unit via a power cord, fluid hoses, serial communication cable, and air line (Figure 1-3 on page 20). Receptacles for the aerosol management and temperature control options are also located within the connection panel. The position of the fluidics cart is constrained only by the length of the connecting cables and hoses, which extend up to 9 feet (2.7 m). Typically, the cart is placed to the left or underneath the cytometer.
Connecting to an External Air Supply

To connect the fluidics cart to an external air source, switch on the Auxiliary Air Supply and attach the external air line to the air input connector. The external air supply should provide 80–100 psi. The external air must be dust and oil-free.

NOTE There is a pull-out drip tray under the connection area. Check the tray periodically for moisture. See page 212 for details.
Power and Operation

Power to the fluidics cart is supplied by the cytometer. The cart is activated when the cytometer main power switch is turned on (see Power Panel on page 39).

⚠️ Power to the fluidics cart is supplied and controlled through the flow cytometer. The fluidics cart voltage settings have been configured to match the supply voltage by your service engineer. To properly operate the fluidics cart, plug the fluidics cart power cord only into the power receptacle on the cytometer (Figure 1-3 on page 20). Do not plug the power cord directly into a wall socket. Do not change the input voltage selection switch on the fluidics cart.

⚠️ When the stream is on, air pressure fluctuates between 80–100 psi (Figure 1-5). A pressure reading of less than 80 psi or greater than 100 psi indicates that the fluidics cart is not functioning properly. If this occurs, contact your BD Biosciences service representative for assistance. Do not operate the cytometer outside the normal air pressure range.

Figure 1-5  Fluidics cart flow gauge

See the following sections for more information about the fluidics cart:

- Setting Up the Fluidics Cart on page 122
- Refilling the Plastic Containers on page 126
- Emptying the Waste Container on page 127
Flow Cytometer

The benchtop flow cytometer contains the major components for all three subsystems (fluidics, optics, and electronics). The BD FACSARia II cytometer is relatively compact, with a much smaller footprint than most sorters with the same capabilities. The cytometer can be set up on a typical laboratory benchtop or table, and it requires only a 20-amp electrical outlet. No special facilities are required.

Figure 1-6  BD FACSARia II flow cytometer

To view the fluidics components, open the side door and lift the flow cell access door. To view the optics components, open the optics access door. The power panel and connectors are found on the left side of the cytometer. Other electronic components are embedded within the cytometer and do not need user adjustment.
Fluidics Components

When the fluidics system is activated, the sheath fluid from the pressurized sheath tank is forced from the fluidics cart up into the cuvette flow cell where hydrodynamic focusing forces particles from the sample injection chamber through the cuvette in a single-file stream.

Within the cuvette flow cell, laser light is focused on the sample core stream. Fluorescent molecules excited by the different laser wavelengths are detected by the optics and analyzed by the electronics. Particles are then either transported to waste reservoirs via the waste aspirator, or sorted into a collection device within the sort collection chamber.

The following fluidics components are described in this section. See Figure 1-7 on page 24. For more information about fluidics, see Fluid Movement on page 44.

- Sample Injection Chamber on page 25
- Cuvette Flow Cell on page 27
- Nozzle on page 28
- Sort Block on page 29
- Sort Collection Chamber on page 32
Figure 1-7 Main fluidics components

cuvette flow cell
sort block door
deflection plates warning light
sort collection chamber

pinch valve
nozzle holder
sample injection chamber
sample loading port
Sample Injection Chamber

The sample injection chamber is where sample is introduced into the flow cytometer. During acquisition, the chamber is pressurized to force sample toward the cuvette flow cell.

Samples can be agitated and temperature-controlled within the sample injection chamber using controls in the software (see Fluidics Controls on page 79). You can view the amount of fluid remaining in your sample tube by pressing the chamber light button shown in Figure 1-8.

⚠️ Do not use the chamber light for long periods with samples stained with light-sensitive reagents.

Figure 1-8  Sample injection chamber
Tube Holders

A variety of tube holders are provided with the cytometer to accommodate tubes from 15-mL centrifuge tubes to 1.0-mL microtubes (Figure 1-9). (For a list of compatible tubes, see Labware on page 269.) To load a tube, install the appropriate-size tube holder onto the loading port, and place a tube in the holder.

NOTE Make sure to press the tube holder down firmly onto the metal rod in the loading port, so the tube holder is seated correctly each time a tube is installed.

When the Load button is clicked in the software (see Acquisition Controls on page 97), the loading port rises to enclose the tube within the chamber.

Figure 1-9 Tube holders

![Image of tube holders](image)

After a tube is loaded, the Load button changes to Unload. Click the Unload button to lower the loading port after data has been recorded. After each tube is unloaded, sheath fluid flushes the sample tubing inside and out to reduce potential sample carryover.

⚠️ To prevent injury from moving parts, keep your hands and clothing away from the loading port when a tube is loading or unloading. Do not place objects under the loading port.
Cuvette Flow Cell

The cuvette flow cell is the heart of the BD FACS Aria II cytometer (Figure 1-10). Within the flow cell, hydrodynamic focusing forces particles through the cuvette in a single-file stream, where laser light intercepts the stream at the sample interrogation point.

Figure 1-10  Cuvette flow cell

The unique flow cell design permits particles to flow through the cuvette at a low velocity (approximately 6 m/sec for the 70 micron Sort Setup), allowing longer exposure to laser energy. The cuvette is gel-coupled to the fluorescence objective lens to transmit the greatest amount of emitted light from the interrogation point to the collection optics (see Optics System on page 33). After passing through the cuvette, the stream is accelerated (to approximately 30 m/sec with the 70 micron Sort Setup) as it enters the nozzle tip, where the drop drive breaks the stream into droplets for sorting.
Nozzle

The BD FACSaria II cytometer is provided with four nozzle sizes (70, 85, 100, and 130 μm) to accommodate a variety of particle sizes. The nozzle is keyed to a fixed position at the lower end of the cuvette. Because the nozzle is below the interrogation point, optical alignment is not affected when the nozzle is changed.

When installing or removing the nozzle, make sure the O-ring is in place before proceeding. Look at the O-ring in the nozzle with a magnifier or under a microscope to confirm it is positioned correctly.

Refer to these sections for more information on the nozzle:

- Changing Nozzles on page 214
- Cleaning the Nozzle on page 216
Sort Block

After leaving the nozzle, particles pass through the sort block where they are either transported to waste via the waste aspirator, or sorted into a collection device in the sort collection chamber. The sort block houses the high-voltage deflection plates, along with the aspirator and aspirator drawer (Figure 1-12).

Figure 1-12  Sort block with door open

Note that the entire sort block assembly can be rotated on a fixed pivot point to adjust the position of the stream in the waste aspirator. If the keyed stream position differs between different nozzles, the stream might not hit the center of the aspirator after the nozzle is changed. In this case, you can change the angle of the sort block by loosening the adjustment screws on both sides of the deflection plates and rotating the sort block. An Allen wrench is provided in the accessory kit. Tighten the screws when the stream is re-centered in the aspirator.
Deflection Plates

The high-voltage deflection plates are used to deflect side streams during sorting. The plates are turned on and off using the Voltage control in the Side Stream window (see Side Stream Formation on page 65). A red warning light is illuminated whenever the plate voltage is on (Figure 1-14 on page 31).

⚠️ A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the voltage warning light is illuminated, or when the software indicates that the plate voltage is on. The plates remain energized even when the sort block door is opened.

Aspirator Drawer

The aspirator drawer keeps the sort collection tubes covered until sorting begins (Figure 1-13). You can open and close the drawer using a control in the Sort Layout or Side Stream window (see Using Sorting Controls on page 107). When the Sweet Spot is on and a clog is detected during sorting, the drawer automatically closes to protect your sort collection tubes.

⚠️ To avoid pinching your hands or fingers in the drawer, keep your hands away from the sort block during sorting.

Figure 1-13 Aspirator drawer closed (left) vs open (right)
Aerosol Management

During sample acquisition and sorting, the sort block door and flow cell access door should be kept closed to help contain potential aerosols (Figure 1-14).

Cell sorters that use droplet generation methods, like the BD FACSAria II, can produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block door closed during sorting. If you need to access the sort block and you are working with highly infectious samples, consider turning off the stream before opening the sort block door.

Figure 1-14 Sort block with door closed

Additional aerosol removal is provided by the BD™ Aerosol Management Option (AMO). The AMO is an optional device that evacuates the sort collection chamber during sorting. The AMO is equipped with a 0.01-µm pore ultra-low penetrating air (ULPA) filter to trap aerosolized particles.

See Appendix C - BD Aerosol Management Option on page 281 for complete information on using this option.
Sort Collection Chamber

Collection devices are installed in the sort collection chamber to collect sorted samples. The collection devices are designed in two pieces with a universal top that can be used with different tube configurations (Figure 1-15). The following collection devices are provided with the cytometer to accommodate a variety of tube sizes:

- Four-way 1-mL collection tube holder
- Four-way 12 x 75-mm collection tube holder
- Two-way 12 x 75-mm collection tube holder
- Two-way 15-mL collection tube holder

An automated cell deposition unit (ACDU) that sorts into multiwell plates and onto microscope slides is available as an option. BD Biosciences also offers a temperature-control option to maintain the temperature of sorted samples during sorting.

Figure 1-15  Sort collection devices
The sort collection chamber door should be kept closed when sorting into a plate. The door keeps the chamber free of dust and other airborne particles, and seals the chamber during aerosol evacuation for cytometers equipped with the AMO.

**Optics System**

The BD FACS Aria II cytometer uses innovative designs for both the excitation optics and collection optics. The optics can be viewed by opening the optics access door and the flow cell access door.

⚠️ The flow cell access door is equipped with a shutter mechanism that shuts off the laser light when the door is opened. To ensure there is no interruption to data acquisition, do not open the door while sorting or recording.

**Excitation Optics**

The excitation optics consist of lasers, fiber optic cables, beam-shaping prisms, and an achromatic focusing lens, as shown in Figure 1-16 on page 34. For information about how signals are generated, see Signal Generation on page 48.

The BD FACS Aria II cytometer uses low-powered, air-cooled and solid-state lasers that do not have special power or cooling requirements. See Table 1-1 for the laser choices. See Table 8-5 on page 257 for the laser specifications.

### Table 1-1 Laser configurations

<table>
<thead>
<tr>
<th>Laser</th>
<th>Wavelength</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>488 nm</td>
<td>Standard</td>
</tr>
<tr>
<td>Red</td>
<td>633 nm</td>
<td>Standard</td>
</tr>
<tr>
<td>Violet</td>
<td>405 nm</td>
<td>Optional</td>
</tr>
<tr>
<td>Near UVa</td>
<td>375 nm</td>
<td>Optional (Uses the same optical path and PMTs as violet laser. See Appendix B on page 271.)</td>
</tr>
</tbody>
</table>

*a. When both the near UV and violet lasers are installed, only one of them can be used at the same time. The laser power toggle switch determines which laser is active.*
Lasers emit intense, coherent electromagnetic radiation that can cause irreparable damage to human skin and eyes. To prevent retinal burns and possible blindness, do not remove laser shielding, adjust laser controls, or attempt to service the cytometer any place where laser warning labels are attached. Refer to the *BD FACS Aria II Safety and Limitations Guide* for the placement of laser warning labels.

Fiber optics direct the laser light in a precise and constant manner onto beam-shaping prisms, which in turn transmit the laser light to a focusing lens. The lens focuses the laser light onto the sample core stream within the cuvette flow cell (Figure 1-16). The lasers are positioned on the sample stream for optimal generation of signals. Since the optical pathway and sample core stream are fixed, optimization is constant from day to day.

**Figure 1-16** Excitation optics pathway (behind laser shielding)
Collection Optics

From the cuvette flow cell, laser light is collected by a fluorescence objective lens that is gel-coupled to the cuvette to transmit the maximum amount of light. The lens collects and focuses fluorescent light emitted at each of the laser focal points onto individual collection fibers. These fibers transfer the emitted light to the collection optics, as shown in Figure 1-17.

**Figure 1-17** Side view of flow cell, nozzle, and objective lens

The collection optics are set up in octagon- and trigon-shaped arrays that are engineered to maximize signal detection from each laser. This is accomplished by transmitting the highest wavelengths to the first photomultiplier tube (PMT), and reflecting lower wavelengths to the next PMT through a series of longpass dichroic mirrors. Bandpass filters in front of each PMT allow fine-tuning of the spectral wavelengths that need to be collected. Since reflection is more efficient than transmittance, this design greatly increases the multicolor detection capabilities of the cytometer. See Figure 1-18 on page 36.
Figure 1-18 Transmission pathways in an octagon

Detectors

A standard system is equipped with an octagon containing six PMTs, that detect light from the 488-nm (blue) laser, and a trigon containing two PMTs, that detect light from the 633-nm (red) laser. The third-laser option adds an additional trigon containing two PMTs to detect light from the 405-nm (violet) laser. If the optional 375-nm (near UV) laser is installed, it uses the same PMTs as the violet laser.

Optical upgrades are available to fill the remaining PMT slots for a two- or three-laser system. A fully-equipped system can detect up to 13 fluorescent markers and two scatter parameters at a time.
At installation, the octagon and trigon arrays are set up with the filter and mirror combinations shown in Table 8-7 on page 258. You can rearrange these configurations according to the type of fluorochromes in your experiment.
Stream-Viewing Optics

The BD FACSARia II cytometer is equipped with optical components that are used to view the stream (Figure 1-20).

- The upper camera generates an image used to monitor drop formation. It is focused on the stream, just below the nozzle, to provide an image of the drop breakoff.

- The lower camera generates an image used for the BD FACS™ Accudrop option. It enhances the ability to see side streams and assists in setting an accurate drop delay value.

Figure 1-20 Stream-viewing optics

Special image-processing software allows you to view the stream images from each camera within separate windows in BD FACSDiva software. See Sorting on page 60 for more information about viewing the streams and to learn how Accudrop components are used to determine the drop delay.
Cytometer Electronics

The electronic components consist of power controls and connectors along with processing boards in the card cage. This section describes only user-adjustable cytometer electronics. For more information about the electronics, see Signal Detection on page 50.

Power Panel

Power to the cytometer, lasers, and fluidics cart is supplied by a power cord plugged directly into a standard electrical outlet. There are no special facilities requirements. The main power button turns on the cytometer and fluidics cart, and enables the laser power buttons. To turn on a laser, press the corresponding button. The button lights up when the power is on.

Figure 1-21 Flow cytometer power panel on 3-laser system

The cytometer circuit breaker is located next to the fluidics cart power cord (Figure 1-21). The switch will need to be reset if there is a power surge in the laboratory.
Emergency Stop Button

The emergency stop button to the right of the loading port (Figure 1-22) is a safety feature that can be used to halt the movement of the loading port and ACDU stage. The button lights up when a tube is loading to remind you to keep your hands away from the loading port.

Figure 1-22  Emergency stop button

The following occur when this button is pushed:

- The tube is unloaded from the sample injection chamber.
- The ACDU stage (if in use) stops moving.
- The stream is turned off.
- The deflection plate voltage is turned off.
- The aspirator drawer (if open) closes to protect sort collection tubes.
- A warning message appears on the screen.
Do not reset the button until the message appears. To do so, turn the button clockwise until the light turns off and the button returns to its original position.

**NOTE** The emergency stop button does not turn off the lasers or shut down the cytometer main power.

**Workstation**

Data acquisition and analysis, as well as most BD FACS Aria II cytometer functions, are controlled by BD FACSDiva software on a third-party PC workstation. The workstation includes a desktop computer, one or two monitors, and a color printer, and is equipped with the following applications:

- Microsoft Windows operating system
- Microsoft Office application package
- BD FACSDiva software, version 6.1 or later
  - Data acquisition and analysis
  - Automatic fluidics startup, shutdown, and cleaning modes
  - Sort setup, stream monitoring, clog detection, and recovery
  - CS&T module for setup and tracking performance
- Supporting documentation for the software

For information about BD FACS Aria II–specific software features, see Chapter 2, Theory of Operation, and Chapter 3, Using BD FACSDiva Software. For general software information, refer to the *BD FACSDiva Software Reference Manual*.

**Tip** For easy access to the online *BD FACSDiva Software Reference Manual*, select Help > Literature > Reference Manual.
Theory of Operation

This chapter describes how the BD FACSaria II cytometer works and how BD FACSDiva software components are used to operate different system components. For a general overview of the software, see Chapter 3.

See the following sections for a description of these BD FACSaria II functions:

- Fluid Movement on page 44
- Signal Generation on page 48
- Signal Detection on page 50
- Electronic Processing on page 57
- Sorting on page 60
Fluid Movement

The fluidics system is responsible for moving particles from the sample injection chamber through the cuvette flow cell for interrogation, and then to waste or into a collection device during sorting (Figure 2-1). The following sections describe the controls used to move fluids through the BD FACS Aria II fluidics system.

Figure 2-1 Fluidic movement via the fluidics system

Sheath Flow

When you turn on the cytometer, the main air compressor starts up. The fluidics system is activated when you select the Fluidics Startup command in BD FACSDiva software. During fluidics startup, sheath fluid is forced from the pressurized sheath tank through a filter and is delivered to the cuvette flow cell at...
a constant pressure. You can view the current sheath pressure setting using the Cytometer > Sheath Pressure command (Figure 2-2).

**Figure 2-2** Sheath pressure level

![Sheath Pressure](image)

After fluidics startup, sheath flow is controlled using the Stream button in the Breakoff window (Figure 2-3). When clicked, the button changes from a red “X” to a green checkmark, and sheath flows through the cuvette flow cell at the rate that is specified in the Sheath Pressure window. (See Drop Formation on page 61 for a complete description of the Breakoff window.)

**Figure 2-3** Stream control in Breakoff window

![Stream Control](image)

As a general rule, the sheath pressure level is set by choosing a Sort Setup mode from the Sort menu, rather than by adjusting the Sheath Pressure control. Each Sort Setup mode is optimized at a preset sheath pressure. If you change the sheath pressure, a multitude of other values will be affected and need updating, including the drop drive frequency, drop charge levels, laser delay, area scaling factor, and other values. For more information, see Sort Setup on page 101.
Sample Flow

Sample is introduced into the cuvette when the Load button is clicked in the Acquisition Dashboard (Figure 2-4). After Load is clicked, the loading port rises to enclose the tube within the sample injection chamber. The chamber is automatically pressurized and the chamber pressure forces sample through the sample line into the cuvette flow cell. To stop sample flow after a tube is loaded, click the Stop Acquiring button.

The sample flow rate is specified using the Flow Rate field in the Acquisition Dashboard. You can adjust the Flow Rate from 1–11, which corresponds to approximately 10–80 μL/min.

Figure 2-4 Load button and Flow Rate field in Acquisition Dashboard

Note that the relatively longer sample tubing on the BD FACSaria II cytometer results in a different flow rate between cells and beads. Thus, absolute counting using BD Trucount™ beads can yield erroneous results.
Hydrodynamic Focusing

In the flow cell, pressurized sheath fluid surrounds the sample fluid to hydrodynamically focus the core stream of suspended cells into the center of the cuvette, where the particles are intercepted by the laser beam.

The difference in pressure between the sheath fluid and the sample fluid can be used to vary the diameter of the sample core. A lower difference results in a relatively narrow core stream, while a higher difference results in a wider sample stream.

Ideally, you want the core stream at its minimum diameter so that cells pass through the laser beam in a single-file stream. However, depending on your application, a lower resolution might be acceptable in order to acquire the data more quickly. For example, a higher flow rate is generally used for qualitative measurements such as immunophenotyping—the data is less resolved but is acquired more quickly. A lower flow rate is generally used in applications where greater resolution is critical.
Signal Generation

The following sections describe how signals are generated when cells or particles intercept the laser within the cuvette flow cell.

Light Scatter

When a cell or particle passes through a focused laser beam, laser light is scattered in all directions. Light that scatters axial to the laser beam is called forward scatter (FSC). Light that scatters perpendicular to the laser beam is called side scatter (SSC). FSC and SSC are related to certain physical properties of cells:

- FSC—indicates relative differences in the size of the cells or particles
- SSC—indicates relative differences in the internal complexity or granularity of the cells or particles
Fluorescent Signals

When cells or particles stained with fluorochrome-conjugated antibodies or other dyes pass through a laser beam, the dyes can absorb photons (energy) and be promoted to an excited electronic state. In returning to their ground state, the dyes release energy, most of which is emitted as light. This light emission is known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the excitation wavelength. The difference between the excitation wavelength and the emission wavelength is known as the Stokes shift. Some fluorescent compounds such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and emitting red light (675 nm), while other fluorochromes such as FITC have a smaller Stokes shift, absorbing blue light and emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in Figure 2-5. See Table 8-7 on page 258 for the corresponding detectors.

Figure 2-5 Emission spectra of commonly used fluorochromes
Signal Detection

From the cuvette flow cell, scattered and fluorescent light is collected by the fluorescence objective lens. The lens collects and focuses fluorescent light emitted at each of the laser focal points onto individual collection fibers. These fibers transfer the emitted light to the individual detector arrays.

The following sections describes how laser light is detected and translated into signals that can be displayed in a plot.

Detector Arrays

There are two types of detector arrays in the BD FACS Aria II flow cytometer: an octagon and trigons. The octagon detects SSC and up to seven fluorescence signals excited by the 488-nm (blue) laser. The trigons detect fluorescence signals excited by the 633-nm (red) and 405-nm (violet) lasers, respectively. Each trigon can detect up to three fluorescence channels. (An optical upgrade is required to fill all detection channels.)

**Figure 2-6** Octagon and trigon detector arrays

Each detector array houses dichroic and bandpass filters, which steer and filter the emitted light, and photomultiplier tubes (PMTs), which detect light signals.
Filters

Optical filters modify the spectral distribution of light scatter and fluorescence directed to the detectors. Three kinds of filters are used in the detector arrays: longpass (LP) filters are used to steer light between the detectors within a detector array, while bandpass (BP) and neutral density (ND) filters allow fine-tuning of the spectral wavelengths that need to be collected (Figure 2-7).

Figure 2-7 Detectors and filters in octagon array
Longpass Filters

Longpass (LP) filters pass wavelengths longer than the filter rating and reflect shorter wavelengths. For example, a 500 LP filter permits wavelengths longer than 500 nm to pass through it and reflects wavelengths shorter than 500 nm (Figure 2-8).

Figure 2-8  Light reflection by longpass filter

Dichroic filters that are used to direct different color light signals to different detectors are called dichroic mirrors or beam splitters.

Although dichroic mirrors have the properties of LP optical filters, you cannot necessarily use any type of LP filter as a beam splitter. A beam splitter must have a surface coating that reflects certain wavelengths, but many types of LP filters are absorbance filters that do not have any specific reflective characteristics. Also, optical filters and beam splitters are rated at a specific angle of incidence. When used as a beam splitter, they are placed at an angle relative to the light source. Their optical properties are therefore designed for that angle of incidence.

The detector arrays use LP dichroic mirrors to steer progressively shorter wavelengths of light to the next PMT in the array. For example, in the octagon array, light first passes through a 735 LP filter in the A position, followed by a 655 LP filter in the B position. Thus, wavelengths longer than 735 nm are detected at PMT-A. All wavelengths <735 nm are reflected to PMT-B. Wavelengths between 655 nm and 735 nm are detected at PMT-B. All wavelengths <655 nm are reflected to PMT-C, and so on. For a list of the longpass filters used in the detector arrays, see Table 8-7 on page 258.
Bandpass Filters

Bandpass (BP) filters transmit a relatively narrow range or band of light. Bandpass filters are typically designated by two numbers. The first number indicates the center wavelength and the second refers to the width of the band of light that is passed. For example, a 500/50 BP filter transmits light that is centered at 500 nm and has a total bandwidth of 50 nm. Therefore, this filter transmits light between 475 and 525 nm (Figure 2-9).

**Figure 2-9** Light transmittance by bandpass filters

Discriminating (DF) filters have the same general function—they transmit a relatively narrow band of light. The principal difference between BP and DF filters is their construction. DF filters have more cavities or layers of optical coatings, resulting in a steeper transmission curve than the curve for a BP filter. This steep slope means that a DF filter is better at blocking light outside the rated bandwidth of the filter. See Figure 2-10 on page 54.
In the detector arrays, DF filters block high-intensity laser light and filter the remaining light to ensure that only the required wavelengths reach their intended detector. For example, in the octagon array, PMT-A has a 780/60 DF filter in front of it, which transmits light of 750–810 nm. Thus, the only wavelengths that will reach the A detector are those between 750 and 810 nm.

For optimal detection of fluorescent light, a bandpass filter must always be installed in front of each detector. For a list of the bandpass filters used in the detector arrays, see Table 8-7 on page 258.
Neutral Density Filters

Neutral density (ND) filters transmit a fixed percentage of light, reducing the transmitted intensity of all wavelengths equally. ND filters are neutral with respect to wavelength.

The ND1 filter on the BD FACS Aria II allows approximately 10% of the light to be transmitted. You can find the ND filter in front of the FSC detector. For applications involving small particles (e.g., bacteria or platelets), you might need to remove the FSC ND filter. For applications involving large particles where events appear off scale on the FSC axis with a gain of zero, a higher value ND filter is needed to decrease the FSC signal and keep the events on scale.

The system comes with three ND filters: 1, 1.5, and 2. See Removing or Installing the FSC ND Filter on page 232.
Detectors

Detectors within each detector array convert light signals into electrical signals that can be processed by the electronics system.

There are two types of signal detectors in the BD FACS Aria II flow cytometer: the photodiode and photomultiplier tubes (PMTs). The photodiode is less sensitive to light signals than the PMTs, and is used to detect the stronger FSC signal. The photodiode detects FSC light from the blue laser, and is stored outside the detector arrays. PMTs are used to detect the weaker signals generated by SSC and all fluorescence channels. The octagon can hold up to eight PMTs. Each trigon can contain up to three PMTs.

Each PMT detects only one fluorochrome at a time. In BD FACS Diva software, the Cytometer Configuration window lets you define which fluorochromes or cell parameters will be measured at each PMT detector. If more than one fluorochrome is measured using the same PMT, you can add additional parameters to your configuration and select the appropriate fluorochrome within your software experiment. See Cytometer Configuration on page 84 for more information.

Figure 2-11  Example BD FACS Aria II cytometer configuration
Electronic Processing

As cells or other particles pass through the focused laser beams, they scatter the laser light and can emit fluorescence. Because each laser beam is focused on a small spot and particles move rapidly through the flow cell, the scatter or fluorescence emission has a very brief duration—only a few microseconds. The PMTs convert this brief flash of light into an electrical signal called a pulse (Figure 2-12).

Figure 2-12 Anatomy of a pulse

A pulse begins when a particle enters the laser beam. At this point, both the beam intensity and signal intensity are low.

The pulse reaches a maximum intensity or height when the particle reaches the middle of the beam, where the beam and signal intensity are the brightest. The peak intensity, or height of the pulse, is measured at this point.

As the particle leaves the beam, the pulse trails off.
Pulse Parameters

A parameter is a pulse property that is generated by a single photomultiplier tube or photodiode, measuring fluorescent or scattered light. You can measure three characteristics of a pulse: the area, height, or width. The pulse height measures the maximum digitized value for the pulse, the pulse area calculates the sum of all height areas for the pulse, and the pulse width calculates \[ \text{area} \times \frac{64000}{\text{height}}. \]

You can select which pulse characteristics you want to measure for each parameter using the Parameters tab. Pulse area (A) is measured by default. The Parameters tab also contains voltage controls that allow you to amplify signals by applying a voltage to PMTs or an electronic gain to the FSC signal. As the voltage is increased, the detector sensitivity increases, resulting in increased signal. As the voltage is decreased, the detector sensitivity decreases, resulting in decreased signal.

Digital data is displayed on an 18-bit linear scale, from 2.6–262,144. Select the Log checkbox to convert the display to a log scale. The Experiment Inspector contains an option to display log data on a four- or five-decade scale. (Refer to the BD FACSDiva Software Reference Manual for more information.)
Laser Delay

Sample interrogation takes place within the cuvette flow cell. Fiber optic cables are used to direct laser light through a series of prisms that focus each laser on the stream at a separate position. This allows optimal detection of fluorescence signals from each laser with minimal cross-contamination from the other beams.

In a three-laser system, the red laser intercepts the stream first, followed by the blue and then the violet laser. Because the laser signals are spatially separated, there is a slight delay between the detection of each laser’s signal (Figure 2-13).

The delay factor in BD FACSDiva software is used to realign the signals so they can be measured and displayed on the same time scale. Note that signals are aligned with respect to the blue laser, so the red laser signals always have a negative delay value.
Sorting

During sorting, drop drive energy is applied to the stream to break it into highly uniform droplets. Droplets detach from the stream a few millimeters downstream from the nozzle. The time between when a particle intercepts the laser and when it reaches the droplet breakoff point is determined using BD FACS Accudrop technology (see Drop Delay Overview on page 67).

When a particle is detected and meets the predefined sorting criteria, an electrical charge is applied to the stream just as the droplet containing that particle breaks off from the stream. Once broken off from the stream, the droplet—now surrounded by air—still retains its charge. The charged droplet passes by two strongly charged deflection plates. Electrostatic attraction and repulsion cause each charged droplet to be deflected to the left or right, depending on the droplet's charge polarity. Uncharged droplets are not affected by the electric field and pass down the center to the waste aspirator. See Figure 2-14 on page 61.

The following sections describe how the BD FACSaria II cytometer creates and charges drops, how the drops are deflected, and how sorting populations are identified.
Figure 2-14  Sorting

1. Charge is applied via the stream-charging wire in the barb.
2. Sample generates light scatter and fluorescence signal. Signal is analyzed.
3. The charged droplet breaks off.
4. Deflection plates attract or repel the charged droplet.
5. Uncharged droplets pass to waste.
6. Charged drops containing particles of interest are collected.

Drop Formation

The BD FACS Aria II cytometer constantly applies drop drive energy to the stream. Droplets form as soon as you turn on the stream. Sample interrogation takes place upstream of the stream vibration so that analysis is not affected by the drop drive.

A drop breakoff image is created using an LED strobe and a video camera. The image is displayed in the Breakoff window. (See Breakoff Window on page 62.) Patented Sweet Spot technology analyzes the drop breakoff image and provides feedback to the appropriate cytometer controls.
Breakoff Window

The upper camera transmits an image of the drop breakoff to the Breakoff window, where video image processing software converts the visual characteristics of the image into numerical properties. The drop breakoff is analyzed for two key features: Drop 1 and Gap.

Drop 1 is defined as the number of pixels from the top of the image to the center of gravity of the first broken-off drop. A thin gray line on the image is used to identify this drop. The number shown to the right of the Drop 1 field at the bottom of the window is the actual pixel location of the gray line. The number entered into the Drop 1 field is the user-defined Drop 1 target.

The Gap is defined as the number of pixels from the first discontinuity in the stream to the next stream object, generally the first broken-off drop. A gray line of varying thickness represents the Gap. The number shown to the right of the Gap field is the pixel width of the gray line. The number entered into the Gap field is a user-defined target.

When the Sweet Spot is turned on, the drop drive amplitude (Ampl) is automatically adjusted to approximately match the target Drop 1 and Gap values. The amplitude is initially adjusted in larger increments until Drop 1 is achieved. The amplitude is then adjusted in smaller increments until the cytometer attains the target Gap. The Sweet Spot feature will make adjustments as necessary to maintain the required breakoff conditions throughout the day.

The Sweet Spot performs two other functions during sorting. When sorting, if the Drop 1 or Gap are out of range, sorting is paused until the values are back within range. This ensures that sorting occurs only under the proper breakoff conditions. If a more severe problem such as a clog is detected by the Sweet Spot, the stream is shut off and sorting is stopped: the deflection plates shut off, the aspirator drawer closes, and the sample tube is unloaded.

Pre-programmed values can be downloaded to the Breakoff window by choosing one of the nozzle sizes (70, 85, 100, 130 micron) from the Sort > Sort Setup menu.
Note that changes to values in the Sort Setup windows (Breakoff and Side Stream) are automatically saved. At startup, the last settings used on the cytometer are restored, except the Stream and Sweet Spot controls which always default to off. For more information, see Sort Setup on page 101.

### Table 2-1 Breakoff window controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream button</td>
<td>Turns the stream on and off.</td>
</tr>
<tr>
<td>Sweet Spot button</td>
<td>Enables automatic adjustment of the drop drive amplitude to maintain the stability of the breakoff point. When the Sweet Spot is on, the Amplitude and Frequency fields are disabled. The amplitude is automatically adjusted by the software. To enable the fields, turn off the Sweet Spot.</td>
</tr>
<tr>
<td>Amplitude field</td>
<td>Adjusts the amplitude or intensity of the drop drive, from 1.0–80.0 volts. The drop drive amplitude determines the breakoff point. A higher amplitude value results in a shorter stream breakoff. A lower amplitude results in a longer stream breakoff. Typically, the amplitude is set once, at the beginning of a sorting experiment, and then maintained via the Sweet Spot.</td>
</tr>
<tr>
<td>Frequency field</td>
<td>Determines the number of drops formed per second and the size of the drops. (Drop size is also influenced by the nozzle size.) The drop drive frequency can be adjusted from 1.0–102.0 kHz. The higher the frequency, the more drops are generated per second and the smaller the drops. The lower the frequency, the fewer drops generated per second and the larger the drops.</td>
</tr>
</tbody>
</table>
Typically, when setting up for sorting, you use the Amplitude to set the required drop breakoff, and copy the generated Drop 1 value to the target field. Then, you turn on the Sweet Spot to maintain the drop breakoff. When the Sweet Spot detects a >1-pixel difference between the target Gap setting and the actual Gap, it adjusts the Amplitude to reduce the Gap. When a >2-pixel difference is detected, the Sweet Spot stops sorting temporarily (stops charging the stream) until the Gap is restored. Note that when the sort is paused, the sample continues to flow. Once the Gap is back within range, sorting automatically resumes.

For information on setting the breakoff, see Setting Up the Breakoff on page 119.
Side Stream Formation

Side streams are formed when the voltage is on and you are sorting, or when you click Voltage, then Test Sort in the Side Stream window.

The Side Stream window displays an image of the side streams as transmitted by the lower camera. In addition to the stream image, the Side Stream window contains the controls used to adjust electrical charges and to determine the drop delay using Accudrop, as described in Drop Delay Overview on page 67.

**Figure 2-15** Side Stream window

Controls in the Side Stream window are described in Table 2-2 on page 66. You can send different values to the Side Stream window by selecting a nozzle size from the Sort > Sort Setup menu.

Note that changes to values in the Sort Setup windows (Side Stream and Breakoff) are linked to the sort setup and are automatically saved. At startup, the last settings used on the cytometer are restored, except the states of the Voltage, Test Sort, and Optical Filter buttons, which always default to off. For more information, see Sort Setup on page 101.
## Table 2-2 Side Stream window controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage button</td>
<td>Turns the plate voltage on and off.</td>
</tr>
<tr>
<td><img src="on" alt="on" /> <img src="off" alt="off" /></td>
<td></td>
</tr>
<tr>
<td>Test Sort button</td>
<td>Generates test side streams based on test sort pulses.</td>
</tr>
<tr>
<td><img src="on" alt="on" /> <img src="off" alt="off" /></td>
<td></td>
</tr>
<tr>
<td>Optical Filter button</td>
<td>Controls the position of the optical filter in front of the lower (Accudrop) camera.</td>
</tr>
<tr>
<td><img src="in" alt="in" /> <img src="out" alt="out" /></td>
<td></td>
</tr>
<tr>
<td>Attenuation button</td>
<td>Decreases the amplitude of the drop drive. At lower pressures, you may need to turn on attenuation to dampen the amplitude.</td>
</tr>
<tr>
<td><img src="off" alt="off" /> <img src="on" alt="on" /></td>
<td></td>
</tr>
<tr>
<td>Waste Drawer button</td>
<td>Opens or closes the aspirator drawer depending on its current state. The default state is closed. For more information, see Aspirator Drawer on page 30.</td>
</tr>
<tr>
<td><img src="closed" alt="closed" /> <img src="open" alt="open" /></td>
<td></td>
</tr>
<tr>
<td>Drop Delay field</td>
<td>Sets the amount of time between when an event is measured and the breakoff point, from 10–140 drops. The drop delay value determines which drop will be deflected. The drop delay value is set experimentally using BD FACS Accudrop technology.</td>
</tr>
<tr>
<td>Auto Delay</td>
<td>Opens the Auto Drop delay dialog.</td>
</tr>
<tr>
<td>Voltage sliders (far left, left, right, far right)</td>
<td>Set the percentage of charge to be applied to the corresponding stream (as a percentage of maximum).</td>
</tr>
<tr>
<td>Voltage Center slider</td>
<td>Adjusts the relative voltage between the left and right plates which moves the streams slightly to the left or right as a whole. In general, the slider rarely needs adjusting.</td>
</tr>
</tbody>
</table>
Chapter 2: Theory of Operation

Drop Delay Overview

The BD FACSAria II cytometer includes integrated Accudrop technology to assist in setting an accurate drop delay value. Accudrop components consist of the following:

- A diode laser, mounted to the left of the sort block
- A camera that provides an image of the side streams
- An emission filter for viewing the fluorescence from BD Accudrop™ beads

The emission filter is installed in front of the lower camera and can be moved in and out by clicking the Optical Filter control. When the button is green (🌿), the filter is out. This position is used to view the center and side streams.

Click the button to move the filter in front of the camera when you are determining the drop delay. The button changes to red (🔥). To determine the drop delay, the streams are illuminated by the diode laser just below the point of deflection. Specialized fluorescent particles (Accudrop beads) can be viewed in the center and left side streams as the delay is adjusted. The best delay yields the most particles in the left stream and the fewest in the center stream.

### Table 2-2  Side Stream window controls (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Voltage field</td>
<td>Adjusts the total voltage difference between the plates, which determines</td>
</tr>
<tr>
<td></td>
<td>the angle of stream deflection. The voltage values change with different</td>
</tr>
<tr>
<td></td>
<td>nozzle sizes.</td>
</tr>
<tr>
<td>2nd, 3rd, 4th Drop fields</td>
<td>Apply a correction factor for the drop charge as a percentage of the</td>
</tr>
<tr>
<td></td>
<td>previous drop, from –100% to 100%.</td>
</tr>
<tr>
<td>Phase field</td>
<td>Adjusts the phase between drop generation and charging of the droplets</td>
</tr>
<tr>
<td></td>
<td>from 0–360°. The selected value is sent to both the drop-charging electrode</td>
</tr>
<tr>
<td></td>
<td>and the drop strobe. In general, the Phase never needs adjusting. You can</td>
</tr>
<tr>
<td></td>
<td>keep the default value of zero.</td>
</tr>
</tbody>
</table>
See Determining the Drop Delay – Manual Method on page 166 for more information.

**Auto Drop Delay**

The Auto Drop Delay feature enables the system to optimize the drop delay automatically. See Determining the Drop Delay – Automatic Method on page 171.

**Drop Charging**

Drops are charged when an event is detected and meets the defined sorting criteria, as specified in the Sort Layout window.

The Sort Layout window contains all sorting instructions and controls (Figure 2-16). The sort layout designates which device will be used to collect sorted particles and which particles will be sorted into each sort location. Up to four sort counters can be displayed in the window to give ongoing status during a sort. See Sort Layout on page 103 for more information about the Sort Layout window.

**Figure 2-16** Sort layout for a four-way sort

Target events are identified by drawing gates around populations of interest in plots. The Sort Layout window specifies which gated population should be sorted into each sort collection tube or spot in a plate or on a slide. During sorting, when an event is identified within one of the sort gates, the drop containing the particle of interest is charged via the stream-charging wire attached to the flow cell. See Figure 2-17 on page 69.
The amount and type of charge determines where the drop will be sorted. For example, in a four-way sort, drops with the most charge will be deflected into the outer streams, while drops with less charge will be deflected into the inner streams.

**Conflict Resolution During Sorting**

During sorting, the cytometer deflects drops based on the characteristics of the particles in each drop and where the user wants to deflect them. Conflicts can occur depending on the type of target particle, where the particle is located within a drop, or whether the drop is free of contaminating particles. BD FACSDiva software accurately measures particle position to within 1/32 of a drop.

*Masks* settings determine how drops are deflected when sorting conflicts occur. There are three Mask settings, each of which addresses a different type of conflict. These settings are combined to define sort *Precision Modes*. Each mode is made up of a set of masks. Precision Modes are defined in the Sort Precision dialog, accessed from the Sort menu.
**Yield Mask**

The *Yield Mask* setting defines how close to the edge of the drop, in 1/32-drop increments, a particle of interest can be located before sorting an additional drop. Half of each Yield Mask setting defines an equal area at each end of the drop.

For example, when the Yield Mask is set to 16 and an event is within 8/32 from the beginning of a drop, the previous (leading) drop will be sorted. If an event is within 8/32 from the end of a drop, the following (trailing) drop will be sorted. See Figure 2-18.

**Figure 2-18** Target particle within a Yield Mask of 16

![Target particle within a Yield Mask of 16](image)

If the Yield Mask were set to 8 for the same target particle, the target particle would fall outside of the Yield Mask; therefore, no additional drops would be sorted. See Figure 2-19.

**Figure 2-19** Target particle outside a Yield Mask of 8

![Target particle outside a Yield Mask of 8](image)

When the Yield Mask is set to zero, only one drop (the drop containing the target particle) will be deflected. When the mask is set to 32, two drops will always be deflected. Yield Masks between 0–32 will sort either one or two drops.

Yield Masks cannot be used in conjunction with Phase Masks. Therefore, when the Yield Mask is greater than zero, the Phase Mask automatically reverts to zero.
**Purity Mask**

The *Purity Mask* setting defines how close, in 1/32-drop increments, a contaminating drop can be located before ignoring the drop being interrogated.

For example, when the Purity Mask is set to 16, the drop being interrogated will not be sorted if a non-target particle falls within the first or last 8/32 of the leading or trailing drop. In the following example, a non-target particle falls within the first 8/32, so the interrogated drop will not be sorted (Figure 2-20).

**Figure 2-20** Non-target particle within a Purity Mask of 16

![Diagram of a droplet with a purity mask of 16, showing a non-target particle within the first 8/32 of the drop, not sorted.]

If the Purity Mask were set to 8 for the same target particle, the non-target particle would fall outside of the Purity Mask, so the interrogated drop would be sorted. See Figure 2-21.

**Figure 2-21** Non-target particle outside a Purity Mask of 8

![Diagram of a droplet with a purity mask of 8, showing a non-target particle outside the purity mask, sorted.]

**NOTE** With any Purity Mask greater than zero, the drop being interrogated must be free of contaminating particles or the drop will not be sorted. If the purity mask is set to zero, a droplet containing the event of interest will be sorted regardless of contaminating particles.
Phase Mask

Particles near the drop edge can affect the breakoff and alter the trajectory of the deflected drop. The Phase Mask restricts drop deflection when an event is too close to the edge of a drop or when there are events close to the edge of adjacent drops. A Phase Mask is used to improve counting accuracy and side-stream quality at the expense of yield.

For example, when the Phase Mask is set to 16, the drop being interrogated will be sorted only if the target particle falls outside the Phase Mask (Figure 2-22).

Figure 2-22  Sorted and unsorted drop with Phase Mask of 16

![Sorted and unsorted drop with Phase Mask of 16]

Decreasing the Phase Mask to 8 allows more drops to be sorted. However, because the target particle is closer to the edge of the drop, there is more variability in drop trajectory (Figure 2-23).

Figure 2-23  Sorted drop with Phase Mask of 8

![Sorted drop with Phase Mask of 8]

**Tip**  We recommend using a Phase Mask of at least 8 when sorting single cells.
Phase Masks cannot be used in conjunction with Yield Masks. Therefore, when the Phase Mask is greater than zero, the Yield Mask automatically reverts to zero.

**Sort Precision Modes**

Mask values can be combined in many different ways. By default, six Sort Precision modes are already defined: Purity, 4-Way Purity, Yield, Single Cell, Initial, and Fine Tune.

<table>
<thead>
<tr>
<th>Precision Mode</th>
<th>Purity</th>
<th>4-Way Purity</th>
<th>Yield</th>
<th>Single Cell</th>
<th>Initial</th>
<th>Fine Tune</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yield Mask</td>
<td>32</td>
<td>0</td>
<td>32</td>
<td>0</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td>Purity Mask</td>
<td>32</td>
<td>32</td>
<td>0</td>
<td>32</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Phase Mask</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>16</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Single Cell</td>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
</tbody>
</table>

- In Purity mode, the Yield Mask is set to the maximum to obtain the greatest number of particles. Because the Purity Mask is also set to the maximum, only drops free of contaminating particles will be sorted. Sorting in Purity mode results in a sorted sample that is highly pure, at the expense of recovery and yield.

- In 4-Way Purity mode, the Purity Mask is set to the maximum, so only drops free of contaminating particles will be sorted. The Yield Mask is set
to zero to ensure that residual charges from adjoining drops do not degrade the quality of side streams. The 4-Way Purity mode is recommended for four-way sorting where precise deflection is required.

- In Yield mode, only the Yield Mask is used at its maximum value. Recovery and yield are optimized at the expense of purity. The yield mode could be used as a first round sort for enrichment of target particles, followed by a sort for purity.

- In Single Cell mode, the Purity Mask is set to the maximum, so only drops free of contaminating particles will be sorted. The Phase Mask is set to half the maximum, so only particles centered within the sorted drop are deflected. Drop trajectory and count accuracy are optimized at the expense of yield. This mode is recommended for plate sorting or situations where precise counting is required.

The remaining modes are used mainly during drop delay determination. Initial mode is equivalent to Yield mode, but it is named differently as a reminder to use this as the initial mode when using Accudrop to set the drop delay.

- In Initial mode, only the Yield Mask is used at its maximum value. Recovery and yield are optimized at the expense of purity.

- In Fine Tune mode, all masks are set to zero to deflect the maximum number of drops. This mode is used to fine-tune the drop delay value. See Determining the Drop Delay – Manual Method on page 166 for more information.
Defining New Precision Modes

Default Precision modes cannot be edited or deleted. However, you can create new modes and then select them from the Precision Mode menu.

1. Select Sort > Sort Precision.

![Sort Precision window]

2. Click Add, and the current sort mode is duplicated and the Mask fields are enabled.

3. (Optional) Change the name of the mode in the Precision Mode field.

4. Enter values for the Yield, Purity, and Phase Masks.

5. Select the Single Cell checkbox, if needed.

6. Click Close.

   The new mode is added to the Precision Mode menu.

To delete a mode, select it from the Precision Mode menu and click Delete.
Many BD FACSARia II cytometer functions are controlled using BD FACSDiva software. This chapter provides a general overview of the workspace components and describes software controls that are unique to the BD FACSARia II cytometer. For an in-depth description of software components not described in this chapter, refer to the *BD FACSDiva Software Reference Manual*.

The following topics are covered in this chapter:

- Workspace Components on page 78
- Cytometer Controls on page 79
- Sorting Controls on page 98
- Templates on page 112
Workspace Components

When you start BD FACSDiva software, the workspace appears (Figure 3-1). For a general overview of the workspace and to get started using the software, refer to Getting Started with BD FACSDiva Software. When running BD FACSDiva with the BD FACSARia II, two additional windows can be displayed by clicking the Sorting button on the Workspace toolbar. See Sorting Controls on page 98 for a description.

Figure 3-1  BD FACSDiva workspace
Cytometer Controls

Most BD FACSARia II-specific cytometer controls are accessed through the Cytometer menu. Controls on the Cytometer menu are described in the following sections:

- Fluidics Controls on page 79
- Cytometer Configuration on page 84
- Cytometer Status Report on page 88

The Cytometer Details and the Catalogs menu commands are described in the BD FACSDiva Software Reference Manual. Additional cytometer controls are located in the Acquisition Dashboard. See Acquisition Controls on page 97.

Fluidics Controls

Fluidics control of the BD FACSARia II cytometer is partially automated by BD FACSDiva software. The software contains pre-programmed fluidics protocols that are activated by choosing the corresponding menu command from the Cytometer menu. In addition, fluidics level indicators are available in the Cytometer window. See Fluidics Level Indicators on page 83.

Fluidics Startup

During fluidics startup, waste and sheath levels are verified and the fluidics system is primed with sheath solution. The fluidics status is displayed at the bottom of the main window.

See Cytometer Startup on page 114 for more information.
**Fluidics Shutdown**

Fluidics shutdown removes sheath from the lines and replaces it with ethanol, and cleans the cuvette with a cleaning solution. See Fluidics Shutdown on page 190 for more details.

**Change Sample Filter**

Sample line filters can be installed to filter a sample before sorting. This selection opens the Sample Filter Change wizard, which guides you through the process. See Installing or Removing a Sample Line Filter on page 220 for the instructions.

**Cleaning Modes**

BD FACSDiva software contains pre-programmed cleaning modes that are activated by choosing the corresponding menu command from the Cytometer > Cleaning Modes menu. See Internal Cleaning on page 194 for more information.

<table>
<thead>
<tr>
<th>Cytometer</th>
<th>Sort</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluidics Shutdown</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Sample Filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cleaning Modes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sheath Pressure</td>
<td>Sample Autoclean</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sample Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sample Temperature</td>
<td></td>
</tr>
<tr>
<td>Cytometer Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Configurations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CST</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Performance Tracking (L2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cytometer Status Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Catalog</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Standby</td>
<td></td>
</tr>
</tbody>
</table>

**Sheath Pressure**

The sheath pressure determines how quickly particles pass through the laser beam. Select Cytometer > Sheath Pressure to view the current sheath pressure and change the pressure for custom sort setups.
Sample Agitation

Select Cytometer > Sample Agitation to specify the speed at which samples are agitated. You can select from one of the specified values, or select Off to turn off agitation.
Sample Temperature

Use the Sample Temperature command to set the temperature inside the sample injection chamber. You can select from one of the specified values, or select Off to turn off temperature control (Figure 3-2).

Figure 3-2 Setting the sample temperature

The cooling/heating unit is designed to maintain the temperature of a sample tube. It is not designed to cool or heat the sample. It takes approximately 45 minutes to reach the required temperature inside the chamber, during which time the chamber must be kept closed.

To cool or heat the chamber, install a sample tube and click Load. Click Stop Acquiring to keep the chamber closed and stop running the sample. To maintain the temperature, do not leave the chamber open for extended periods while changing sample tubes.

The sample temperature retains the last setting after startup. For example, if it was set to 20 C the last time the system was used, then it will return to that setting the next time the system is started up.
Fluidics Level Indicators

BD FACSDiva software provides fluidics level indicators in the Cytometer window (Figure 3-3). The sheath and waste indicators provide an approximate indication of the fluid levels in each tank. The DI, bleach, and ethanol tank indicators appear full until the fluid level descends below 20% of the tank capacity. When this occurs, the corresponding level indicator changes to black.

**NOTE**  The stainless steel ethanol shutdown tank does not have a level sensor. It must be checked manually.

*Figure 3-3  Fluid level indicators*

When the sheath is low or the waste is full while the stream is running, the corresponding indicator turns red and the following warning message is displayed every 5 minutes until the stream is turned off. If the warning message is not dismissed, the system automatically turns off the stream after 15 minutes.

![Warning Message]

**WARNING**  Do not dismiss the warning message without refilling the sheath or emptying the waste. If you continue to run the cytometer after dismissing the message, the system could shut down.
Cytometer Configuration

The menu selections shown in Figure 3-4 open the Cytometer Setup and Tracking (CS&T) module in a separate window. The CS&T module enables you to perform multiple functions related to cytometer configuration.

NOTE When the CS&T module is open, BD FACSDiva software goes into a holding mode and does not accept any user input. When CS&T is closed, BD FACSDiva becomes active again.

Figure 3-4 Cytometer menu selections that open CS&T

- View Configurations—Opens the Cytometer Configuration window within the main CS&T window. See the following section for an overview of this function.

- CST—Opens the CS&T module. See the Cytometer Setup and Tracking Application Guide for complete information on using CS&T.

- Performance Tracking (LJ)—Opens the Performance Tracking feature within the main CS&T window. See the Cytometer Setup and Tracking Application Guide for complete information on using this feature.
Cytometer Configuration Window

The BD FACSARia II cytometer is equipped with a specific set of lasers, filters, and dichroic mirrors. The Cytometer Configuration window lets you define which fluorochromes or cell parameters will be measured at each photomultiplier tube (PMT) detector. Within this window, you can define parameters for an unlimited number of fluorochromes, up to four lasers, and all of the detectors.

Select Cytometer > View Configurations to open the window shown in Figure 3-5 on page 86. Click the Parameters tabs for a list of parameters. Click the Filters and Mirrors tab for the list of optics.

The Cytometer Configuration window also displays these settings:

- Sheath pressure
- Nozzle size
- Window extension

See the Cytometer Setup and Tracking Application Guide for more information on editing configurations, including adding parameters, mirrors, and filters.
Before you start any experiment, verify that the cytometer configuration contains appropriate parameters for the samples you are running and that the cytometer optics match the current configuration. If needed, you can add or modify parameters in an existing configuration or define a custom configuration, as described in Custom Configurations on page 90.

⚠️ For accurate data results, the cytometer optics must match the current cytometer configuration.
Selections in the Cytometer Configuration window determine which parameters are available for your experiment. When more than one parameter is available for a detector, the first parameter is listed by default. To select a different parameter, click the name in the Parameters tab of the Cytometer window in BD FACSDiva software and select a different parameter from the menu.
Cytometer Status Report

The Cytometer Status Report provides a list of all cytometer settings at the time the report was created. You must be connected to the cytometer to create the report. In an open experiment, click to set the current tube pointer and select Cytometer > Cytometer Status Report. The report is displayed in a separate window with a menu bar above the report header. The header lists the cytometer name, type, serial number, and the date and time the report was generated. See Figure 3-6 on page 89 for a sample report.

For a full description of the Cytometer Status Report, refer to the BD FACSDiva Software Reference Manual. A BD FACSAria II cytometer report includes the following additional information: user access privileges, cytometer information, cytometer settings, and sorting settings (for cytometers equipped with sorting features). The report can be printed or exported.

- The User Access Privileges section lists access settings for the current user.
- The Cytometer Info section lists values for laser delay, area scaling, window extension, FSC area scaling, sheath pressure, and sample flow rate.
- The Parameters section displays settings for the current acquisition tube.
- The Sort Settings section lists all sort setup values, along with the Plate Voltage and Voltage Center values. If the Sweet Spot is off, Breakoff and Gap values are shown. If the Sweet Spot is on, Drop 1 and target Gap values are shown.
Figure 3-6  Cytometer Status Report

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Type</th>
<th>Log</th>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMT</td>
<td></td>
<td>A, H, W</td>
<td>Off</td>
<td>150</td>
</tr>
<tr>
<td>SSC</td>
<td></td>
<td>A, H, W</td>
<td>Off</td>
<td>146</td>
</tr>
<tr>
<td>PFC</td>
<td></td>
<td>A, H</td>
<td>On</td>
<td>140</td>
</tr>
<tr>
<td>PE</td>
<td></td>
<td>A, H</td>
<td>On</td>
<td>140</td>
</tr>
<tr>
<td>PE-Trans</td>
<td>14.45</td>
<td>14.45</td>
<td>15.12</td>
<td>15.12</td>
</tr>
<tr>
<td>PE-Trans</td>
<td>100.00</td>
<td>100.00</td>
<td>100.00</td>
<td>100.00</td>
</tr>
<tr>
<td>APC</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>APC-67</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Pacific Blue</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>AECyan</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Sort Settings**
- Gate Setup: 100 seconds
- Frequencies: 200 Hz
- Amplitude: 1 mV
- Phase: 0°
- Drop Delay: 27 ms
- Attenuation: 0 dB
- Scale Step: On
- First Drop: 250 ms
- Data Rate: 31 data points per second
- Voltage Setting: 2,500.00
- Voltage Outgoing: 0 V

**Side Shear Voltage (%)**
<table>
<thead>
<tr>
<th>For Left</th>
<th>For Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>60.00</td>
<td>60.00</td>
</tr>
<tr>
<td>59.00</td>
<td>59.00</td>
</tr>
</tbody>
</table>

**Neighboring Drop Charge (%)**
<table>
<thead>
<tr>
<th>2nd</th>
<th>3rd</th>
<th>4th</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.00</td>
<td>6.00</td>
<td>3.00</td>
</tr>
</tbody>
</table>
Custom Configurations

Before you can record data, you must first ensure that the cytometer configuration is appropriate for the experiment. If needed, you can create custom configurations to add parameters or filters and mirrors that are not listed in the base configuration. You will also need to create custom configurations for each sheath pressure you would like to run.

When creating custom configurations, use descriptive names that make it easy to identify the configuration. Refer to the BD FACSDiva Software Reference Manual and the BD Cytometer Setup and Tracking Application Guide for more information.

Preparing for Custom Configurations

Custom configurations can only be created by users with administrator access. The easiest way to create a custom configuration is to copy and edit a base configuration. You can also create a new, blank configuration.

1. Log in to the software as an administrator.

2. Go to Sort > Sort Setup and select the setup mode to match the nozzle size you are using.

3. Verify the correct nozzle is installed, then start the stream.

4. Select Cytometer > CST.

The Cytometer Configuration window appears. (See Figure 3-5 on page 86.) For users with administrator access, the window displays the Parameters and Filters and Mirrors tabs, which are not visible to users with operator access.

**NOTE** When you create a new configuration in CS&T, you need to run a new baseline for that configuration. Once the baseline is established, you cannot edit any of the settings in the configuration.
Adding Parameters, Filters, and Mirrors

Before creating a custom configuration, verify that the necessary parameters, filters, and mirrors required for the custom configuration are defined.

1. To add new parameters, do the following in the Parameters tab:
   a. Click Add.
   b. Enter a parameter name in the field provided.

2. To add filters or mirrors, do the following in the Filters and Mirrors tab:
   a. To add a filter, click Add under the Filter list. To add a mirror, click Add under the Mirror list.
   b. Select a Pass Type and enter a wavelength in the field provided.
Copying a Base Configuration

You cannot edit or delete your Base Configuration. However, you can use it as a starting point to create a custom configuration.

1. In the Configurations tab, right-click the Base Configuration folder and select New Folder.

2. Rename the new folder Custom Configurations.

3. Right-click the Base Configuration and select Copy.

4. Right-click the Custom Configurations folder and select Paste.

5. A copy of the base configuration is added to the Custom Configurations folder.
Enter a descriptive name and press Enter.

For example, use the name 70-70, meaning 70 micron nozzle at 70 psi. If you need to rename the configuration, right-click the new configuration and select Rename.

**Editing the Copied Configuration**

Once the base configuration is copied, you can customize the parameters, filters, and mirrors in the configuration.

1. In the configuration list, right-click the new configuration and select Edit Configuration.

The following window appears.

![Configuration Window](image)

Use the tabs at the bottom of the window to view each laser’s detectors separately.
2 To edit the nozzle size and sheath pressure for this configuration:

a Enter the appropriate sheath pressure value at the bottom of the configuration window.

b Select the appropriate nozzle size.

3 To edit the optical configuration:

• To change the parameter label for a detector, click and drag a new parameter from the Parameters list to the appropriate detector.

• To add more than one parameter label to a detector, Ctrl-click the parameters in the Parameters list, then drag them to the detector.
To verify that the sheath pressure in the Sort Setup matches the sheath pressure in the configuration:

1. Select File > Exit to exit CS&T.
2. Select Sort > Sort Setup, and select the Sort Setup that matches the nozzle size listed in your configuration.
3. Select Cytometer > Sheath Pressure and verify that the pressure matches the pressure in your configuration. Enter a new sheath pressure, if needed.
The new sheath pressure is automatically saved with the current Sort Setup mode.

![Sheath Pressure dialog](image)

Enter the same sheath pressure that was entered in the configuration.

**Tip** The name of the configuration is displayed at the top of the BD FACSDiva workspace. If you use a descriptive name for each configuration (such as 100-15-Custom, for nozzle size-sheath pressure-Sort Setup mode), it will be easier to verify that the appropriate settings match without going back to view the configuration.

### Configuration Mismatch Dialog

If there is a mismatch between the CS&T settings and those in BD FACSDiva software, a dialog opens (Figure 3-7 on page 97) to indicate what the differences are, and gives these options:

- **Use CS&T Settings**—Select this option if you have run a performance check or created a new configuration, and want to use those values.

- **Keep Current Settings**—Select this option if you were viewing a configuration in CS&T, and don’t want to change the values. For example, settings for area scaling for the particle of interest.
Acquisition Controls

Along with the controls described in the BD FACSDiva Software Reference Manual, the following acquisition controls are available for the BD FACSaria II cytometer.
• Load—Lifts a tube into the sample injection chamber, starts sample agitation (if agitation is turned on), and starts acquisition of the sample.

When a tube is already loaded, the button changes to Unload. Clicking Unload stops acquisition of the sample, turns off the agitator, and lowers the tube from the sample injection chamber.

**NOTE** The Load button is enabled only when the workstation is connected to the cytometer, an experiment is open, the stream is turned on, and the current tube pointer is set to a tube.

• Stop Acquiring—Stops sample acquisition without unloading the sample tube.

The Acquire Data button functions only when a tube is loaded.

• Flow Rate—Controls sample flow rate, from 1.0–11.0 (10–80 µL/min).

Do one of the following to change the flow rate:

- Select the value in the field and enter a new value.
- Click the pointer in the slider bar and drag it to a new value.
- Use the mouse to click the up and down arrows or press the arrow keys on your keyboard to increase or decrease the values in small increments.

**Sorting Controls**

All sorting on the BD FACS Aria II cytometer is controlled by BD FACSDiva software. Sorting controls are shown in Figure 3-8 on page 99. See Table 3-1 on page 99 for explanations of each area.
Table 3-1 Description of sorting controls

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The <strong>Sort menu</strong> provides access to the sort setup and sort precision modes, sort layouts, sort reports, and sort devices used with the automated cell deposition unit (ACDU). See Sort Menu on page 100.</td>
</tr>
<tr>
<td>2</td>
<td>The <strong>Sort Layout</strong> window designates which device will be used to collect sorted particles and which particles will be sorted into each sort location. Sorting controls and counters are also displayed in the window. See Sort Layout on page 103.</td>
</tr>
<tr>
<td>3</td>
<td>The <strong>Breakoff</strong> window displays an image of the stream and contains controls to adjust drop formation. See Drop Formation on page 61.</td>
</tr>
<tr>
<td>4</td>
<td>The <strong>Side Stream</strong> window displays an image of the side streams, and contains controls to adjust electrical charges and the drop delay. See Side Stream Formation on page 65.</td>
</tr>
</tbody>
</table>
Sort Menu

Select commands in the Sort menu for the following:

- **Sort Setup**—Downloads the most recently used settings for selected nozzle size. See Sort Setup on page 101.

- **Sort Precision**—Opens a dialog box where you can select or define a sort precision mode for handling sorting conflicts. See Conflict Resolution During Sorting on page 69.

- **New Sort Layout**—Opens the default 2-Tube Sort Layout window where other sort layouts can be selected. See Sort Layout on page 103. (Note that clicking the Sort Layout button on the Browser toolbar performs the same function.)

- **Open Sort Layout**—Opens an existing sort layout. A sort layout must be selected in the Browser for this menu command to be enabled. Alternatively, double-click any sort layout to open it.

- **Home Device**—Opens a dialog box containing commands to move the tray support arm, either manually or to the home position. See Setting Up the Stream on page 181.

- **Custom Devices**—Opens a dialog box where custom devices can be defined. See Creating a Custom Device on page 184.

- **Sort Report**—Displays a report showing the sort settings, acquisition counters, and sort layout information from the current sort. See Sort Report on page 110.
Sort Setup

Sort setup values for four different nozzle sizes can be downloaded using the Sort > Sort Setup command. Default settings are provided for each sorting option, along with a custom setting for each option.

As a general rule, for optimal results when sorting large or fragile cells, use a larger nozzle size and lower pressure. To increase throughput and yield when sorting smaller or less fragile cells, use a smaller nozzle size and higher pressure.

<table>
<thead>
<tr>
<th>Sort Setup name</th>
<th>Nozzle (microns)</th>
<th>Default pressure (psi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 micron</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>85 micron</td>
<td>85</td>
<td>45</td>
</tr>
<tr>
<td>100 micron</td>
<td>100</td>
<td>20</td>
</tr>
<tr>
<td>130 micron</td>
<td>130</td>
<td>10</td>
</tr>
</tbody>
</table>

If you make changes to any of the settings, the changes are automatically saved when you exit BD FACSDiva software or when you switch to a different sort setup mode. When you restart, the most recently used set of values is restored. Default settings are shown in Table 3-2 on page 102.

In addition, the sort setup menu has following menu items: 70 Custom, 85 Custom, 100 Custom and 130 Custom. Initially, all of these new setups are exact copies of the corresponding original setups with the same defaults. This allows you to create two sets of sort values (pressure, for example) for the same nozzle size.

⚠️ Do not use a nozzle size that is different from the sort setup setting. The gap values and sensitivity algorithms are optimized for particular nozzles and are not suitable for other nozzle sizes. The system performance could be unstable.
Table 3-2  Default Sort Setup values

<table>
<thead>
<tr>
<th>Setting</th>
<th>70 micron</th>
<th>85 micron</th>
<th>100 micron</th>
<th>130 micron</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheath Pressure</td>
<td>70</td>
<td>45</td>
<td>20</td>
<td>10</td>
</tr>
<tr>
<td>Amplitude</td>
<td>60</td>
<td>32</td>
<td>12</td>
<td>24</td>
</tr>
<tr>
<td>Frequency</td>
<td>87</td>
<td>47</td>
<td>30</td>
<td>12</td>
</tr>
<tr>
<td>Drop 1</td>
<td>150</td>
<td>150</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>Gap (upper limit)</td>
<td>6 (14)</td>
<td>7 (17)</td>
<td>10 (21)</td>
<td>12 (21)</td>
</tr>
<tr>
<td>Attenuation</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Drop Delay</td>
<td>47.00</td>
<td>30.00</td>
<td>27.00</td>
<td>16.00</td>
</tr>
<tr>
<td>Far left voltage</td>
<td>100</td>
<td>100</td>
<td>80</td>
<td>60</td>
</tr>
<tr>
<td>Left voltage</td>
<td>40</td>
<td>35</td>
<td>30</td>
<td>20</td>
</tr>
<tr>
<td>Right voltage</td>
<td>40</td>
<td>35</td>
<td>30</td>
<td>20</td>
</tr>
<tr>
<td>Far right voltage</td>
<td>100</td>
<td>100</td>
<td>80</td>
<td>60</td>
</tr>
<tr>
<td>Plate voltage</td>
<td>4,500</td>
<td>4,000</td>
<td>2,500</td>
<td>2,000</td>
</tr>
<tr>
<td>2nd Drop</td>
<td>20</td>
<td>20</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>3rd Drop</td>
<td>10</td>
<td>10</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>4th Drop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Laser Delay (blue)</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Laser Delay (red)</td>
<td>-36.00</td>
<td>-54.00</td>
<td>-40.00</td>
<td>-82.00</td>
</tr>
<tr>
<td>Laser Delay (violet)</td>
<td>36.00</td>
<td>54.00</td>
<td>40.00</td>
<td>82.00</td>
</tr>
<tr>
<td>Area Scaling (blue)</td>
<td>1.40</td>
<td>1.20</td>
<td>1.40</td>
<td>0.75</td>
</tr>
<tr>
<td>Area Scaling (red)</td>
<td>1.00</td>
<td>0.75</td>
<td>1.00</td>
<td>0.50</td>
</tr>
<tr>
<td>Area Scaling (violet)</td>
<td>0.80</td>
<td>0.35</td>
<td>0.50</td>
<td>0.25</td>
</tr>
<tr>
<td>Window Extension</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>4.00</td>
</tr>
</tbody>
</table>
Sort Layout

The Sort Layout window contains all sorting instructions and controls. The sort layout designates which device will be used to collect sorted particles and which particles will be sorted into each sort location. Up to four sort counters can be displayed in the window to give ongoing status during a sort.

Only one sort layout can be open at a time, but you can create several layouts for a single tube, as long as each sort layout has a different name. Sort layouts can also be added to global worksheets.

Sort layouts are available for up to nine default collection devices (shown in the following figure). Additional custom devices can be defined. See Creating a Custom Device on page 184.

Examples of sort layouts for different devices are shown in the following figures. Instructions for setting up a sort layout can be found in Setting Up a Sort Layout on page 105.
Figure 3-9  Sort layout for collection tubes (top) and for a 48-well plate (bottom)

Figure 3-10  Sort layout for a frosted slide
Setting Up a Sort Layout

Sort layouts can be added to tubes or global worksheets.

- Create tube-specific layouts if you are sorting different populations or using different sort devices for each tube in the experiment.
- Create global worksheet-specific layouts if you are sorting the same populations into the same sort device for all tubes in the experiment.

**NOTE** To create a tube-specific sort layout, make sure a normal worksheet (white tab) is shown in the Worksheet window before you create the layout.

1. Select the icon for a tube or global worksheet in an open experiment and click the New Sort Layout button ( ) on the Browser toolbar.

2. In the Sort Layout window, select the type of device from the Device menu.

   Default sorting devices are listed along with any defined custom devices. The Sort Layout window changes depending on the selected device. The number of rows and columns in the window matches the number of tubes, wells, or spots in the collection device.

3. Select the sort precision mode from the Precision menu.

   For more information, see Sort Precision Modes on page 73.

4. Enter the number of events to be sorted in the Target Events field.

   Once entered, the number of events can be selected from the Target Events menu. For continuous sorting, select Continuous from the Target Events menu.

5. Select one of the following options from the Save Sort Reports menu:

   - Save None—Sort Reports are not saved.
   - Save All—Automatically saves sort report each time the sort is stopped.
• Ask User—Prompts the user each time the sort is stopped to select whether or not to save the sort report. This is the default option.

This setting is saved with the sort layout.

6 Select the field(s) corresponding to the tube(s), well(s), or spot(s) where the population will be sorted and select a defined population from the Add menu.

When you click in a sort location field, a menu appears allowing you to add, delete, or clear all populations in the field (Figure 3-11).

**Figure 3-11 Adding populations to be sorted**

After you add a population, the population and the number of target events are added to the corresponding sort location field.

**Tip** Select a row or column header to select all fields in that row or column. When you add a population, it will be added to all selected fields at once.

7 Specify whether to save sort conflicts by selecting the Save Conflicts checkbox.

This checkbox is enabled only when using a two- or four-tube layout. When selected, all sort conflicts are sorted into a default location.

• For a two-tube layout, conflicts are sorted to the right.
• For a four-tube layout, conflicts for the Far Left tube are sorted to the left, and conflicts for the Far Right tube are sorted to the right.

Editing a Sort Layout

• To change the number of events for any population, click in the Sort Location field(s) containing the population, then select a number from the Target Events menu or enter a new number.

• To remove a population from a sort location field, select the field, then select the corresponding population from the Delete menu.

• To clear all populations from a field, select the field, then select Clear All.

Using Sorting Controls

Sorting controls appear at the bottom of the Sort Layout window. Use these controls for the following functions.

• Sort—Starts sorting events for the current acquisition tube. All counters reset to zero when this button is clicked. Events are sorted until the requested number of sorted events has been reached.
Click the Sort button again to stop sorting before reaching the requested number of events. The counters stop at the number of sorted events. If you click Sort to restart sorting, the counters reset to zero.

- **Pause**—Stops sorting, but not acquisition. Sort counters and sort timers freeze when the Pause button is clicked. Click the Resume button to continue sorting and to continue incrementing the sort counters and timers. See Pausing and Resuming a Sort on page 178.

- **Access Stage**—When the ACDU stage is in the back, the stage is moved forward to put a plate on or take a plate off the stage. When the stage is in the front, the stage is moved to the back and out of the way so you can install a collection tube holder.

- **Move Drawer**—Moves the aspirator drawer in (closed) or out (open) depending on its current state. The default state is in. For more information, see Aspirator Drawer on page 30.

### Using Counters

Counters provide ongoing status during sorting. Counter fields cannot be edited. To display fewer counters in the Sort Layout window, click the View Counters button and select a menu option. The corresponding counter is hidden. (Only counters with a checkmark next to the name are displayed.)

Counters display the following information:
• Sort Rate—number of events per second that met the sort criteria and were sorted

• Conflict Count—number of events that met the sort criteria but were not sorted because of conflicts

• Conflict Rate—number of conflicts per second

• Efficiency—number of sorted events/(sort conflicts + sorted events) x 100

Monitoring a Sort

During sorting, each sort location field displays the number of actual sorted events (Figure 3-12). When a target number is specified, the field displays the actual number of events along with the number of target events.

A progress bar appears behind the Sort Rate counter field showing the progress of the sort.

Figure 3-12 Sort Layout during sorting
Sort Report

Select Sort > Sort Reports to view all of the saved reports for the current sort layout (see Figure 3-13). A Sort Report can be printed or exported. The Sort Reports menu item is enabled if either of the following is true: a sort layout is selected in the Browser (even if experiment is closed), or a sort layout is open. If both conditions are true, the Browser selection takes precedence.

Figure 3-13  Select Sort Reports

A Sort Report (see Figure 3-14 on page 111) contains the following:

- Header information—experiment name, specimen name, tube name, sort layout name, type of collection device, and the date and time of printing
- Sort Settings—sort setup values, precision mode, and mask definitions
- Acquisition Counters—threshold count, processed events count, electronic conflicts count, and elapsed time
- Sort Counters—counter values per sort destination, or total sort count if sorting sequentially
- Sort Layout—population(s), sort count, and target event count for each sort location field
The Sort Report window contains a File menu where you can select to print or export the report. Exported comma-separated value (CSV) files can be opened with a spreadsheet application such as Microsoft Excel®.
When you install BD FACSDiva software for the BD FACS Aria II cytometer, the following additional experiment templates are installed in the BD Export Templates directory:

- **Accudrop Drop Delay template**—Contains a single specimen and tube, a gated plot on a standard worksheet, and a predefined sort layout. This experiment is used for setting the drop delay during sorting as described in Determining the Drop Delay – Manual Method on page 166.

- **Doublet Discrimination Gating template**—Contains custom cytometer settings, a single specimen and tube, and three gated plots on a global worksheet. This experiment is used to eliminate doublets as described in Data Collection on page 144.

- **QC Experiment template**—Contains cytometer settings, a single specimen, one tube, and two global worksheets containing gated plots and statistics for data from each laser. This experiment is used for daily cytometer quality control, as described in QC Using BD FACSDiva Software on page 313.
Running Samples

The following topics are covered in this chapter:

- Cytometer Startup on page 114
- Checking Cytometer Performance on page 130
- Application Settings on page 136
- Data Collection on page 144
- Data Recording and Analysis on page 151
Cytometer Startup

Follow these steps to start up your BD FACSAria II cytometer.

1  Start up the workstation.

2  Turn on the cytometer main power.

   Figure 4-1  Power panel

   If the cytometer was just shut down, wait until the system is fully depressurized (stops hissing) before you turn on the main power.

3  Turn on the lasers. Wait 30 minutes for them to warm up.

   To turn on a laser, press the corresponding laser power button on the power panel (Figure 4-1).

   Tip  If you are using temperature control, start heating or cooling the sample injection chamber or the recirculating water bath while the lasers are warming up. See Sample Temperature on page 82.

4  Start BD FACSDiva software and log in with your user name and password.

   To start the software, double-click the application shortcut on the desktop.
5 Check the fluidics levels in the Cytometer window. Replenish fluids or empty the waste, if needed.

To display the Cytometer window, click the Cytometer button ( ) on the Workspace toolbar. Check the fluid levels at the bottom of the window (Figure 4-2).

Figure 4-2 Fluid levels in Cytometer window

To service the fluid containers, see Setting Up the Fluidics Cart on page 122 and Emptying the Waste Container on page 127.

Performing Fluidics Startup

This section describes the fluidics startup procedure. The status of the fluidics system is displayed in the bottom right corner of the main window.

1 From the BD FACSDiva Cytometer menu, select Fluidics Startup. The following window appears.
2 Verify that the air and fluid lines are disconnected from the ethanol tank and connected to the sheath tank, then click Done. See Figure 4-3.

Caution: Do not run fluidics startup with the air and fluid lines connected to the ethanol shutdown tank. This can cause damage to the system. Always verify that the lines are connected to the sheath tank.

![Figure 4-3 Air and fluid lines connected to sheath tank](image)

3 Verify that a closed-loop nozzle is installed in the flow cell, then click Done.

The fluidics startup process starts and the progress is displayed at the bottom of the dialog.
4 Remove the closed-loop nozzle from the flow cell, then click Done.

5 Insert the correct nozzle size in the flow cell.
   a Verify that the O-ring is installed in the nozzle.
   b Make sure the top side of the nozzle is facing up as you insert the
      nozzle.
   c Push the nozzle all the way back into the flow cell.
   d Turn the nozzle-locking lever clockwise to the 12:00 position.

6 Click OK to complete the process.

7 When fluidics startup is complete, select Sort > Sort Setup and verify that
   the setup mode matches the nozzle size.

   For information about Sort Setup modes, see Sort Setup on page 101.
Starting the Stream

The system can take anywhere from 20 seconds to several minutes to reach the correct pressure and turn on the stream, depending on the state of the system and the sort setup selected.

1 Start the stream.

   a Click the Sorting button ( ) on the Workspace toolbar to display the Breakoff and Side Stream windows.

   b Click the Stream button ( ) in the Breakoff window to turn on the stream.

2 Open the sort block door and check the stream.

   The stream should flow smoothly from the nozzle into the center of the waste aspirator.

   If the stream is flowing but is unsteady, check for bubbles in the flow cell. If you see bubbles, turn off the stream, wait for 10 seconds, and turn on the stream again.

   If you see any dripping or spraying, or the stream image appears abnormal, turn off the stream and see Troubleshooting the Stream on page 234.

3 Close the sort block door.

   NOTE If you encounter bubbles in the sheath fluid stream at the 130 micron sort setting, perform a sample line backflush for approximately 1 minute. Select Cytometer > Cleaning Modes > Sample Line Backflush.

   To prevent this, the sheath tank should be depressurized while not in use to prevent air from dissolving into the sheath solution.
Setting Up the Breakoff

Establishing a stable drop pattern in the breakoff window is an important step in getting optimal results from the system. See Breakoff Window on page 62 for more information on the parameters and controls in the breakoff window.

1 Adjust the Ampl slider until the drop breakoff is approximately in the top third of the Breakoff window.

Do not exceed 70 volts. If you cannot achieve a drop breakoff at <70 volts, do the following:

- Check the flow cell for air bubbles. If you see bubbles, turn the stream off and back on.
- Make sure the sheath pressure and drop drive frequency are appropriate. See Table 3-2 on page 102 for starting values.
- If the amplitude is <10 volts, turn on Attenuation in the Side Stream window.
2 Verify that the small satellite droplets are merging with the large droplets.

Satellite-merging is largely dependent on nozzle position. If the satellites are not merging, you might need to remove and reinstall the nozzle, or clean it by sonicating.

The satellite drops should merge into the drops in 6 satellites or fewer.

3 Enter the actual Drop 1 value as the target in the Drop 1 field.

The actual value appears in the gray background next to the Drop 1 field. Once a valid target has been established, you do not need to reset it unless you change the nozzle or your Sort Setup option.

Tip If the target value causes the Ampl to exceed 70 volts, perform the recommendations under step 1 and re-enter the Drop 1 target value.

4 Turn on the Sweet Spot when the drop pattern is stable.

The Sweet Spot is designed to automatically adjust the drop drive amplitude to maintain the stability of the breakoff point. When the Sweet Spot is on, the Amplitude and Frequency fields are disabled. The values are automatically adjusted by the software. For more information, see Breakoff Window on page 62.

See Table 4-1 on page 121 for examples of breakoff patterns at each nozzle size.
NOTE  The breakoff patterns in Table 4-1 are intended as examples. The patterns will not always look exactly like these.

Table 4-1  Examples of breakoff patterns at each nozzle size

<table>
<thead>
<tr>
<th>70 micron</th>
<th>85 micron</th>
<th>100 micron</th>
<th>130 micron</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

*Chapter 4: Running Samples  121*
Setting Up the Fluidics Cart

Check the fluid levels in the sheath tank and waste containers every time you use the cytometer. This ensures that you will not run out of sheath fluid during an experiment or have to service the containers during a sort. Fluidics level indicators are shown in the Cytometer window in BD FACSDiva software. See Figure 4-2 on page 115.

**NOTE** When the fluidics cart is in the correct position in the lab, lock the rolling casters by turning the orange disk until the feet contact the floor. This helps minimize any vibrations that could affect the stability of the stream.

If a fluidics container is running low, refill it with the fluid indicated on the container label. For best results, fill the containers only with the fluids shown in Table 4-2. For ordering information, see Reagents on page 268.

For instructions on emptying the waste, see page 127.

<table>
<thead>
<tr>
<th>Table 4-2 Recommended fluids</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container</td>
</tr>
<tr>
<td>Sheath(^a)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Ethanol Shutdown</td>
</tr>
<tr>
<td>Bleach</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>DI</td>
</tr>
<tr>
<td>Ethanol</td>
</tr>
</tbody>
</table>

\(^a\) Users should select solutions that are compatible with their specific samples and experiments.
NOTE Make sure the blue sheath fluid line between the sheath tank and the cytometer does not come into contact with anything that could introduce vibration that might affect the stability of the stream.

Refilling the Sheath Tank

The fluid level in the pressurized stainless steel sheath tank should be checked often and refilled when low. The startup times for the breakoff stream will increase when the tank is low.

NOTE If the cytometer is run until the sheath supply is too low, the system will turn off the stream.

Figure 4-4 Sheath tank connectors

1 Turn off the stream.

2 Disconnect the air line.

3 Pull up on the ring of the pressure relief valve to release pressure from the tank.

   Make sure the tank is fully vented.

4 Unscrew the sheath tank cover knob and remove the cover.
5  Fill the tank with sheath fluid up to the upper weld line on the inside of the tank. See Figure 4-5.

NOTE  Do not overfill the sheath tank because this can cause incorrect sample flow rates.

Figure 4-5  Sheath tank fill level

6  Replace the cover and tighten the knob.

Make sure the large O-ring on the inside lip of the cover is seated correctly and has not slipped out of position. The tank can leak if the cover is not secured properly.

7  If you removed the sheath tank from the fluidics cart to refill it, always place the tank back in its original position on the cart. See Figure 4-6.

The flow rate is calibrated with the sheath tank on the fluidics cart. If the location or elevation of the sheath tank is changed, it could affect the flow rate calibration.

Figure 4-6  Sheath tank location label

ATTENTION
SHEATH TANK (W)
located here
during instrument operation
to maintain calibration
8. Connect the air line. The system is ready to run again.

**Refilling the Ethanol Shutdown Tank**

The fluid level in the stainless steel ethanol shutdown tank should be checked before starting the fluidics shutdown procedure and refilled when low. This tank does not have a sensor, so it must be checked manually.

**Figure 4-7** Ethanol shutdown tank connectors

1. Turn off the stream.

2. If it is connected, disconnect the air line on the ethanol shutdown tank.

3. Pull up on the ring of the pressure relief valve to release pressure from the tank.

   Make sure the tank is fully vented.

4. Unscrew the tank cover knob and remove the cover.

5. Fill the tank with ethanol up to the weld line. See Figure 4-7.
6 Replace the cover and tighten the knob.

Make sure the large O-ring on the inside of the cover is seated correctly and has not slipped out of position. The tank can leak if the cover is not secured properly.

7 If you are going to perform fluidics shutdown, connect the air line.

**Refilling the Plastic Containers**

You can refill the plastic containers directly on the fluidics cart without detaching any lines, or you can remove the container for refilling. Note that during operation, you can add fluid to a container through the large cap without any interruption to your experiment, but if you detach any lines, you will need to prime the system.

1 (Optional) Disconnect the container’s sensor and quick-release connector if you need to move the container. (See Figure 4-8.)

If you do not need to move the container, skip to step 2.

**Figure 4-8** Plastic fluidics container lines

2 Remove the large-sized cap from the container (See Figure 4-8.)

3 Fill the container with the fluid indicated on the container label.
4 Replace the container cap and hand-tighten it until it is fully closed.

5 If you disconnected the sensor and quick-release connectors in step 1:
   a Reconnect the sensor and quick-release connectors to their respective ports.

⚠️ To ensure that the appropriate solutions are dispensed, do not switch the tank positions. Make sure the label on each container matches the labelled port on the fluidics cart.

b Prime the fluidics system.

   From the BD FACSDiva menu bar, select Cytometer > Cleaning Modes > Prime after Tank Refill. In the dialog box, select the fluid to prime, then click OK.

Emptying the Waste Container

Empty the waste container daily and when the fluid indicator shows the waste is getting full. To prolong the life of the container, we recommend that you switch to the alternate container each time the waste is emptied.

⚠️⚠️ All biological specimens and materials coming into contact with them can transmit potentially fatal disease. To prevent exposure to biohazardous agents, expose waste container contents to bleach (10% of total volume) before disposal. Dispose of waste in accordance with local regulations. Use proper precautions and wear suitable protective clothing, eyewear, and gloves.

⚠️⚠️ Change the waste container cap every month to prevent container pressurization. To order new replacement caps (BD Part No. 33885407, pack of 12), contact your local BD Biosciences representative.
Disconnect the waste container’s sensor and fluid line connectors from their respective ports on the fluidics cart.

The waste container can become pressurized when the cytometer is running. Always disconnect the container from the fluidics cart before you empty it. Wait at least 1 minute for pressure to dissipate before you open the container.

Remove the disposable waste cap (large-sized cap) and attached trap from the container. Place the assembly on the bench label-side up.

Do not wet the cap on top of the trap. If you see liquid inside the trap, remove the drain plug and fully drain the liquid before you replace the plug (Figure 4-10 on page 129).
3 Empty the waste container according to your standard laboratory procedures for biohazardous waste.

4 Add approximately 1 L of bleach to the waste container (10-L container). Add a sufficient amount so that 10% of the total waste volume is bleach.

5 Replace the waste trap and attached filter cap. Hand-tighten the trap and cap until they are fully closed.

To prevent over-pressurization during fluidics startup, do not overtighten the trap or attached filter cap. Tighten each component only until it is hand-tight. Do not use sealants such as Teflon® tape or other adhesives.

6 If one month has passed since you last changed the cap, replace the filter cap with a new one. Write the date on the new cap as a reminder.

7 Reconnect the sensor and fluid line connectors to their respective ports.
Checking Cytometer Performance

Before setting up an experiment, you should first run a performance check. A performance check ensures that the cytometer is performing consistently over time. It also generates default cytometer settings that places each PMT within an optimal range.

**NOTE** You can also use the quality control process originally established in previous versions of BD FACSDiva software. See QC Using BD FACSDiva Software on page 313.

To run a performance check, start the Cytometer Setup and Tracking (CS&T) application within BD FACSDiva software and select the appropriate cytometer configuration. Each configuration must have a valid baseline. Refer to the Cytometer Setup and Tracking Application Guide for more information on running a baseline.

Preparing the CS&T Workspace

To ensure that your cytometer is performing consistently over time, it’s important to keep as many variables constant as possible, such as bead type, sheath pressure, and cytometer settings. For this reason, you should run the daily performance check using the same cytometer configuration each day.

1. Turn off the Sweet Spot (if it is on), then select Cytometer > CST.

   The cytometer disconnects from the BD FACSDiva interface and connects to the Cytometer Setup and Tracking interface. A window similar to Figure 4-11 on page 131 opens.
Verify that the bead lot information under Setup Beads matches the Cytometer Setup and Tracking bead lot.

Select the correct Lot ID from the menu. The bead lot ID number is located on the CS&T beads vial.
Verify that the cytometer configuration is correct for your experiment.

If the cytometer is not set to the correct configuration:

a. Click Select Configuration in the Setup Control window.

b. Select the correct configuration from the list.

c. Click Set Configuration. Click OK.
Verify that the current configuration has a valid baseline defined. If not, refer to the Cytometer Setup and Tracking Application Guide for more information on running a baseline.

Preparing the CS&T Beads

The BD™ Cytometer Setup and Tracking beads consist of bright, mid, and dim beads dyed with a mixture of fluorochromes. Use the beads to define a baseline and to check cytometer performance using the CS&T application.

See the BD Cytometer Setup and Tracking beads package insert for more instructions about preparing the bead suspension.

1. Mix the beads by gently inverting the vial.
2. In a 12 x 75-mm tube, add 0.35 mL of sheath fluid and 1 drop of beads.

**NOTE** Beads are stable at 2°C to 25°C for no more than 20 minutes if stored in direct light, and up to 8 hours if protected from light.
Running a Performance Check

The performance check feature of Cytometer Setup and Tracking will check the cytometer’s daily performance.

1. Install the bead tube onto the cytometer loading port.

2. In the Setup Control window, select Check Performance from the Characterize menu.

3. Click Run.

Plots appear under the Setup tab and the performance check is run. The performance check takes approximately 5 minutes to complete.

Reviewing the Results

1. Once the performance check is complete, click View Report.

2. Print the Report.

3. Verify that the performance check passed.

   In the Setup tab, the Cytometer Performance Results should have a green checkmark and the word Passed next to it.

   If any parameters did not pass, refer to The Cytometer Setup and Tracking Application Guide for troubleshooting information.
4 Select File > Exit to close the Cytometer Setup and Tracking window and connect back to the BD FACSDiva interface.

5 Click Use CST Settings in the dialog that appears.

By selecting Use CST Settings, the laser delay, area scaling, and other cytometer settings will be updated to the latest optimized settings from the performance check.

Click the Details button to verify which cytometer settings will be updated.

At this point you can do one of the following:

- Continue to the next section to create Application Settings for an experiment you will use frequently.

- Collect data using existing application settings, see Data Collection on page 144.
Application Settings

Application settings are associated with a cytometer configuration and include the parameters needed for the application, area scaling values, PMT voltages, and threshold values, but not compensation. Each time a performance check is run for a configuration, the application settings associated with that configuration are updated to the latest run.

Using application settings provides an easy, consistent, and reproducible way to reuse cytometer settings for your commonly used applications. Refer to the Cytometer Setup and Tracking Application Guide for information on running a baseline and for other details on using the CS&T application.

Before creating application settings you must:

- Perform the cytometer startup procedure described in Cytometer Startup on page 114.
- Run a performance check for the cytometer configuration that will be used for the application.

Creating Application Settings

This section describes how to create and save application settings for a multi-color immunophenotyping sample.

Setting Up the Workspace

1. Create a new folder.
2. Create a new experiment.
3. Select the Cytometer Settings in the Browser.
4. In the Inspector window, click the Parameters tab and delete unneeded parameters.
5 Select the H checkbox to select Height for each parameter. See Figure 4-12 on page 137.

Figure 4-12 Inspector Window - Parameters tab

Adjusting Area Scaling

The required area scaling factor changes based on sheath pressure and particle size. The area scaling factors should be verified for each experiment performed on the cytometer.

1 In the Browser, right-click Global Sheet1 and select Apply Analysis Template.

2 In the Template dialog, select the Area Scaling worksheet and click OK.

3 Create a new specimen by clicking the New Specimen button on the Browser toolbar.

4 Expand the new specimen, then click to set the current tube pointer to Tube_001.

5 Install the FITC-positive control tube onto the loading port and click Load in the Acquisition Dashboard.
6 Adjust the FSC and SSC voltages to place the particles on scale. See Figure 4-13 on page 138.

**Figure 4-13** Adjusting FSC and SSC Voltages

7 Adjust the P1 gate around the population of interest in the FSC vs SSC plot. See Figure 4-14.

**Figure 4-14** FSC and SSC Plot

8 Adjust the FSC area scaling.

   a Click the Laser tab in the Cytometer window. See Figure 4-15.
**Figure 4-15** Adjusting FSC Area Scaling

b Adjust the FSC area scaling factor until the FSC-A signal matches the FSC-H signal. See Figure 4-16.

Increase the area scaling factor if the FSC-A signal is lower than FSC-H.

Decrease the area scaling factor if the FSC-A signal is higher than FSC-H.

c View the result of your change in the histograms and statistics views.
9 Adjust the blue laser area scaling until the FITC-A signal matches the FITC-H signal, if needed.

10 Unload the FITC-positive control tube, then load the APC-positive control tube.

11 Adjust the red laser area scaling until the APC-A signal matches the APC-H signal, if needed.

12 In the Inspector window, clear the checkbox for Height for all parameters. See Figure 4-17 on page 141.
Optimizing PMT Voltages

1. Right-click Cytometer Settings in the Browser, then select Application Settings > Create Worksheet.
   A second global sheet is added with the plots created according to your selections in the parameters tab. (See Figure 4-18.) Use the gray boxes and crosshairs to guide your optimization.

2. Load the unstained control tube onto the cytometer.

3. In the Cytometer window, optimize the settings for your application.
   a. Optimize the FSC and SSC voltages to place the population of interest on scale.
b  Optimize the FSC threshold value to eliminate debris without interfering with the population of interest.

c  If needed, increase the fluorescence PMT voltages to place the negative population within the gray boxes. Try to align the center of the negative population with the crosshair shown in the gray box.

**NOTE**  Do not decrease the fluorescence PMT voltages at this point. Doing so may decrease your ability to resolve dim populations from the negative population.

4  Unload the unstained control tube from the cytometer.

5  Load the multicolor sample onto the cytometer.

6  Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that parameter until the positive population can be seen entirely on scale.

7  Unload the multicolor sample from the cytometer.
Saving Application Settings

1 Right-click Cytometer Settings in the Browser, then select Application Settings > Save, to save the values for reuse. See Figure 4-19.

Figure 4-19 Saving Application Settings

\[
\text{a} \quad \text{In the Applications Settings dialog, rename the application settings with a descriptive name.}
\]

\[
\text{b} \quad \text{Click OK.}
\]

The application settings are saved to the catalog.
Data Collection

Before you record data for a sample, cytometer settings should be optimized to position the cells of interest on scale for scatter and fluorescence parameters. In the previous section, application settings were created by taking into consideration the following:

- FSC and fluorescence area scaling
- FSC and SSC voltages
- FSC threshold
- Fluorescence PMT voltages

In this section, the Application Settings will be applied and compensation will be calculated before collecting test data.

The following sections describe how to use previously optimized application settings for a 4-color experiment. See Application Settings on page 136 for more information.

Compensation will be automatically calculated using the Compensation Setup feature. For more information about this feature, refer to the *BD FACSDiva Software Reference Manual*. If you are performing compensation manually, not all steps will apply.

Setting Up the Workspace

Before you begin optimizing settings, it is important to verify the cytometer configuration and create an experiment containing appropriate parameters for the assay.

1. Select Cytometer > View Configurations, and verify that the current configuration is appropriate for the type of sample you are running.
2. Verify that there is a valid performance check for the configuration.
3 Make sure the octagon and trigon(s) contain appropriate filters. For assistance, see Cytometer Configuration on page 84.

⚠️ For accurate data results, the cytometer optics must match the current cytometer configuration.

4 Click the corresponding buttons on the Workspace toolbar to display the Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and Acquisition Dashboard ( ) windows, as needed.

5 (Optional) Create a folder for your experiment.

Select the icon for your database and press Ctrl-N. Rename the folder appropriately. Refer to the BD FACSDiva Software Reference Manual for ideas on how to organize experiments.

⚠️ Tip To place an experiment inside a folder, select the folder before you create the experiment.

6 Create an experiment from the Doublet Discrimination Gating template.

For best results, we recommend that you perform doublet discrimination in order to record only singlet events. This template contains cytometer settings and gated plots for this purpose. A procedure is given in Recording Data on page 155.

For experiments where you do not need to distinguish singlets from doublets, you can start with a default experiment or a template of your choice.

To use the template, select Experiment > New Experiment and select the Doublet Discrimination Gating template. Click OK to add a copy of the template to the Browser.
7 Rename the experiment appropriately (for example, 4-Color experiment).

8 Right-click the experiment level Cytometer Settings in the Browser and select Apply Application Settings. See Figure 4-20.

**Figure 4-20** Application Settings window

Refer to page 136 for instructions on creating Application Settings.

9 Select the application setting for your sample and click Apply.

See Figure 4-21 on page 147 for a typical error message if there are any mismatches between the application and cytometer settings.
Figure 4-21 Example mismatch error message

10 Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog box appears, listing only those parameters associated with the Application Settings.

11 Click OK to add the specified controls.

Alternatively, add and define label-specific controls, then click OK.

Add label-specific controls when your experiment contains samples stained with the same fluorophore conjugated to different antibodies (labels) that require different compensation values. This is especially useful with tandem
conjugates due to lot-to-lot variation. Refer to the BD FACSDiva Software Reference Manual for more information about this feature.

A compensation specimen is added to the experiment, along with a stained control tube for each compensation control. (Expand the specimen to view all tubes.) Worksheets containing appropriate plots are added for each compensation tube.

Calculating Compensation

The unstained control will be used to verify the settings for FSC, SSC, and FSC threshold, and to gate the population of interest.

1. Install the unstained control tube onto the cytometer.
2. Expand the compensation specimen in the Browser.
3. Set the current tube pointer to the unstained control tube and click Load.
4. Verify that the population of interest is displayed appropriately on the FSC vs SSC plot. Adjust if needed. (See Figure 4-22).

Since the application settings have already been optimized for your sample, the cytometer settings should require little or no adjustment.
5 Click the Threshold tab and adjust the FSC threshold, if needed.

Set the threshold to remove most of the debris without cutting off the singlet population (Figure 4-22).

6 Adjust the P1 gate to surround only the singlets (Figure 4-22).

7 Right-click the P1 gate and select Apply to All Compensation Controls.

The P1 gate on each Stained Control worksheet is updated with your changes.

8 Click Record Data.

9 When recording is finished, click Unload and remove the unstained control tube from the cytometer.

⚠️ Do not change the PMT voltages after the first compensation control has been recorded. In order to calculate compensation, all controls must be recorded with the same PMT voltage settings. If you need to adjust the PMT voltage for a subsequent compensation control, you will need to record all compensation controls again.

10 Install the next tube onto the cytometer and repeat steps 8 and 9 until data for all stained control tubes has been recorded.

11 Double-click the first stained control tube to display the corresponding worksheet.
12 Verify that the Snap-to Interval gate encompasses the positive population (Figure 4-23). Adjust the gate, if needed.

**Figure 4-23** Gating the positive population

13 Repeat steps 11 and 12 for the remaining compensation tubes.

14 Select Experiment > Compensation Setup > Calculate Compensation.

15 Enter the name of your experiment as the setup name, then click Link & Save.

![Screenshot of the Single Stained Setup window](image)

**Tip** To keep track of compensation setups, include the experiment name, date, or both in the setup name.

**NOTE** We recommend that you always visually and statistically inspect automatically calculated overlap values. The means of the positive controls should be aligned with the means of the negative.
Data Recording and Analysis

Once you have optimized the cytometer electronics for your sample type, you are ready to record and analyze data.

Before you record data, we recommend that you gate out doublets in order to record only singlet events. The Doublet Discrimination Gating template provides gated plots for this purpose.

During analysis, recorded data is displayed in plots, and gates are used to define populations of interest. BD FACSDiva software analyzes the gated data and calculates statistics that you can print or export. With global worksheets, data can be shown for a series of tubes on the same worksheet, manually or in an automated batch analysis.

The following sections describe how to use BD FACSDiva software features to record and analyze sample data.
Setting Up the Experiment

Before you record data, set up an experiment with appropriate tubes, plots, and labels for your assay. This section describes how to add Browser and worksheet elements to the experiment that was started in the previous section, Data Collection.

1. Rename Specimen_001 to a descriptive name.
2. Rename Tube_001 to 4-color_001.
3. Set the current tube pointer to the 4-color_001 tube.
4. Click Next Tube in the Acquisition Dashboard to duplicate the first tube with the name 4-color_002.
5. Use the Experiment Layout to specify the number of events to record for each tube.

The Experiment Layout can be used to define the events to record as well as parameter labels for all tubes in an experiment. Labels appear on the plot axes and in all statistics views.

a. Select Experiment > Experiment Layout.

b. In the Acquisition tab, select the events to record field for all specimen tubes, and select or enter 5,000 events.

c. Click OK.
Setting Up the Global Worksheet

A global worksheet is used to perform doublet discrimination and to set up plots to preview and record data.

1. Click the Worksheets View button ( ) on the Worksheet toolbar.

   The global worksheet is shown. If you are using the Doublet Discrimination Gating template, the worksheet shows the predefined plots and gates used to distinguish singlets from doublets.

   The second and third plots are set up to display gated data from the first and second plots, respectively, as shown in the population hierarchy.

2. Create two dot plots for previewing and recording data.

   For this example, create a FITC vs PE plot and an APC vs PerCP-Cy5.5 plot.

   Tip Double-click the Plot button to keep it selected until you create all plots. Click any other button to undo the selection.
3 Turn on biexponential display.
   a Select the two plots.
   b In the Inspector, select the checkboxes for X Axis and Y Axis under Biexponential Display. See Figure 4-24.

**Figure 4-24** Turning on Biexponential Display

4 Set up the fluorescence plots to display data from the FSC gate.

The FSC gate defines singlet events. By gating the fluorescence plots through this population, only singlet events will be recorded.

   a Select the two plots.
   b In the Inspector, select the FSC Gate checkbox.

5 Arrange the fluorescence plots so they fill the page vertically.

For an example, see Figure 4-26 on page 158.
Recording Data

This section describes how to adjust the gates to eliminate doublets and record singlet events.

1. Move the current tube pointer to the 4-color_001 tube.
2. Install the first mixed sample tube onto the loading port and click Load.
3. Change the Events to Display to 5,000 events.
4. Adjust the Scatter Gate to encompass the singlet events.
5. Adjust the SSC Gate to encompass the low SSC-W population.
6. Adjust the FSC Gate to encompass the low FSC-W population.

**Figure 4-25** Discriminating singlet events

7. Click Record in the Acquisition Dashboard to record data.
8. When all events have been recorded, click Unload and remove the tube from the cytometer.
9. Install the next tube, then click Next Tube in the Acquisition Dashboard to move the current tube pointer to the next tube.
10 Repeat steps 7 through 9 for the remaining tubes.

**Analyzing Data**

This section describes how to set up plots, gates, and a statistics view to analyze the recorded data. By the end of this section, your analysis should look similar to that shown in Figure 4-26 on page 158.

1 Select Edit > User Preferences.

2 In the Gates tab, set the preferences as follows:

3 Create the following gates:
   - Quadrant gate on the FITC vs PE plot.
   - Interval gate on the APC vs PerCP-Cy5.5 plot to capture the APC beads.
   - Rectangle gate on the APC vs PerCP-Cy5.5 plot to capture the PerCP-Cy5.5 beads.

4 Rename each population in the population hierarchy.

   **Tip** Press the Enter key twice to move to the next population without using the mouse.
5 Right-click either fluorescence plot and select Create Statistics View.

A statistics view is added to the worksheet.

6 Right-click the statistics view and select Edit Statistics View.

7 Edit the statistics view as follows:
   • In the Header tab, select the Use 2 columns for display checkbox.
   • In the Populations tab, clear the checkboxes for all populations except FITC, PE, PerCP-Cy5.5, and APC.
   • In the Statistics tab, select the Mean checkboxes for the fluorescence-A parameters.

8 Resize the statistics view so it fits on the page.

9 (Optional) Print the analysis.
Figure 4-26  Sample analysis for mixed-bead tube
Performing a Batch Analysis

Batch analysis allows you to automatically advance through a selected set of tube data when using a global worksheet.

To perform a batch analysis:

1. Verify that the global worksheet you will be using for analysis is displayed in the worksheet window.

2. Right-click the specimen to analyze in the Browser and select Batch Analysis.

The Batch Analysis dialog appears.

Only tubes under the selected specimen will be processed. Tubes without data are skipped during a batch analysis.

3. Do the following in the Batch Analysis dialog:

- Select Auto to analyze all the files without user intervention.
- Select 5 from the View Time menu to pause the analysis for 5 seconds after each tube is loaded.
- Select the Output to Printer checkbox to print a copy of the analysis after the data for each tube is loaded.
• Select the Statistics checkbox to export the statistics to a separate file, then enter a name for the statistics file. By default, the file is saved in D:\BDExport\Statistics.

• Select the Freeze Biexponential Scales checkbox to process all files with the same biexponential scales.

• Clear the Use Preferred Global Worksheet checkbox to display analyses of tubes within the same global worksheets. This option is useful for analyzing panels that require a separate global worksheet for each tube.

4 Click Start to begin the analysis.

When the analysis is finished, a completion message similar to Figure 4-27 displays.

Figure 4-27 Batch analysis complete
You can program BD FACSDiva software to sort a specified number of particles from multiple populations into a variety of sorting devices including tubes, plates, and slides. Collection devices are provided for sorting into 1-mL, 12 x 75-mm, and 15-mL tubes. Hardware for sorting into plates and slides is available as an option. Up to four defined populations can be sorted into each tube, allowing up to 16 populations to be sorted at one time.

Any subsetted population can be used for sorting, including populations defined by quadrant gates, interval gates, or derived gates. A single sort population can be defined by up to eight gates.

The following topics are covered in this chapter:

- Setting Up for Sorting on page 162
- Determining the Drop Delay – Manual Method on page 166
- Determining the Drop Delay – Automatic Method on page 171
- Sorting on page 173
- Setting Up for Sorting Into a Plate or Slide on page 179
Before you begin, you should be familiar with BD FACS Aria II operation using BD FACSDiva software. Review chapters 2 and 3, if needed.

Setting Up for Sorting

In general, do the following to set up for a sorting experiment. Each step is explained in more detail in previous or subsequent sections.

1. Start up the cytometer and the computer.
   See Cytometer Startup on page 114.

2. Install the appropriate size nozzle.

3. Select a new sort setup mode, if needed, and select an appropriate cytometer configuration.

   To change your current sort setup mode, select a nozzle size from the Sort > Sort Setup menu.

   For more information, see Sort Setup on page 101.

4. Install a sample line filter, if needed.
   See Installing or Removing a Sample Line Filter on page 220.

5. Check the laser delay for your sheath pressure and particle size.
   - To set the laser delay automatically using the Cytometer Setup and Tracking module, see Checking Cytometer Performance on page 130.
   - To set the laser delay manually, see QC Using BD FACSDiva Software on page 313.

6. Optimize cytometer settings for the sample to be sorted.
   See Data Collection on page 144.
7 Install the required collection device and set up the side streams.

See Setting Up for Bulk Sorting on page 164 or Setting Up for Sorting Into a Plate or Slide on page 179.

8 Calculate the drop delay.

See Determining the Drop Delay – Manual Method on page 166.

9 Use gating tools and subsetting methods to define the population(s) of interest.

Examples of gating analyses can be found in Analyzing Data on page 156 and in Getting Started with BD FACSDiva Software.

10 Define a sort layout for the tube containing the defined sort populations and proceed with sorting.

See Sorting on page 173.
Setting Up for Bulk Sorting

This section describes how to set up the streams for two- or four-way sorting. For sorting using the ACDU option, see Setting Up for Sorting Into a Plate or Slide on page 179.

⚠️ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1 Install collection tubes in the required collection device.

Collection tube holders are available for 1-mL microtubes, 12 x 75-mm tubes, and 15-mL centrifuge tubes. For compatible tubes, see Labware on page 269.

2 Install the collection tube holder onto the cytometer.

   a Close the sort block door and open the sort collection chamber door, if needed. The sort block door must be closed to install the tube holder.

   b Slide the holder into the slotted fittings below the sort aspirator drawer, then close the sort collection chamber door.

⚠️ Before installing the collection tube holder, ensure that an O-ring is installed in the groove between the two sections of the tube holder. The O-ring minimizes the chance of aerosols escaping. It can be found in the accessory kit (Catalog No. 337897).

3 Turn on the deflection plates.

Click the Voltage button in the Side Stream window (Figure 5-1 on page 165). The voltage warning light illuminates, indicating that the plates are charged.
A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the plate voltage is on. The plates remain energized even when the sort block door is opened.

**Figure 5-1** Turning on the deflection plates

Make sure the center stream image does not move after the plates are turned on. Major movement of the center stream could indicate that the plates or area around the plates needs cleaning.

4 Click Test Sort and optimize the side streams. See Figure 5-2.

Adjust the voltage sliders to view the required number of streams.

**Figure 5-2** Turning on Test Sort
If you cannot see a stream image or the image is dim, adjust the micrometer dial on the diode laser to better view the streams (Figure 1-20 on page 38).

5 Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and fine-tune the side streams, if needed.

Generally, the Sort Setup mode provides good starting values for these settings. Adjust the values only if needed to optimize the streams.

6 Open the aspirator drawer and aim the side stream(s) into each collection tube.

   a In the Side Stream window, click the Waste Drawer button ( ) to open the drawer.

   b Open the sort block door and aim each side stream into the tube as you adjust the corresponding slider in the Side Stream window.

   c When you are satisfied with the side stream deflection, close the sort block door.

7 Click the Voltage button ( ) to turn off the deflection plates.

**Determining the Drop Delay – Manual Method**

BD FACS Accudrop technology is used to determine the optimal drop delay setting for your sorting application. For more information, see Drop Delay Overview on page 67.

There are two methods for determining the drop delay.

- Manual drop delay – using the standard method, as described in the following sections.

NOTE Before beginning these procedures, make sure the stream is stable and the Sweet Spot is on.

Setting Up the Experiment

The steps in this section show you how to set the drop delay using the Accudrop experiment template. Because no data is recorded, the experiment can be reused as often as you like.

1. Create an experiment from the Accudrop Drop Delay template.
   Select Experiment > New Experiment. Select the Accudrop Drop Delay experiment and click OK.

2. Expand Specimen_001 and Tube_001.

3. Set the current tube pointer to Tube_001.

4. Open the sort layout by double-clicking it.
Using Manual Drop Delay

This section describes the manual method of optimizing the drop delay.

1. Load a tube filled with a suspension of BD Accudrop beads (approximately 2 drops of beads in 0.5 mL PBS).

2. In the Laser tab of the Cytometer window, set the window extension to zero.

3. Adjust the flow rate to achieve an event rate of 1,000–3,000 events per second.

   Tip   If this cannot be achieved using a flow rate setting between 1 and 5, adjust the bead concentration.

4. Turn on the voltage in the Side Stream window. Click Sort in the Sort Layout window.

5. Click Cancel at the Confirm dialog.
There is no need to collect the beads. When the drawer is closed, the beads are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-20 on page 38) to obtain the brightest bead spot on the center stream.

7 Click the Optical Filter button in the Side Stream window.

This control moves the emission filter that allows you to view the Accudrop beads in front of the lower camera. When the control is clicked, the image switches from a raw image to a processed (digitized) image. The two boxes indicate the region of the image where the left and center stream intensities are calculated during image processing. The numbers shown are percentages of the total intensity.

If the left side stream is not completely contained in the left region, adjust the voltage slider to place the stream in the center of the region.

8 Verify that the sort precision mode is set to Initial. See Sort Precision Modes on page 73 for more information.

9 Optimize the drop delay.

Adjust the Drop Delay value in 1-drop increments (Ctrl-click arrow control) to achieve close to 100% intensity in the left side stream. Wait a few seconds after each click for a complete response to the delay change.
In the Sort Layout window, change the precision mode to Fine Tune.

Optimize the drop delay.

Adjust the Drop Delay value in 0.03-drop increments (click arrow control) until the left side stream intensity is ≥90%. Wait a few seconds after each click for a complete response to the delay change.

Click the Optical Filter button to move the emission filter away from the camera.

Reset the window extension to its original setting (typically 2).

Turn off the deflection plates.
Determining the Drop Delay – Automatic Method

The Auto Drop Delay feature automates setting the drop delay to get optimized results from sorting. You should use this method after you have a good understanding of how drop delay works in general. See Using Manual Drop Delay on page 168 for more information.

Overview of Auto Drop Delay

Auto Drop Delay works best when the sort system is stable and assumes that BD Accudrop beads are used. When the process is started, the auto drop algorithm uses several passes to find best drop delay possible under current conditions of the system. Coarse passes are used to find initial drop delay within 2 drops of the ideal. The coarse passes are faster than fine tune passes. Fine tune passes are used to locate the drop delay value which is ideal considering current conditions.

Using Auto Drop Delay

1. Set up an experiment for drop delay as described in Setting Up the Experiment on page 167.

2. Load a tube filled with a suspension of BD Accudrop beads (approximately 2 drops of beads in 0.5 mL PBS).

3. Adjust the flow rate to achieve these values of events per second:

   - 70 micron = 1,000 to 3,000
   - 85 micron = 800 to 2,000
   - 100 micron = 600 to 1,500
   - 130 micron = 400 to 1,200

   **Tip** If this cannot be achieved using a flow rate setting between 1 and 5, adjust the bead concentration.

4. Turn on the voltage in the Side Stream window. Click Sort in the Sort Layout window.
5 Click Cancel at the Confirm dialog.

There is no need to collect the beads. When the drawer is closed, the beads are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-20 on page 38) to obtain the brightest bead spot on the center stream.

7 Click the Auto Delay button in the Side Stream window.

A dialog similar to Figure 5-5 on page 173 opens. The graph in the left pane of the dialog represents brightness of the stream (Y axis) versus drop delay (X axis). Typically the graph should have a flat portion, with several small peaks in either direction (up or down) or one prominent peak.

**NOTE** If the original drop delay value was close to the appropriate value prior to starting auto delay, then you may not get a graph displayed because few data points were required to determine the optimal drop delay.

8 Select Start Run in the Auto Drop Delay dialog.

9 Monitor the Auto Drop Delay dialog for progress. A message appears when the process is completed.

**NOTE** If the sort is stopped during algorithm execution (either by user action or because the system detected a failure), the run will be stopped with an appropriate message. Start the sort again, verify that the stream is stable and the sort is not pausing, and re-run the auto drop delay.
Before beginning the sort, do the following:

1. Perform the steps outlined in Setting Up for Sorting on page 162.
2. Use gating tools and subsetting methods to define the population(s) of interest.

Examples of gating analysis can be found in Analyzing Data on page 156 and in *Getting Started with BD FACSDiva Software*.

**NOTE** Gates drawn on a biexponential scale can be used for sorting. However, the cytometer will sort on a log scale. Therefore, a gate that crosses the zero boundaries will sort all events below zero into that gated population. This can cause a variance between the sort results and the statistical results in the software. If the gate is completely below zero on a biexponential plot, no events will be sorted.

**NOTE** Snap-To gates cannot be used for sort gates.
## Setting Up the Experiment

**Tip** When more than one drop is deflected in the same direction, residual charge from the first drop degrades the quality of the side streams. Thus, when four-way sorting or sorting into small wells where precise deflection is required, use the 4-Way Purity mode or select a mode with a Yield Mask of zero. For more information, see Yield Mask on page 70.

1. Create a new sort layout by clicking the New Sort Layout button ( ) on the Browser toolbar.

   By default, the 2-Tube Sort Layout appears.

2. Make appropriate entries in the Sort Layout window.

   ![Sort Layout Window](image)

   - Select the collection device from the Device menu.
   - Change the sort precision mode to Purity (two tubes), 4-Way Purity (four tubes), or Single Cell (plate or slide).
   - Enter the number of target events by choosing a value from the menu or entering a number in the field.
   - Select a Save Sort Reports option: Save None, Save All, or Ask User. See Setting Up a Sort Layout on page 105.
   - Select the Save Conflicts checkbox if you are using a 2- or 4-Tube Sort Layout and want to save conflicts.
• Select the sort location field(s) to be sorted into. Select multiple fields by dragging the mouse. Select a row or column by clicking the row or column header.

• Add the required population(s) to each sort location field.

• To display fewer counters in the Sort Layout window, click the View Counters button and deselect a menu option. The corresponding counter is hidden. (Only counters with a checkmark next to the name are displayed.)
Starting and Monitoring the Sort

1. Open the sort collection chamber door and install the collection tubes, plate, or slide.

2. Install the sample tube onto the loading port and click Load.

3. Adjust the flow rate.

   Sorting results are typically optimized at lower flow rates.

4. (Optional) Turn on the deflection plates and open the aspirator drawer.

   The deflection plates turn off automatically each time a tube is unloaded. If you do not turn them back on before beginning a sort, a dialog appears where you can turn on the plates and open the aspirator drawer by clicking OK.

5. Verify that the current tube pointer is indicating the appropriate tube in the Browser, then click Sort.

6. Click OK if you are prompted to open the aspirator drawer or turn on the deflection plates.

   If you click Cancel, sorting will begin with the deflection plates off and the drawer closed. As a result, sort populations will be identified and counted, but no deflection (or sorting) will occur. If you sort with the drawer closed, events will be sorted to waste.
Tip  Click Record Data to save data for the tube. Acquisition and sorting continue when the required number of events has been recorded.

Sorting continues until the required number of cells has been sorted. Acquisition stops and the drawer closes when sorting is complete. If the number of Target Events is set to Continuous, sorting continues until you manually stop sorting by clicking the Stop Acquiring button in the Dashboard, or the Sort button in the Sort Layout window.

Monitor the sort progress from the Sort Layout window. The number of events sorted into each sort location appears in the corresponding field. The sort rate and sort conflict rate are displayed in the corresponding counter fields.

NOTE When the Sweet Spot is on, sorting pauses automatically if the Drop 1 or Gap values are out of range. This ensures that sorting occurs only under the proper breakoff conditions. If a more severe problem such as a clog is detected, the stream shuts off and sorting stops. The deflection plates shut off, the aspirator drawer closes, and the sample tube is unloaded. To clear a clogged nozzle, see Cleaning the Nozzle on page 216.

(Optional) You can print the Sort Report at this time, or open the report later and print it then. You can also export the report.
Pausing and Resuming a Sort

The Pause/Resume feature allows you to temporarily pause the sort, and still retain the counter values. This is particularly useful when the sample volume is low and you need to refill the tube.

1. In the Sort Layout window, verify that the Save Sort Reports option is set to Save All.

2. To pause a sort while it is running, click the Pause button.

3. Unload the sample tube.

4. Refill the sample and load the tube.

5. Turn on the deflection plates and move the aspirator drawer to sort position.

6. Click the Resume button.

The Threshold counter restarts, however the value is saved in the final sort report. Each Pause/Resume action generates a sort report.
Setting Up for Sorting Into a Plate or Slide

The following sections describe how to set up for sorting into a plate or slide. For general guidelines, see Setting Up for Sorting on page 162.

Installing the Sorting Hardware

⚠️⚠️ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1  Install the splash shield below the aspirator drawer.
   a  Close the sort block door and open the sort collection chamber door, if needed.

The sort block door must be closed in order to open the collection chamber door.

b  Remove the tube holder, if one is installed.

c  Slide the splash shield into the slotted fittings below the sort aspirator drawer and push it all the way in.
2 Click the Access Stage button to bring the ACDU stage to the front.

a Open an experiment, if one is not already open, and create a sort layout for any of the tubes.

b In the Sort Layout window, click the Access Stage button ( ) to move the stage to the front of the sort collection chamber.

3 Install the required collection device on the stage (Figure 5-6).

• If you are sorting into a plate, install the plate with well A1 toward the front of the stage.

• If you are sorting onto a slide, install the slide-adapter tray with the printed side up. If your slide has a frosted end, place the frosted end to the right.

Figure 5-6 ACDU stage set up with plate (left) and slide (right)

Sorting starts on the front left corner of the device (A1 location), and proceeds from front to back, and then from left to right, sorting in a serpentine motion. Thus, for a plate, sorting proceeds from well A1–A12, B12–B1, C1–C12, and so on.

When sorting onto a slide, sorting proceeds in rows across the short end of the slide, and in columns along the long end of the slide. Make sure that you set up your sort layout accordingly. See Figure 5-7 on page 181.
Setting Up the Stream

This section describes how to optimize side stream deflection and how to adjust the Home location.

When sorting into a plate or onto a slide, the stage is pre-programmed to move a set distance between wells on a plate or spots on a slide. The Home location is used as the starting point. The far left stream should hit the center of the well in the top left corner of a plate or the top left corner of a slide at the Home location.

Default Home location coordinates exist for each standard sort collection device: BD Falcon™ multiwell plates with 6, 24, 48, 96, and 384 wells, and standard or frosted-end slides. For other plate types, you will need to create a custom device. See Creating a Custom Device on page 184.

Use the following procedure to verify the Home location and adjust it.

1. Optimize the drop delay.

   See Determining the Drop Delay – Manual Method on page 166.
2 Turn on the deflection plates.

Click the Voltage button ( ) in the Side Stream window. The voltage warning light illuminates, indicating that the plates are charged.

**NOTE** Make sure the center stream image does not move after the plates are turned on. Major movement of the center stream could indicate that the plates or area around the plates need cleaning. See External Cleaning on page 193.

3 Click the Test Sort button and optimize the far left side stream, then turn off Test Sort.

Adjust the far left slider for minimal deflection of the stream. The stream should be deflected just enough to clear the hole in the splash shield. Do not adjust the other sliders.

If you cannot see a stream image or the image is dim, adjust the micrometer dial on the diode laser (Figure 1-20 on page 38) to better view the streams.

4 Select Sort > Home Device.

5 In the Device Setup dialog, select the collection device you are using and click Go to Home.
The stage moves to the pre-programmed Home position.

6 Double-click the Test Sort button to deposit a drop at the Home location.

7 Inspect the collection device to see where the drop was deposited.

If you need to move the stage to the front, close the Device Setup dialog and click the Access Stage button in the Sort Layout window.

8 Wipe the collection device dry and place it back on the tray support.

If needed, click the Access Stage button to send the stage back and select Sort > Home Position to access the Device Setup dialog again.

9 Adjust the Home location, if necessary.

Click the appropriate Arrow buttons to move the tray support as needed. Large arrows move the tray by five steps. Small arrows move the tray by one step.

10 Repeat steps 6 through 9 until the drop is centered appropriately.

11 Click Set Home, then Close.

12 Click the Voltage button ( ) to turn off the deflection plates.

13 Proceed with Sorting on page 173.
Creating a Custom Device

You can program the ACDU stage to sort into any grid configuration. Create a custom device by entering the number of rows and columns and setting the Home and Farthest locations. BD FACSDiva software calculates the increment between rows and columns to determine the sort locations. The Home and Farthest locations for a 96-well plate are A1 and H12, respectively.

Figure 5-8  Home and Farthest location on 9-drop slide (example)

1. Select Sort > Custom Devices.
2. Click the Add button in the Custom Devices dialog.

A new device is added to the list of custom devices. By default, devices are named Custom Device_00x, where x is the next consecutively numbered device.
3. Select the text in the Name field and enter a new name.

4. Enter the number of sort location rows and columns.

A device can have up to 60 rows and 25 columns.

5. Use the Arrow keys and the Test Sort button to set the Home location, then click Set Home.

See Setting Up the Stream on page 181 for details. There are no default values for custom devices, so greater initial adjustment with the Arrow keys is required.

6. Use the same procedure to set the Farthest location, then click Set Farthest.

The Farthest sort location is the well or spot on the lower-right corner of the collection device.

7. Click Apply, then Close.

After you set the Home and Farthest locations, custom devices are listed in the Device menu in the Sort Layout window.

**NOTE** Once custom devices are defined, you cannot change the number of rows and columns.

8. Click the Voltage button ( ) to turn off the deflection plates.

Deleting a Custom Device

1. Select Sort > Custom Devices.

2. Select the name of the custom device to be deleted in the Custom Devices dialog.

3. Click Delete.

The device is deleted from the Custom Device list, but is retained within any sort layouts where it was used.
The BD FACS Aria II cytometer is designed to require minimum maintenance. However, to preserve the reliability of the cytometer, you must regularly perform basic preventive maintenance procedures. This chapter explains routine maintenance procedures you should follow to keep your cytometer in good condition.

Maintenance procedures are presented as follows:

- Daily Shutdown on page 188
- Scheduled Maintenance on page 194
- Unscheduled Maintenance on page 213
Daily Shutdown

In the BD FACS Aria II system, the recommended daily shutdown procedure is to run the Clean Flow Cell command with the closed-loop nozzle installed (see the next section). This procedure fills the flow cell with cleaning solution. This is normally sufficient to keep the flow cell clean and operating properly.

If the system is used to process many different sample types, or the system has problems with contamination, you can perform a more extensive cleaning by running the Fluidics Shutdown command. See Fluidics Shutdown on page 190.

In addition to one of the choices listed above, you should also perform an external cleaning. See External Cleaning on page 193.

Clean Flow Cell

Use the Clean Flow Cell command to run a tube of cleaning solution through the sample line and flow cell. This procedure can be used in two ways:

- As the daily shutdown procedure
- Any time poor optical performance indicates that additional cleaning is needed.

**NOTE** After the procedure is complete, the cleaning solution remains in the flow cell until the stream is restarted.

To run Clean Flow Cell, do the following:

1. Turn off the stream.
2. Remove the nozzle and install the closed-loop nozzle. See Figure 6-1 on page 191.

   Verify that there is an O-ring in the closed-loop nozzle before installing it.
3. Select Cytometer > Cleaning Modes > Clean Flow Cell.
4 When prompted, install a tube containing approximately 3 mL of 15% Contrad® 70 cleaning solution, then click OK.

The cytometer loads the tube and fills the flow cell with the cleaning fluid.

5 Click OK when the completion dialog appears.

6 If this is part of a daily shutdown, perform these steps.

   a Turn off the cytometer main power.

   b Exit BD FACSDiva software and shut down the computer.

7 If you are cleaning the flow cell to improve performance and will continue to use the system, increase the Contrad 70 solution to 100%, and perform these steps:

   a Wait a minimum of 15 minutes to let the cleaning fluid remain in the flow cell.

      The longer the cleaning fluid remains in the flow cell, the more effective it will be. You can repeat the Clean Flow Cell procedure multiple times if required.

   b Remove the closed-loop nozzle and install the correct nozzle size.

   c Restart the stream to flush the cleaning fluid from the flow cell.
Fluidics Shutdown

The Fluidics Shutdown command can be used to perform an extensive cleaning if the system is used to process many different sample types, or the system has problems with contamination. This procedure removes sheath fluid from the lines and fills them with 70% ethanol, and cleans the flow cell.

Preparing for Shutdown

1. Unload the sample tube, if one is loaded.
2. Turn off the stream.
3. Check the waste container and empty it if needed.
   See Refilling the Sheath Tank on page 123.
4. Check the ethanol shutdown tank and refill if it needed.
   See Refilling the Ethanol Shutdown Tank on page 125.

Running Fluidics Shutdown

1. Select Cytometer > Fluidics Shutdown. The following window opens.

2. Remove the nozzle from the flow cell assembly and click Done.
3. Insert a closed-loop nozzle into the flow cell assembly and click Done. See Figure 6-1.
Verify that there is an O-ring in the closed-loop nozzle before installing it.

**Figure 6-1** Closed-loop nozzle installed in flow cell

4. Connect the air and fluid lines to the stainless steel ethanol (ETOH) shutdown tank. See Figure 6-2 on page 192.

   a. Disconnect the air line from the sheath tank and connect it to the air port on the ETOH shutdown tank.

   b. Disconnect the fluid line from the output side of the sheath filter and connect it to the fluid port on the ETOH shutdown tank.

   Keep the sheath filter attached to the sheath tank. Do not run ethanol through the sheath filter.

   c. Click Done.

The system starts the cleaning process, and then displays a message at the bottom of the window.
5 When prompted, install a tube containing 3 mL of 15% Contrad 70 cleaning solution into the loading port, then click Done.

The cytometer loads the tube and continues the cleaning process. A progress message appears, and then displays Done when the process is complete.
6 Click OK when you see a message informing you the system can be turned off.

7 Turn off the cytometer main power.

8 Exit BD FACSDiva software and shut down the computer.

**External Cleaning**

To keep the system free from salt buildup, wipe down all cytometer surfaces that have been exposed to sheath fluid. Clean surfaces with a cloth dampened with a 10% bleach solution, followed by DI water.

⚠️⚠️ All cytometer surfaces that come in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when cleaning cytometer surfaces. Wear suitable protective clothing and gloves.

⚠️⚠️ To prevent shock, turn off the plate voltage before cleaning on or around the deflection plates. To prevent arcing (sparking), make sure the plates are completely dry before you turn the plate voltage back on.

The following surfaces should be inspected and cleaned when necessary:

- Inside the sort chamber
- Deflection plates
- Sample loading port
- Collection devices
Scheduled Maintenance

For optimal cytometer functioning, perform the following procedures according to the recommended maintenance schedule.

**Table 6-1  Scheduled Maintenance**

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Cleaning on this page</td>
<td>See Table 6-2 on page 195</td>
</tr>
<tr>
<td>Purging the Fluid Filters on page 200</td>
<td>Weekly</td>
</tr>
<tr>
<td>Purging the Sheath Filter on page 200</td>
<td>Weekly</td>
</tr>
<tr>
<td>Changing the disposable waste cap (see Emptying the Waste Container on page 127)</td>
<td>Monthly</td>
</tr>
<tr>
<td>Flow Cell Preventive Cleaning on page 201 (with 100% Conrad70)</td>
<td>Monthly</td>
</tr>
<tr>
<td>Changing Fluid Filters on page 202</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Changing the Sheath Filter on page 203</td>
<td>Every 3 months</td>
</tr>
<tr>
<td>Changing the Sample Lines on page 204</td>
<td>Every 4–6 months, or when required</td>
</tr>
<tr>
<td>Changing the Air Filters on page 211</td>
<td>Every 6–12 months, depending on cytometer use and the quality of the air</td>
</tr>
<tr>
<td>Changing the Sheath Tank Air Filter on page 212</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Checking the Fluidics Cart Drip Tray on page 212</td>
<td>Weekly</td>
</tr>
</tbody>
</table>

**Internal Cleaning**

BD FACSDiva software includes four pre-programmed cleaning modes that can be used alone, or in combination to provide the required level of cleaning. The following sections describe the different cleaning modes. See Table 6-2 on page 195 for an overview of each mode.
Sample Line Backflush

After a sample tube is unloaded, the sample line tubing within the sample injection chamber is automatically flushed inside and out with sheath fluid to eliminate potential sample carryover. Use the Sample Line Backflush command to perform additional backflushing of the inside of the sample line after a tube is unloaded. Perform the Sample Line Backflush when you observe sample carryover or after running samples with adherent cells or dye.

**NOTE**  Keep the stream running while performing the backflush.

1. Select Cytometer > Cleaning Modes > Sample Line Backflush.

Table 6-2  Cytometer cleaning modes

<table>
<thead>
<tr>
<th>Cleaning Mode</th>
<th>Summary</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Line Backflush on page 195</td>
<td>Flushes the sample line with sheath fluid</td>
<td>After running samples with adherent cells or dye</td>
</tr>
<tr>
<td>Clean Flow Cell on page 188</td>
<td>Cleans the sample path and the flow cell with a cleaning fluid</td>
<td>When indicated by distorted scatter or high CVs, or as a daily shutdown procedure.</td>
</tr>
<tr>
<td>Prime After Tank Refill on page 196</td>
<td>Primes the fluid lines for the designated fluid(s)</td>
<td>When a fluidics line is unplugged to refill a tank</td>
</tr>
<tr>
<td>Prepare for Aseptic Sort on page 197</td>
<td>Decontaminates the complete sheath path and sample path with bleach, DI water, and ethanol.</td>
<td>When needed before aseptic sorting</td>
</tr>
</tbody>
</table>
2 Click Start to start the backflush.

![Sample Line Backflush dialog]

3 Click Stop to stop the backflush, or click Cancel to stop the backflush and close the dialog.

The backflush does not stop automatically.

**Prime After Tank Refill**

Use the Prime After Tank Refill command to prime the fluid lines if a 5 liter plastic fluidics container was disconnected for refilling.

1 Turn off the stream.

2 Select Cytometer > Cleaning Modes > Prime After Tank Refill.

3 Select the checkboxes for the tanks that were refilled, then click OK.

![Tank Prime dialog]

The cytometer proceeds with priming the specified tanks. A progress message appears while the tanks are being primed.
4 Click OK when the tank prime is complete.

**Prepare for Aseptic Sort**

Use the Prepare for Aseptic Sort command when you want to decontaminate the entire sheath path. This procedure cleans the system with bleach, DI water, and ethanol.

For the most complete decontamination, autoclave the sheath container and install a new sheath filter before sorting. Autoclave the sheath container at 125°C and 15 psig for 30 minutes with a 7.5-minute warmup and shutdown cycle.

**NOTE** Do not autoclave the sheath probe. Remove the probe and decontaminate it using 70% ethanol.

*Figure 6-3* Sheath probe
To run the Prepare for Aseptic Sort command:

1. Select Cytometer > Cleaning Modes > Prepare for Aseptic Sort.

   Follow the instructions on screen as you perform the procedure.

   ![Aseptic Sort Prep](image)

2. Install the closed-loop nozzle in the flow cell and click Done.

   Verify that there is an O-ring in the closed-loop nozzle before installing it.

3. Remove the fluid line from the DI water port, connect the fluid line from the bleach tank to the DI water port, then click Done. See Figure 6-4.

   Do not disconnect the sensors from either tank.

   **Figure 6-4** Moving bleach fluid line

   ![Diagram of bleach fluid line](image)
4 Disconnect the bleach fluid line from the DI water port, and connect it back to the bleach tank port, then reconnect the fluid line to the DI water port, and click Done.

5 Disconnect the fluid line from the sheath tank (at the output side of the sheath filter) and connect it to the fluid out port on the side of the fluidics cart (see Figure 6-5). Click Done.

The system cleaning takes approximately 20 minutes.

**Figure 6-5 Moving the sheath fluid line**

6 Disconnect the fluid line from the fluid out port on the side of the fluidics cart and connect it to a new 0.2-µm sheath filter.

7 Remove the old sheath filter and connect a new 0.2-µm sheath filter to the liquid port of the sterilized sheath tank.

8 To complete the process, select one of the two options.

**Figure 6-6 Finishing the aseptic sort prep process**

<table>
<thead>
<tr>
<th>Run</th>
<th>Run</th>
</tr>
</thead>
<tbody>
<tr>
<td>To continue running samples, perform fluidics startup.</td>
<td>To turn off system, perform flow cell cleaning procedure.</td>
</tr>
</tbody>
</table>
• To continue running samples, perform fluidics startup.
• To turn off the system, perform the flow cell cleaning procedure.

Purging the Fluid Filters

Once a week, purge air from the fluid filters for the 5 L plastic containers by opening the bleeder valve on the top of each filter. This ensures that the filters will not dry out.

1. Open the bleeder valve a small amount and leave it open until fluid seeps out through the valve (see Figure 6-7 on page 202).
2. Close the valve.
3. Wipe up any excess fluid that might have dripped onto the fluidics cart.

Purging the Sheath Filter

Once a week, purge air from the sheath filter by opening the bleeder valve on the top of the filter. The sheath tank is pressurized, so do this task carefully to avoid spraying sheath fluid on any equipment.

1. Hold the sheath filter up vertically.
2. Place a small container under the bleeder valve to catch any fluid.
3. Slowly open the bleeder valve a small amount and leave it open until fluid seeps out through the valve (see Figure 6-8 on page 203).
4. Close the valve.
5. Wipe up any excess fluid that might have dripped onto the fluidics cart.
Flow Cell Preventive Cleaning

It is good practice to perform flow cell preventive cleaning once per month, or more often if required, to maintain flow cell cleanliness. Do this at the end of the day when the system will not be used again until the next day.

1. Turn off the stream.
2. Remove the nozzle and install the closed-loop nozzle. See Figure 6-1 on page 191.
   Verify that there is an O-ring in the closed-loop nozzle before installing it.
3. Select Cytometer > Cleaning Modes > Clean Flow Cell.
4. When prompted, install a tube containing approximately 3 mL of 100% Contrad 70 cleaning solution, then click OK.
   The cytometer loads the tube and fills the flow cell with the cleaning solution.
5. Click OK when the completion dialog appears.
6. To shut the system down for the day:
   a. Turn off the cytometer main power.
   b. Exit BD FACSDiva software and shut down the computer.
   c. Let the cleaning solution remain in the flow cell overnight.
Changing Fluid Filters

We recommend changing the fluid filters every 6 months. Spare filters are included with the accessory kit.

**Figure 6-7** Fluid filters

1. Remove the filter by pressing the tabs on each quick-disconnect coupling. (See Figure 6-7.)

2. Install the new filter and connect the quick-disconnect couplings.

   Write the current date on the filter so you will know when to replace it.

3. Open the bleeder valve on top of the filter a small amount and leave it open until fluid seeps out through the valve.

4. Close the valve.

5. Wipe up any excess fluid that might have dripped onto the fluidics cart.
Changing the Sheath Filter

We recommend changing the sheath filters every 3 months, or when increased debris in an FSC vs SSC plot indicates that the sheath filter needs to be replaced. Spare filters are included with the accessory kit.

1. Turn off the stream.

2. Remove the filter by pressing the tabs on each quick-disconnect coupling. (See Figure 6-8.)

**Figure 6-8 Sheath filter**

3. Unscrew the nuts at each end of the filter to remove the connecting tubing.

4. Locate a new filter and wrap the threads at each end with Teflon tape.

5. Screw the nuts with connecting tubing onto each end of the filter and tighten finger-tight.

6. Observe the direction of flow on the filter and replace it in the same orientation. Write the current date on the filter so you will know when to replace it.

7. Open the bleeder valve on top of the filter a small amount and leave it open until fluid seeps out through the valve.

8. Close the valve.
Changing the Sample Lines

The primary sample line between the sample injection chamber and the pinch valve should be changed every 4–6 months or when decreased event rates indicate that the sample line might be clogged. The secondary sample line between the pinch valve and the cuvette flow cell needs changing only when it is kinked or clogged.

Figure 6-9 Primary and secondary sample lines

To withstand the high pressures generated by the BD FACSAria II flow cytometer, the sample lines are attached using a two-piece compression fitting, where a cone-shaped ferrule is compressed onto the tubing as the connecting nut is tightened.

To replace the tubing, you will need a 12-inch length of replacement tubing for the primary sample line, or a 7-inch length for the secondary line. Replacement tubing is supplied in the accessory kit. The ferrules and connecting nuts can be reused when the tubing is replaced.

All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle used tubing and fittings as if capable of transmitting infection. Wear suitable protective clothing and gloves.
Changing the Primary Sample Line

To replace the primary sample line, you will need a 12-inch length of replacement tubing from the accessory kit. There is a different fitting at each end of the tubing, so the procedure is divided into two sections.

Assembling the Collet Fitting at the Pinch Valve

At the pinch valve end of the primary sample line, a collet fitting joins the sample line to the pinch tubing. Perform the following steps to replace the tubing.

1. Turn the stream off (if needed). Make sure the loading port is in the unload position.
2. Unscrew the nut from the collet fitting and pull the nut and collet apart.
3. Pull the pinch tubing out of the nut, and then pull the sample line out of the pinch tubing. See Figure 6-10.
4. Locate a new 12-inch piece of sample line tubing.
   a. Slide the nut over the new sample line tubing.

   Figure 6-10  Collet nut fitting on pinch valve tubing

   b. Slide the pinch valve tubing over one end of the sample line tubing until approximately 6 mm of the sample line is inside the pinch valve tubing.
c Slide the pinch valve tubing on the inside of the teeth of the nut until it stops.

d Couple both pieces of the fitting together and then tighten until finger-tight.

**Primary Sample Line - Sample Injection End**

At the sample injection end of the primary sample line, a compression fitting secures the sample line at the top of the sample injection chamber.

1 Turn the stream off (if needed). Make sure the loading port is in the unload position.

2 If there is a sample line filter installed, remove it by pulling it off of the sample line.

   To gain access to the filter, see Installing or Removing a Sample Line Filter on page 220.

3 Unscrew the connecting nut at the top of the sample injection chamber and slowly pull out the sample line. (See Figure 6-9 on page 204.)
4 Ensure that a cone-shaped ferrule is attached to the sample line.

Figure 6-11 on page 206 shows an example of a ferrule. If the ferrule was left behind in the injection chamber fitting, gently push the tip of the ferrule-removal tool (included in the accessory kit) into the top of the ferrule and pull the ferrule straight out. See Figure 6-12.

After using the tool, you might need to replace the ferrule. If the ferrule is damaged, replace it with a spare (included in the accessory kit).

5 Slide the ferrule and nut off the end of the sample line.

6 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 5 inches (12.7 cm) of tubing extending out of the sample injection chamber end. (This length can be adjusted depending on the depth of your sample tube.) This length is referred to as the pilot, as shown in Figure 6-13 on page 207.

7 Insert the pilot tubing into its fitting, ensuring that the tubing reaches the intended pilot depth.

⚠️ Do not to bend the primary sample line during insertion.
Insert the sample line into the sample injection chamber fitting. Push the tubing from the top until it is slightly above the bottom of the chamber viewing window. Finger-tighten the nut on top of the chamber so the sample line is secure.

⚠️ Do not overtighten the nut and do not use tools. Over-tightening the nut can kink or damage the tubing.

8 Check the fitting connections at both ends to make sure they are not leaking.

Turn on the stream, load a tube of DI water, and make sure none of the fittings are leaking. If needed, unload the tube, turn off the stream, and tighten the fittings. After tightening, if leaking still occurs, replace the ferrule.

⚠️⚠️ Make sure all fittings are securely tightened. If any fitting is loose, the tubing could detach during high-pressure operation, exposing the operator to potentially biohazardous sample spray.

9 Verify the length of the sample line.

The sample line should not bow or bend when a tube is loaded. If you need to adjust the length, unscrew the nut on top of the sample injection chamber, adjust the length, and tighten the nut again.

**Changing the Secondary Sample Line**

This section describes changing the secondary sample line (see Figure 6-9 on page 204). There is a different fitting at each end of the tubing, so the procedure is divided into two sections.

**Pinch Valve End**

The procedure to replace the secondary sample line at the pinch valve end is the same as for the primary sample line, except the replacement line is a 7-inch length. Refer to Assembling the Collet Fitting at the Pinch Valve on page 205.
Flow Cell End

1. Turn the stream off (if needed).

2. Unscrew the connecting nut at the top of the flow cell and slowly pull out the sample line. (See Figure 6-14.)

![Figure 6-14 Secondary sample line insertion](image)

3. Ensure that a cone-shaped ferrule is attached to the sample line.

   If the ferrule was left behind in the flow cell fitting, gently push the tip of the ferrule-removal tool (included in the accessory kit) into the top of the ferrule and pull the ferrule straight out.

   After using the tool, you might need to replace the ferrule. If the ferrule is damaged, replace it with a spare (included in the accessory kit).

4. Slide the ferrule and nut off the end of the sample line.

5. Slide the nut and then the ferrule onto the end of the new sample tubing.

   Leave approximately 0.1 inch (0.25 cm) of tubing extending out of the ferrule. This length is referred to as the pilot, as shown in Figure 6-13 on page 207.
6 Insert the pilot tubing into its fitting at the top of the flow cell, ensuring that the tubing reaches the intended pilot depths.

⚠️ Within the cuvette flow cell fitting, make sure the pilot is seated flush against the pilot depth. Dead volume between the pilot and the pilot depth can lead to sample carryover or leaking.

7 Finger-tighten the nut at the top of the flow cell to secure the sample line.

⚠️ Do not overtighten the nut and do not use tools. Over-tightening the nut can kink or damage the tubing.

8 Check the fitting connections at both ends to make sure they are not leaking.

Turn on the stream, load a tube of DI water, and make sure none of the fittings are leaking. If needed, unload the tube, turn off the stream, and tighten the fittings. After tightening, if leaking still occurs, replace the ferrule.

⚠️ Make sure all fittings are securely tightened. If any fitting is loose, the tubing could detach during high-pressure operation, exposing the operator to potentially biohazardous sample spray.
Changing the Air Filters

The BD FACSaria II cytometer has two air filters: one in the sort collection chamber door and one in the side door.

• To change the filter in the sort collection chamber door, slide out the old filter and slide in the new filter. See Replacing the Air Filter on page 294 for more information.

• To change the air filter in the side door (Figure 6-15), loosen the screws at the top corners of the filter and remove the old filter. Install a new filter and tighten the screws to hold the filter in place. Replace the filter once or twice a year, depending on the quality of the air in the laboratory.

Figure 6-15 Changing the air filter
Changing the Sheath Tank Air Filter

Check the inline air filter on the sheath tank air line periodically for any signs of debris or discoloration. Replace with a new air filter from the accessory kit every six months, or sooner if needed.

**Figure 6-16** Inline air filter for sheath tank

1. Turn off the cytometer.
2. Pull the tubing off each end of the air filter.
3. Install a new filter with the directional arrow pointing toward the sheath tank.

Checking the Fluidics Cart Drip Tray

Check the drip tray on the fluidics cart weekly for signs of excess liquid and empty the tray if needed.
Unscheduled Maintenance

There are several cytometer components that should be cleaned periodically or checked for wear and replaced if necessary. See the indicated sections for the following maintenance procedures.

**Table 6-3 Unscheduled maintenance**

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing Nozzles on page 214</td>
<td>As needed when running different sized particles</td>
</tr>
<tr>
<td>Cleaning the Nozzle on page 216</td>
<td>When stream irregularities indicate that the nozzle is clogged</td>
</tr>
<tr>
<td>Closed-Loop Nozzle Maintenance on page 218</td>
<td>As needed</td>
</tr>
<tr>
<td>Installing or Removing a Sample Line Filter on page 220</td>
<td>When the sample line filter needs to be installed or changed</td>
</tr>
<tr>
<td>Changing the Pinch Valve Tubing on page 223</td>
<td>As needed</td>
</tr>
<tr>
<td>Cleaning the Camera Windows on page 225</td>
<td>When smudges appear in the Breakoff or Side Stream windows</td>
</tr>
<tr>
<td>Removing the Deflection Plates on page 228</td>
<td>As needed to clean the deflection plates</td>
</tr>
<tr>
<td>Lubricating the Sample Injection Chamber O-Ring on page 229</td>
<td>As needed when the O-ring is dry</td>
</tr>
<tr>
<td>Cleaning the Optical Filters on page 231</td>
<td>As needed when changing a filter</td>
</tr>
</tbody>
</table>
Changing Nozzles

As a general guideline, the nozzle size should be at least three times the diameter of the particle to be sorted. Four sizes of nozzles are provided with your cytometer: 70, 85, 100, and 130-μm nozzles. The size is marked on the nozzle. The closed-loop nozzle used for cleaning and shutdown procedures is also changed with this procedure.

⚠️⚠️ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1  Turn off the stream and open the flow cell access door.

2  Turn the nozzle-locking lever 90° counter-clockwise, and pull the nozzle out of the cuvette flow cell (Figure 6-17).

   To avoid losing the O-ring, hold the nozzle steady and pull it straight out without tilting it from side to side. If you do not see the O-ring on the nozzle, it could be stuck to the cuvette. To locate and remove the O-ring, wet the wooden end of a cotton swab and use it to wipe the inside of the nozzle well. Use the magnifying glass in the accessory kit if necessary.

![Figure 6-17 Nozzle-locking lever](image)

3  Insert the new nozzle into the flow cell.
Use the magnifying glass in the accessory kit to make sure the O-ring is installed in the groove at the end of the new nozzle. Insert the nozzle and push it gently all the way forward until it stops.

4. Turn the nozzle-locking lever clockwise to the 12:00 position.

5. Turn on the stream and make sure it flows smoothly from the nozzle into the center of the waste aspirator.

If the stream is flowing but the breakoff is too long or the gap is unsteady, this could indicate that there are bubbles in the flow cell. If these conditions occur, turn off the stream, wait for 10 seconds, and turn on the stream again.

If you see any dripping or spraying, or the stream image appears abnormal, turn off the stream and see Troubleshooting the Stream on page 234.

**NOTE** After changing the nozzle, you might need to adjust the angle of the sort block to re-center the stream in the aspirator. To do so, loosen the adjustment screws on both sides of the deflection plates and rotate the sort block (see Figure 1-12 on page 29). Tighten the screws when the stream is centered in the aspirator. For further assistance, see Troubleshooting the Stream on page 234.
Cleaning the Nozzle

Use the following procedure to clean the nozzle when the stream appears blocked or distorted. To verify that the nozzle is clogged, examine the tip under a microscope. Figure 6-18 shows an example of an unclogged nozzle tip.

**Figure 6-18** Magnified view of a nozzle tip

![O-ring](image)

- All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle nozzles as if capable of transmitting infection. Wear suitable protective clothing and gloves.

1. Turn off the stream and open the flow cell access door.
2. Remove the nozzle from the cuvette flow cell.
   
   Turn the nozzle-locking lever 90° counter-clockwise. See Figure 6-17 on page 214. Remove the nozzle by pulling it straight out.
3. Remove and set aside the O-ring.
4. Sonicate the nozzle for approximately 1 minute.
   
   Sonicate the nozzle in a test tube containing DI water or a mild detergent. Repeat the sonication as needed until the nozzle is clean.
5. After sonicating, use the wooden end of a swab to re-install the O-ring on the nozzle tip, then allow the nozzle to air dry for a few minutes.
Do not wipe the nozzle with anything, because it could leave fibers or other contamination, or dislodge the O-ring.

6 Carefully reinsert the nozzle into the flow cell.

Push the nozzle gently all the way forward until it stops.

7 Turn the nozzle-locking lever clockwise to the 12:00 position.

8 Turn on the stream and make sure it flows through the nozzle properly.

9 Close the flow cell access door.

Note that after re-installing the nozzle, you might need to change the angle of the sort block to re-center the stream in the aspirator. To do so, loosen the adjustment screws on both sides of the deflection plates and rotate the sort block (see Figure 1-12 on page 29). Tighten the screws when the stream is centered in the aspirator. For further assistance, see Troubleshooting the Stream on page 234.
Closed-Loop Nozzle Maintenance

The closed-loop nozzle and related tubing should be cleaned as needed if there are any indications of clogging or kinked tubing.

Cleaning the Closed-Loop Nozzle

1. Turn off the stream and open the flow cell access door.
2. Remove the closed-loop nozzle from the cuvette flow cell.

   Turn the nozzle-locking lever 90° counter-clockwise. Remove the nozzle by pulling it straight out. See Figure 6-19.

   Figure 6-19 Closed-loop nozzle

3. Verify that the O-ring is installed in the groove. If it is missing, find it inside the flow cell.
4. Unscrew the nut on the side of the nozzle to remove the tubing.

   Make sure the ferrule stays on the tubing as you remove it.
5. Remove the O-ring and set it aside.
6. Sonicate the nozzle for approximately 1 minute.
Sonicate the nozzle in a test tube containing DI water or a mild detergent. Repeat the sonication as needed until the nozzle is clean.

7 After sonicating, place the O-ring back into the groove in the nozzle, then allow the nozzle to air dry for a few minutes.

8 Make sure the ferrule is on the tubing, then screw the nut back into the hole in the side of the closed-loop nozzle. See Figure 6-20.

Replacing the Tubing on Closed-Loop Nozzle

To replace the tubing from the closed-loop nozzle, use this procedure. See Figure 6-20. Use a 7-inch length of sample tubing from the accessory kit as the replacement.

1 Un螺丝 the nut from the closed-loop nozzle and from the union fitting and pull out the tubing from both places.

Make sure the ferrule comes out on the tubing on both ends. If not, use the ferrule tool to remove it. See Figure 6-12 on page 207.

2 Slide the nut and ferrule off each end of the tubing.

3 Slide the nut and ferrule onto the new tubing as shown in Figure 6-20.

Insert the tubing into the closed-loop nozzle and slowly tighten the nut until secure. Do not over-tighten. Make sure the tubing is pushed all the way in while tightening the nut.
4 Insert the tubing into the union fitting and slowly tighten the nut until secure. Do not over-tighten. Pull gently on the tubing to ensure it is secure.

Installing or Removing a Sample Line Filter

Sample filters can be installed on the end of the sample line to filter out large particles from a sample. Pre-filtering the sample before beginning any sorting is recommended.

Two sizes of sample line filters are included in the accessories kit, 35 micron (red) and 50 micron (purple). The filters can be changed as often as required. The sample filters are not intended for use with the 1 mL micro-tubes.

NOTE When a sample filter is installed, the sample flow rate can be slowed down due to the effect of particles in the sample fluid clogging the filter.

1 Select Change Sample Filter from the Cytometer menu.

Make sure the stream is turned on before starting the process.

2 A wizard appears with the instructions. See Figure 6-21.

![Sample line filter wizard](image)

Figure 6-21 Sample line filter wizard
3 Loosen the sample line fitting nut at the top of the injection chamber to allow the sample line to slide freely through the fitting. See Figure 6-22 on page 221.

*Figure 6-22* Loosen nut to move sample line

![Diagram of sample injection chamber with loosen nut](image)

4 Push the sample line down so the end is below the bottom of the sample injection chamber.

*Figure 6-23* Sample line filter installed

![Diagram of sample line filter installed](image)

5 Install the sample line filter by sliding it onto the end of the line, then click Done. See Figure 6-23.

Do not bend the sample line while installing the filter.
6 Pull the sample line up to operation height, slightly above the chamber viewing window.

7 Place a tube onto the loading port.

8 Click Done, and the sample injection chamber raises.

⚠️ Be careful of a pinching hazard as the sample injection chamber is raised.

The sample line should not bow or bend when a tube is loaded.

9 Adjust the sample line height if needed.

10 Tighten the sample line fitting and click Done.

The bulk injection chamber is lowered and the sample purge mode is turned on for about 5 seconds until several drips exit the filter. A message is displayed at the bottom of the wizard. See Figure 6-24 on page 222.

Figure 6-24  Sample line wizard message

11 Click Done and the process is complete.
Changing the Pinch Valve Tubing

The tubing that runs through the pinch valve should be changed as needed. The system ships with replacement tubing cut into 3-inch lengths, found in the accessory kit.

Perform the following steps to replace the tubing:

1. Turn off the stream (if needed). Make sure the loading port is in the unload position.

2. Pull the existing pinch valve tubing out of the slot in the pinch valve.

   Grasp the tubing with two fingers on each side of the pinch valve and pull it straight out from the slot. The tubing pops out of the slot with a small amount of pulling action. See Figure 6-26 on page 224.
3 Unscrew the nut on the black collet fitting at each end of the tubing, and pull the pinch valve tubing out of both fittings. Leave both pieces of the fitting on the sample line tubing.

4 Install a new 3-inch piece of pinch valve tubing. See Figure 6-27 on page 225.

a Slip the collet over one end of the new pinch valve tubing.

b Slide the pinch valve tubing over the sample line tubing until approximately 6 mm of the sample line is inside the pinch valve tubing.

c Slide the pinch valve tubing on the inside of the teeth of the nut until it stops.

d Couple both pieces of the fitting together and then tighten until finger-tight.

e Repeat steps a through d at the other end of the tubing.

f Check to see that both ends of the new pinch valve tubing are held securely in the compression fittings.
5 Install the new pinch valve tubing into the slot in the pinch valve.

Make sure the tubing goes all the way into the back of the slot. The sample line can drip if the pinch tubing is not all the way into the slot in the pinch valve.

**Cleaning the Camera Windows**

**Lower Camera Window**

Clean the lower camera window and the diode laser window when you have trouble viewing the side streams or you cannot set the drop delay using Accudrop. Wipe the windows with a soft, lint-free cloth soaked with DI water, and then dry the windows.
Figure 6-28  Lower camera and diode laser windows

Upper Camera Window

Clean the strobe lens and upper camera window when smudges appear in the processed (digitized) image in the Breakoff window, or when dark spots appear to interfere with Sweet Spot monitoring. You might need to clean these components after a clog, or after sheath fluid has leaked or sprayed. Follow the steps in this section to clean the strobe lens and upper camera window.

⚠️⚠️ A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the plate voltage is on. The plates remain energized even when the sort block door is opened.

1  Ensure that the deflection plates are turned off (warning light is not illuminated).

2  Turn off the stream.
3 Open the sort block door.

4 Place 1–2 drops of DI water or ethanol on a cotton swab.

5 Click the Breakoff window and select Raw Image.
   Visible smudges are more apparent in the raw image view.

6 While viewing the image on the Breakoff window, insert the swab just below the bottom of the flow cell.
   The strobe lens and upper camera windows are located behind two circular openings on either side of the top of the sort chamber. You will see the end of the swab in the Breakoff window when you intercept either opening.

7 Gently wipe the upper camera window, and then the strobe lens (opposite the window) to remove any saline.

8 Repeat with isopropyl alcohol or 70% ethanol until clean.
Removing the Deflection Plates

You can remove the deflection plates for cleaning by pulling the plates out using the deflection plate removal tool, supplied in the accessory kit. See Figure 6-29.

Figure 6-29 Deflection plate removal tool

1. Make sure the deflection plates are turned off.
2. Open the sort block door.
3. Slide the deflection plate removal tool behind one of the plates and pull straight out from the sort block.

Hold your thumb on the plate (or use your other hand) as you pull it out so it does not fall as you remove it.

Figure 6-30 Using the deflection plate removal tool
Lubricating the Sample Injection Chamber O-Ring

The O-ring at the bottom of the sample injection chamber should be lubricated as needed to maintain proper operation.

1. Verify that the loading port is in the down position, and open the hinged cover.

2. Check the O-ring (located at the opening in the bottom of the chamber) to see if it is dry.

3. If the O-ring is dry, it must be lubricated with O-ring lubricant from the accessory kit.
   
   a. Remove the clear plastic tube holder from the tube holder base.
   
   b. Apply a small amount O-ring lubricant to the O-ring inside the chamber and to the top, outside beveled edge of the tube holder base. This is where the base contacts the O-ring inside the sample injection chamber.
   
   c. Wipe off any excess lubricant.
   
   d. Replace the tube holder on the base.

*Figure 6-31* Loading port with tube holder removed
Using Custom Optical Filters

If you want to install a custom filter or dichroic, the filter should comply with the following specifications.

Table 6-4  BD FACSARia II filter specifications

<table>
<thead>
<tr>
<th>Filter Characteristic</th>
<th>Dichroic LP Filters</th>
<th>BP Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter</td>
<td>0.622 ±0.003 in.</td>
<td>1.00 ±0.010 in.</td>
</tr>
<tr>
<td>Thickness</td>
<td>0.125 ±0.005 in.</td>
<td>0.12–0.35 in.</td>
</tr>
<tr>
<td>Minimum clear aperture</td>
<td>0.562 in.</td>
<td>0.85 in.</td>
</tr>
<tr>
<td>Incident angle</td>
<td>11 ±1°</td>
<td>0°</td>
</tr>
</tbody>
</table>

For the longpass filters, the surface that faces the center of the octagon/trigon should be coated directly on its surface, not between two or more pieces of glass. The coating should transmit >70% of the wavelength range you want the filter to transmit, with a minimum transmission of >50%, and it should reflect >90% of the wavelength range you want the filter to reflect.

The opposite surface (facing away from the center) should be coated with an anti-reflective coating with a minimum reflection of ≤1% of the wavelength range you want the filter to reflect.

Note that filters must be installed in front of each PMT to block unwanted laser light. For the dichroic, carefully assemble the glass filter in the holder using the retaining spring. Assemble the filter with the arrow pointing toward the center of the octagon or trigon. The angle of the dichroic is critical to achieving optimal results.

Note that any time you modify a detector array, you will need to create a new cytometer configuration to identify which PMT (identified by laser color and letter) will detect the emitted light. See Custom Configurations on page 90 for instructions.
Cleaning the Optical Filters

Optical filters should be inspected occasionally and cleaned as necessary. The frequency will depend on how often the filters are handled.

⚠️ When cleaning or replacing a filter, handle with care to avoid scratching the surface and to prevent the filter from falling out of the holder. Use cotton swabs, optical lens paper, and spectral-grade methanol or absolute ethanol in a dropper bottle (do not use acetone) to clean the optical filters.

1. Wrap a triangular section of the lens paper around the cotton end of a cotton swab. Moisten and seal the end with a few drops of alcohol.

2. Holding the cotton swab in a horizontal position, gently rub any spots on the filter surface and wipe clean.

3. Allow the solvent to evaporate and check the filter surface for streaks.

4. Inspect a ¼-inch–diameter section in the center of the filter for scratches.

   Filters are coated with different dielectrics that can get scratched. If you see scratches, replace the filter.

5. Insert the cleaned filter into the octagon or trigon.

   Make sure the filters are pushed all the way in.
Removing or Installing the FSC ND Filter

For applications involving large particles where events appear off scale on the FSC axis with a voltage of zero, keep the FSC ND filter in place to decrease the FSC signal and keep the events on scale. For applications involving small particles (e.g., bacteria or platelets), you might need to remove the FSC ND filter as follows.

1. Open the flow cell access door.

2. Locate and pull out the FSC ND filter (Figure 6-32).

   The filter is installed at the left end of the FSC detector block, just to the right of the flow cell. To remove the filter, loosen the set screw and pull the filter out of the slot.

   ![Figure 6-32 Removing the FSC ND filter](image)

3. To reinstall the filter, slide it into the slot with the filter side down.

   **NOTE** You can remove the nozzle holder to get better access to the ND filter slot.

232  *BD FACS Aria II User’s Guide*
Troubleshooting

The tips in this section are designed to help you troubleshoot your experiments. Additional troubleshooting information can be found in the *BD FACSDiva Software Reference Manual*.

If additional assistance is required, contact your local BD Biosciences technical support representative. See Technical Assistance on page xv.

Troubleshooting suggestions in this chapter are grouped under the following headings:

- Troubleshooting the Stream on page 234
- Troubleshooting the Breakoff on page 238
- Sorting Troubleshooting on page 239
- Acquisition Troubleshooting on page 244
- Fluidics Troubleshooting on page 251
- Electronics Troubleshooting on page 252
## Troubleshooting the Stream

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream not in center of aspirator</td>
<td>Difference in keyed stream position between nozzles</td>
<td>If you have just changed the nozzle, use an Allen wrench to loosen the screws on either side of the sort block. Adjust the angle of the sort block until the stream flows into the center of the waste aspirator, and then tighten the screws. See Figure 1-12 on page 29.</td>
</tr>
<tr>
<td>Nozzle inserted improperly</td>
<td></td>
<td>Turn off the stream. Remove the nozzle and ensure that the O-ring is in place. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
</tr>
<tr>
<td>Clogged or damaged nozzle</td>
<td></td>
<td>Turn off the stream, remove the nozzle, and examine the nozzle tip under a microscope.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If debris is visible, clean the nozzle. See Cleaning the Nozzle on page 216.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the nozzle appears damaged, replace it. See Changing Nozzles on page 214.</td>
</tr>
</tbody>
</table>
## Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No stream or dripping stream</td>
<td>Nozzle inserted improperly</td>
<td>Turn off the stream. Remove the nozzle. See Changing Nozzles on page 214 for instructions.</td>
</tr>
<tr>
<td></td>
<td>Clogged or damaged nozzle</td>
<td>Turn off the stream, remove the nozzle, and examine the nozzle tip under a microscope.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If debris is visible, clean the nozzle. See Cleaning the Nozzle on page 216.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the nozzle appears damaged, replace it. See Changing Nozzles on page 214.</td>
</tr>
<tr>
<td>Stream control disabled or no stream when Stream control clicked</td>
<td>Air lock in fluidics filter</td>
<td>Prime the system with the corresponding fluid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the control is still disabled, remove the filter, install bypass tubing, and repeat the priming procedure until you see fluid in the line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When fluid is running through the line, remove the bypass tubing, install the filter, and repeat the priming procedure one last time.</td>
</tr>
<tr>
<td></td>
<td>Communication failure between workstation and cytometer</td>
<td>Exit the software and restart it.</td>
</tr>
</tbody>
</table>
### Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No stream when Stream control clicked</td>
<td>Sheath tank low or empty</td>
<td>Refill the sheath tank. See Refilling the Sheath Tank on page 123.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note that when the empty tank warning message is not dismissed after 15 minutes, the stream shuts off automatically.</td>
</tr>
<tr>
<td></td>
<td>Air in sheath line</td>
<td>Prime the sheath tank. See Prime After Tank Refill on page 196.</td>
</tr>
<tr>
<td></td>
<td>Air in sheath filter</td>
<td>Purge the sheath filter. See Purging the Sheath Filter on page 200.</td>
</tr>
<tr>
<td></td>
<td>Dry filter</td>
<td>Open the bleeder valve to purge the filter. See Purging the Fluid Filters on page 200.</td>
</tr>
<tr>
<td>Fanning around center stream</td>
<td>Nozzle inserted improperly</td>
<td>Re-insert the nozzle. Push it gently all the way forward without rocking it from side to side.</td>
</tr>
<tr>
<td>Unstable stream</td>
<td>Debris in flow cell or nozzle</td>
<td>Remove the nozzle and run the stream with no nozzle in place for approximately 10 seconds. (Click the Stream control on, then off.) Sonicate the nozzle and re-install it.</td>
</tr>
<tr>
<td>Fluid line connected to ethanol shutdown tank</td>
<td></td>
<td>Move fluid and air lines to sheath tank, then perform Fluidics Startup.</td>
</tr>
</tbody>
</table>
## Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leaking or spraying around nozzle</td>
<td>Defective or damaged nozzle O-ring</td>
<td>Replace the O-ring.</td>
</tr>
<tr>
<td></td>
<td>Nozzle inserted improperly</td>
<td>Turn off the stream. Remove the nozzle. See Changing Nozzles on page 214 for instructions.</td>
</tr>
<tr>
<td></td>
<td>Extra O-ring is blocking the nozzle</td>
<td>Remove the nozzle and use a cotton swab to clear out the cuvette.</td>
</tr>
<tr>
<td>Drop breakoff is too long</td>
<td>Bubbles in flow cell</td>
<td>Open the flow cell access door and check for bubbles in the flow cell. If they are visible, turn off the stream, wait a few seconds, and turn on the stream again.</td>
</tr>
<tr>
<td></td>
<td>Attenuation is on</td>
<td>Turn off attenuation.</td>
</tr>
<tr>
<td></td>
<td>Amplitude is too low</td>
<td>Increase the amplitude until you can see drops. If you need a very high amplitude (&gt;70 volts) to see drops, you might have air bubbles in the flow cell.</td>
</tr>
<tr>
<td></td>
<td>Nozzle inserted improperly</td>
<td>Turn off the stream. Remove the nozzle and ensure that the O-ring is in place. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
</tr>
<tr>
<td>Problems using Auto Delay feature</td>
<td>Stream is not stable</td>
<td>Make sure stream is stable before starting to run auto delay.</td>
</tr>
<tr>
<td></td>
<td>Diode laser does not fully intercept the sorting streams</td>
<td>Adjust the diode laser to intercept streams in the middle, producing biggest and brightest spots in the left and center images.</td>
</tr>
<tr>
<td></td>
<td>Event rate is too low or too high</td>
<td>Adjust flow rate to increase or decrease event rate.</td>
</tr>
</tbody>
</table>
Troubleshooting the Breakoff

Use the following examples to help troubleshoot problems with the breakoff image.

<table>
<thead>
<tr>
<th>Normal stream image</th>
<th>Abnormal stream image</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Nozzle inserted improperly</td>
<td>Remove the nozzle and re-insert it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Nozzle inserted improperly or orifice is off center</td>
<td>Remove the nozzle and re-insert it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Partial clog</td>
<td>Remove the nozzle, clean it, and then re-insert it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wet or dirty strobe lens</td>
<td>Clean the lens as described in Cleaning the Camera Windows on page 225.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Attenuation is on at wrong pressure</td>
<td>Turn off attenuation in the Side Stream window.</td>
</tr>
</tbody>
</table>
## Sorting Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unstable breakoff while Sweet Spot is engaged</td>
<td>Residual ethanol in system</td>
<td>Allow the system to run until the breakoff stabilizes.</td>
</tr>
<tr>
<td>Target Drop 1 value is out of range for drop spacing</td>
<td>Use an actual Drop 1 value for the target. Remember to repeat the drop delay setup each time the target value is changed.</td>
<td></td>
</tr>
<tr>
<td>Nozzle is clogged or inserted improperly</td>
<td>Turn off the stream. Remove the nozzle and clean it. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
<td></td>
</tr>
<tr>
<td>Dirty strobe lens or upper camera window</td>
<td>Clean the lens and the window as described in Cleaning the Camera Windows on page 225.</td>
<td></td>
</tr>
<tr>
<td>Air in sheath filter</td>
<td>Purge the sheath filter.</td>
<td></td>
</tr>
<tr>
<td>Debris in flow cell or nozzle</td>
<td>Remove the nozzle and run the stream with no nozzle in place for approximately 10 seconds. (Click the Stream control on, and then off.) Sonicate the nozzle and re-install it.</td>
<td></td>
</tr>
<tr>
<td>Center stream image is dim or not visible in the Side Stream window</td>
<td>Camera window is dirty</td>
<td>Clean the lower camera window. See Cleaning the Camera Windows on page 225.</td>
</tr>
<tr>
<td>Stream is not intercepting the diode laser</td>
<td>Adjust the micrometer dial on the laser to make the stream intercept as bright as possible. See Figure 1-20 on page 38.</td>
<td></td>
</tr>
</tbody>
</table>
## Sorting Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center stream is off center when the plate voltage is turned on</td>
<td>Voltage center too low or too high</td>
<td>Adjust the Voltage Center slider to put the center stream back to center.</td>
</tr>
<tr>
<td></td>
<td>Saline spray on deflection plates or in sort block</td>
<td>Clean the deflection plates and the area around them.</td>
</tr>
<tr>
<td>Arcing between deflection plates</td>
<td>Salt bridge</td>
<td>Clean and dry the deflection plates and the area around and behind the plates.</td>
</tr>
<tr>
<td>ACDU sorting failure</td>
<td>Insufficient stream voltage</td>
<td>Increase the voltage for the far left stream.</td>
</tr>
<tr>
<td></td>
<td>Splash shield not installed</td>
<td>Install the splash shield. See Installing the Sorting Hardware on page 179.</td>
</tr>
<tr>
<td>Side stream position reversal, where the streams appear to be associated with the wrong voltage slider.</td>
<td>Voltage sliders are set too far in or too far out.</td>
<td>Move sliders in or out so they control the correct side streams.</td>
</tr>
</tbody>
</table>
### Sorting Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No deflection or insufficient deflection</td>
<td>Insufficient voltage</td>
<td>• Increase the side-stream voltages using the slider controls.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Increase the plate voltage.</td>
</tr>
<tr>
<td>Stream-charging wire is loose or missing</td>
<td>Verify the stream-charging wire is inserted all the way into the barb.</td>
<td></td>
</tr>
<tr>
<td>Salt bridge</td>
<td>Turn off the stream. Remove the nozzle. See Changing Nozzles on page 214 for instructions.</td>
<td></td>
</tr>
<tr>
<td>Sorting paused because actual Drop 1 value is out of range</td>
<td>Wait until the Sweet Spot adjusts the amplitude to achieve the Drop 1 target. If this happens repeatedly during sorting, there might be debris in the nozzle or flow cell. See Troubleshooting the Stream on page 234 for suggestions.</td>
<td></td>
</tr>
</tbody>
</table>
## Sorting Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fanning around center or side streams</td>
<td>Nozzle inserted improperly</td>
<td>Turn off the stream. Remove the nozzle and ensure that the O-ring is in place. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
</tr>
<tr>
<td>Sweet Spot is off</td>
<td></td>
<td>Turn on the Sweet Spot.</td>
</tr>
<tr>
<td>Incorrect sort precision mode</td>
<td></td>
<td>Verify that the sort precision mode is appropriate for your sorting requirements. See Sort Precision Modes on page 73.</td>
</tr>
<tr>
<td>2nd, 3rd, or 4th Drop values not optimized</td>
<td></td>
<td>Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and fine-tune the side streams.</td>
</tr>
<tr>
<td>Particles too big for nozzle</td>
<td></td>
<td>Change the nozzle. See Changing Nozzles on page 214.</td>
</tr>
<tr>
<td>Sort button disabled</td>
<td>Current tube pointer not set to current tube</td>
<td>Click to move the current tube pointer to the appropriate tube.</td>
</tr>
<tr>
<td>Population not listed in Add menu on sort layout</td>
<td>Population defined using snap-to gate</td>
<td>Redefine the population using another gate type.</td>
</tr>
<tr>
<td>Correct sort precision mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viewing sort layout for another tube</td>
<td></td>
<td>Open or create a sort layout for the current acquisition tube.</td>
</tr>
<tr>
<td>Sort layout counters not updating</td>
<td></td>
<td></td>
</tr>
<tr>
<td>High sort conflict rate</td>
<td>Event rate is too high for drop drive frequency</td>
<td>Decrease the event rate.</td>
</tr>
<tr>
<td>Gating conflict</td>
<td></td>
<td>Verify the gating hierarchy.</td>
</tr>
<tr>
<td>Purity mask is too high</td>
<td></td>
<td>Decrease the purity mask.</td>
</tr>
<tr>
<td>Erratic sort rate</td>
<td>Flow rate is too high</td>
<td>Decrease the flow rate.</td>
</tr>
</tbody>
</table>
## Sorting Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexpected sort results</td>
<td>Incorrect drop delay</td>
<td>Reset the drop delay. See Determining the Drop Delay – Manual Method on page 166.</td>
</tr>
<tr>
<td>Determining the Drop Delay – Manual Method on page 166.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incorrect sort precision mode</td>
<td>Verify that the sort precision mode is appropriate for your sorting requirements. See Sort Precision Modes on page 73.</td>
<td></td>
</tr>
<tr>
<td>Sweet Spot is off</td>
<td>Keep the Sweet Spot on during sorting.</td>
<td></td>
</tr>
<tr>
<td>Drop 1 changed after setting drop delay</td>
<td>Reset the drop delay each time you change the Drop 1 value. See Determining the Drop Delay – Manual Method on page 166.</td>
<td></td>
</tr>
<tr>
<td>Laser delay changed after setting drop delay</td>
<td>Reset the drop delay each time you change the laser delay. See Determining the Drop Delay – Manual Method on page 166.</td>
<td></td>
</tr>
<tr>
<td>Incorrect logic in population hierarchy</td>
<td>Verify the gating strategy.</td>
<td></td>
</tr>
<tr>
<td>Sorting parent and child populations into two different tubes</td>
<td>If you try to sort a parent and its child population into two tubes, BD FACSDiva software ignores the child events in both tubes. Create a new subset under the parent population consisting of NOT (child). Sort the child population into one tube and the NOT (child) population into another tube.</td>
<td></td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No events in plots after clicking Load or Acquire Data</td>
<td>Current tube pointer is not set to current tube</td>
<td>Click to move the current tube pointer to the appropriate tube.</td>
</tr>
<tr>
<td></td>
<td>Laser shutter is engaged</td>
<td>Make sure the flow cell access door is completely closed.</td>
</tr>
<tr>
<td></td>
<td>Laser power is off</td>
<td>Turn on the laser power.</td>
</tr>
<tr>
<td></td>
<td>Viewing plots for a different tube</td>
<td>Double-click the current tube in the Browser to display the plots for that tube.</td>
</tr>
<tr>
<td></td>
<td>Incorrect population(s) in plot</td>
<td>Right-click the plot and select Show Populations. Verify that the appropriate populations are displayed.</td>
</tr>
<tr>
<td></td>
<td>Uncolored events in plot</td>
<td>• Format the plot to display all events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign a color to the population displayed in the plot.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify the population drawing order.</td>
</tr>
<tr>
<td></td>
<td>Current cytometer configuration different from optical setup</td>
<td>Verify that the cytometer optics match the current cytometer configuration.</td>
</tr>
<tr>
<td></td>
<td>No sample in the tube</td>
<td>Add sample to the tube or install a new sample tube.</td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No events in plots after clicking Acquire Data (continued)</td>
<td>Sample is not mixed properly</td>
<td>Increase the Sample Agitation rate. See Sample Agitation on page 81.</td>
</tr>
<tr>
<td></td>
<td>Sample line is clogged</td>
<td>Perform a sample line backflush. See Sample Line Backflush on page 195. If necessary, change the sample line.</td>
</tr>
<tr>
<td></td>
<td>Sample filter is clogged</td>
<td>Replace sample filter.</td>
</tr>
<tr>
<td></td>
<td>Threshold not set to the correct parameter (usually FSC)</td>
<td>Set the threshold to the correct parameter for your application.</td>
</tr>
<tr>
<td></td>
<td>Multiple threshold parameters not set correctly</td>
<td>Verify that the correct Boolean logic (And/Or) was used for the threshold parameters.</td>
</tr>
<tr>
<td></td>
<td>Threshold channel too low or too high</td>
<td>Adjust the Threshold channel. See Calculating Compensation on page 148.</td>
</tr>
<tr>
<td></td>
<td>Optical filter(s) not completely seated</td>
<td>Make sure the filters are pushed all the way in.</td>
</tr>
<tr>
<td></td>
<td>FSC area scaling is incorrect</td>
<td>Ensure that the FSC-H matches the FSC-A value.</td>
</tr>
<tr>
<td>No fluorescence signal</td>
<td>Current cytometer configuration different from optical setup</td>
<td>Verify that the cytometer optics match the current cytometer configuration.</td>
</tr>
<tr>
<td></td>
<td>Wrong filter installed or filter not completely seated</td>
<td>Make sure the appropriate filter is installed for each fluorochrome. Make sure the filters are pushed all the way in.</td>
</tr>
<tr>
<td></td>
<td>Laser delay is set incorrectly</td>
<td>Adjust the laser delay settings. See Cytometer Quality Control Using BD FACS DIVA Software on page 314.</td>
</tr>
</tbody>
</table>

*Chapter 7: Troubleshooting* 245
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low area signal</td>
<td>Area scaling is too low</td>
<td>Adjust area scaling for the corresponding laser. See Cytometer Quality Control Using BD FACSDiva Software on page 314.</td>
</tr>
<tr>
<td>Unexpected events in plot</td>
<td>Incorrect logic in population hierarchy</td>
<td>Verify the gating strategy.</td>
</tr>
<tr>
<td>Incorrect population(s) in plot</td>
<td>Right-click the plot and select Show Populations. Verify that the appropriate populations are displayed.</td>
<td></td>
</tr>
<tr>
<td>Incorrect drawing order</td>
<td>Verify that the required population is not hidden by another population. Right-click the plot and select Order Populations by Count.</td>
<td></td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Erratic event rate</strong></td>
<td>Sample aggregates</td>
<td>Filter the sample.</td>
</tr>
<tr>
<td></td>
<td>Bulk injection O-ring is worn</td>
<td>Contact your BD Biosciences service engineer.</td>
</tr>
<tr>
<td></td>
<td>Sample is contaminated</td>
<td>Re-stain the sample, making sure the tube is clean.</td>
</tr>
<tr>
<td></td>
<td>Sheath tank low</td>
<td>Fill the sheath container.</td>
</tr>
<tr>
<td><strong>Unexpectedly high event rate</strong></td>
<td>Threshold channel is too low</td>
<td>Adjust the threshold channel. See Calculating Compensation on page 148.</td>
</tr>
<tr>
<td></td>
<td>Sample is too concentrated</td>
<td>Dilute the sample.</td>
</tr>
<tr>
<td></td>
<td>Flow rate is too high</td>
<td>Decrease the flow rate in the acquisition dashboard.</td>
</tr>
<tr>
<td></td>
<td>Bubbles in flow cell</td>
<td>Turn off the stream, wait a few seconds, and turn on the stream again.</td>
</tr>
<tr>
<td><strong>Unexpectedly low event rate</strong></td>
<td>Sample not adequately mixed</td>
<td>Increase the sample agitation rate. See Sample Agitation on page 81.</td>
</tr>
<tr>
<td></td>
<td>Threshold channel is too high</td>
<td>Adjust the threshold channel. See Calculating Compensation on page 148.</td>
</tr>
<tr>
<td></td>
<td>Sample is too dilute</td>
<td>Concentrate the sample.</td>
</tr>
<tr>
<td></td>
<td>Sample line is clogged or kinked</td>
<td>Backflush the sample line. See Sample Line Backflush on page 195. If necessary, change the sample line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Look for visible kinks in the line. If kinks are found, change the sample line. See Changing the Sample Lines on page 204.</td>
</tr>
</tbody>
</table>
# Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexpectedly low event rate (continued)</td>
<td>Sample line installed incorrectly</td>
<td>Verify the sample line installation. See Changing the Sample Lines on page 204.</td>
</tr>
<tr>
<td></td>
<td>Sample aggregates</td>
<td>Filter the sample.</td>
</tr>
<tr>
<td></td>
<td>Memory is full</td>
<td>Compare the processed event rate in BD FACSDiva software with the threshold counter. If the event rate is much lower, exit and then restart the application.</td>
</tr>
<tr>
<td>Distorted populations or high CVs</td>
<td>Cytometer settings adjusted incorrectly</td>
<td>Optimize the scatter parameters. See Calculating Compensation on page 148.</td>
</tr>
<tr>
<td></td>
<td>Flow rate is too high</td>
<td>Decrease the flow rate in the acquisition dashboard.</td>
</tr>
<tr>
<td></td>
<td>Window extension is too low</td>
<td>Increase the window extension.</td>
</tr>
<tr>
<td></td>
<td>Bubbles in flow cell</td>
<td>Turn off the stream, wait a few seconds, and turn on the stream again.</td>
</tr>
<tr>
<td></td>
<td>Nozzle is clogged or dirty</td>
<td>Clean the nozzle as described in Changing Nozzles on page 214.</td>
</tr>
<tr>
<td></td>
<td>Flow cell is dirty</td>
<td>Clean the flow cell with a detergent such as 100% Contrad 70. See Clean Flow Cell on page 188. Let the detergent sit for 5 minutes before turning on the stream.</td>
</tr>
<tr>
<td></td>
<td>Poor sample preparation</td>
<td>Repeat sample preparation.</td>
</tr>
<tr>
<td></td>
<td>Area scaling is too low</td>
<td>Verify area scaling. See Adjusting Area Scaling and Laser Delay on page 316.</td>
</tr>
</tbody>
</table>
**Acquisition Troubleshooting (continued)**

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excessive amount of debris in plots</td>
<td>Threshold channel is too low</td>
<td>Increase the threshold channel. See Calculating Compensation on page 148.</td>
</tr>
<tr>
<td></td>
<td>Dead cells or debris in sample</td>
<td>Examine the sample under a microscope.</td>
</tr>
<tr>
<td></td>
<td>Sample is contaminated</td>
<td>Re-stain the sample, making sure the tube is clean.</td>
</tr>
<tr>
<td>High electronic abort rate (&gt;10% of system event rate)</td>
<td>Window extension is too high</td>
<td>Decrease the window extension.</td>
</tr>
<tr>
<td></td>
<td>Threshold channel is too low</td>
<td>Increase the threshold channel.</td>
</tr>
<tr>
<td></td>
<td>Event rate is too high</td>
<td>Decrease the flow rate in the acquisition dashboard.</td>
</tr>
<tr>
<td></td>
<td>Sample is aggregated</td>
<td>Filter the sample.</td>
</tr>
<tr>
<td></td>
<td>Sample is too concentrated</td>
<td>Dilute the sample.</td>
</tr>
<tr>
<td>Fewer events than expected in gated population</td>
<td>Window extension set incorrectly</td>
<td>Adjust the window extension, if needed. Refer to the BD FACSDiva Software Reference Manual for information.</td>
</tr>
<tr>
<td></td>
<td>Plot is zoomed</td>
<td>Unzoom the plot or make the gate bigger.</td>
</tr>
<tr>
<td></td>
<td>Events left out of the gate</td>
<td>When drawing a gate, make sure events on the axis are included.</td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increasing threshold results in decreased Area signal</td>
<td>Window extension is too low</td>
<td>Slightly increase the window extension to maximize the Area signal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE</strong> Increasing the window extension too much results in more electronic aborts or high CVs.</td>
</tr>
<tr>
<td>Area measurement off-scale while the Height measurement is on scale</td>
<td>Area scaling is too high</td>
<td>Decrease area scaling to move the Area measurement back on scale.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If necessary, adjust area scaling to make the Area measurement match the Height measurement.</td>
</tr>
<tr>
<td>Cannot delete from Parameters, Threshold, Compensation, or Ratio tab views</td>
<td>Row not selected</td>
<td>Select the row using the selection button.</td>
</tr>
<tr>
<td></td>
<td>Data already recorded</td>
<td>Create a new tube.</td>
</tr>
</tbody>
</table>
## Fluidics Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No fluid in line during system prime</td>
<td>Air lock in sheath or fluidics filter</td>
<td>Remove the filter for the corresponding fluid, install bypass tubing, and run Prime After Tank Refill. Repeat the priming procedure until you see fluid in the line. When fluid is running through the line, remove the bypass tubing, install the filter, and repeat the priming procedure one last time.</td>
</tr>
<tr>
<td>Prepare for aseptic sort fails</td>
<td>Air lock in filter</td>
<td>See previous recommendations.</td>
</tr>
<tr>
<td>Fluid line is detached</td>
<td></td>
<td>Verify the fluid line connections on the fluidics cart and on the cytometer. Push firmly on each line to ensure it is connected.</td>
</tr>
<tr>
<td>Fluidics cart air flow &lt;80 psi</td>
<td>Air leak</td>
<td>Contact your BD Biosciences service engineer.</td>
</tr>
<tr>
<td>Fluidics cart air flow &gt;100 psi</td>
<td>Regulator not adjusted properly</td>
<td>Contact your BD Biosciences service engineer.</td>
</tr>
<tr>
<td>Fluid leak under fluidics cart or below side door</td>
<td>Condensation from pressure relief valve</td>
<td>This is a normal phenomenon that occurs when water is condensed from room air. Condensation is greater in humid environments. To avoid slipping, check and wipe up the water daily.</td>
</tr>
<tr>
<td>Sample injection chamber does not close and causes a BISH or BISO error message</td>
<td>O-ring at bottom of sample injection chamber is dry and causing chamber to stick</td>
<td>Lubricate the O-ring and tube holder. See Lubricating the Sample Injection Chamber O-Ring on page 229.</td>
</tr>
<tr>
<td>Bleeder valve is open</td>
<td>Check and close all bleeder valves for fluid and sheath filters.</td>
<td></td>
</tr>
<tr>
<td>Broken fluid line</td>
<td>Contact BD Biosciences.</td>
<td></td>
</tr>
</tbody>
</table>
### Electronics Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Cytometer Disconnected” in Cytometer window</td>
<td>Cytometer power is off</td>
<td>Turn on the cytometer main power.</td>
</tr>
<tr>
<td></td>
<td>Communication failure between workstation and cytometer</td>
<td>- Exit the software and then restart it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If restarting does not work, reset the cytometer electronics: switch off the main power, wait 10 seconds until the system is fully depressurized, and then switch the power back on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Restart the computer and the cytometer.</td>
</tr>
<tr>
<td></td>
<td>Ethernet cable between workstation and cytometer is disconnected</td>
<td>Unplug and then plug in the cable connectors and make sure they are secure.</td>
</tr>
<tr>
<td>IP address changed</td>
<td></td>
<td>Enter the correct IP address. Call BD Biosciences for assistance.</td>
</tr>
<tr>
<td>“Master DAQ Overflow” in Cytometer window</td>
<td>Event rate is too high</td>
<td>Decrease the event rate or verify the threshold.</td>
</tr>
<tr>
<td></td>
<td>Dirty flow cell</td>
<td>Clean the flow cell. See Clean Flow Cell on page 188.</td>
</tr>
<tr>
<td>“Cytometer not responding” in Status tab</td>
<td>Unknown</td>
<td>Perform the suggestions for a communication failure, above.</td>
</tr>
</tbody>
</table>
Technical Specifications

- Cytometer Specifications on page 254
- Fluidics Cart Specifications on page 259
Cytometer Specifications

Table 8-1  Cytometer Specifications

<table>
<thead>
<tr>
<th>Cytometer dimensions</th>
<th>Height: 71 cm (28 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width: 122 cm (48 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 71 cm (28 in.)</td>
</tr>
<tr>
<td>Table (optional)</td>
<td>Height: 85.1 cm (33.5 in.)</td>
</tr>
<tr>
<td></td>
<td>Width: 266.7 cm (105 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 134.6 cm (53 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>approximately 181.4 kg (400 lb.)</td>
</tr>
<tr>
<td>Power requirements</td>
<td>100/115/230 VAC and 50 or 60 Hz</td>
</tr>
<tr>
<td>Power consumption (maximum)</td>
<td>1500 watts</td>
</tr>
</tbody>
</table>

Environment

Table 8-2  Required Operating Conditions

<table>
<thead>
<tr>
<th>Storage temperature</th>
<th>1–40°C (34–104°F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>15–30°C (59–86°F)</td>
</tr>
<tr>
<td>Operating relative humidity</td>
<td>5–80% (noncondensing)</td>
</tr>
<tr>
<td>Noise level</td>
<td>less than or equal to 62 dBA</td>
</tr>
<tr>
<td>Facilities</td>
<td>No special room requirements</td>
</tr>
</tbody>
</table>
## Performance

### Table 8-3 Performance Specifications

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluorescence Resolution</td>
<td>Coefficient of variation PI-Area of &lt;3.0%, full G\textsubscript{0}/G\textsubscript{1} peak for propidium iodide (PI)-stained chicken erythrocyte nuclei (CEN) Coefficient of variation Hoechst-Area of &lt;3.5%, full G\textsubscript{0}/G\textsubscript{1} peak for Hoechst-stained CEN</td>
</tr>
<tr>
<td>Fluorescence Linearity</td>
<td>Doublet/singlets ratio for CEN stained with PI = 1.95–2.05 detected off the 488-nm laser or Hoechst = 1.95–2.05 detected off the 405-nm laser or 375-nm laser</td>
</tr>
<tr>
<td>Forward and side scatter sensitivity</td>
<td>Sensitivity enables separation of fixed platelets from noise, identification of bacteria, and 0.5-micron beads.</td>
</tr>
<tr>
<td>Sample Acquisition Rate</td>
<td>Maximum acquisition rate: 70,000 events per second with 8 parameters, 12 compensation pairs. Maximum rate &lt;70,000 events per second with more parameters, &gt;100,000 events per second with fewer parameters.</td>
</tr>
</tbody>
</table>
## Sort Performance

**Table 8-4  Sort performance specifications**

<table>
<thead>
<tr>
<th>Drop Drive Frequency</th>
<th>Range from 1 to 100,000 Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purity and Yield</td>
<td>At 70 psi and 90 kHz with an average threshold rate of 25,000 events per second for a four-way sort results in a purity of &gt;98% and a yield &gt;80% of Poisson’s expected yield.</td>
</tr>
<tr>
<td>Viability</td>
<td>Sorts were performed at a variety of sheath pressures using cell lines and human peripheral blood mononuclear cells. All sorts resulted in cells that proved viable and proliferated for several days post-sort.</td>
</tr>
<tr>
<td>Sort Collection Devices</td>
<td>Two-way sorting into the following sample tube collection devices: microtubes, 12 × 75 mm, and 15 mL. Four-way sorting into the following sample tube collection devices: microtubes and 12 × 75 mm. Automatic Cell Deposition Unit (ACDU) option allows for slide and plate sorting into 6, 24, 48, 96, and 384-well plates</td>
</tr>
<tr>
<td>Sample Collection Cooling</td>
<td>Water recirculator for refrigeration/heating (optional)</td>
</tr>
<tr>
<td>BD FACS Accudrop</td>
<td>633-nm red-diode laser provided for quick drop-delay. Automatic drop determination in software</td>
</tr>
</tbody>
</table>
Excitation Optics

Laser Specifications

The following class 3B lasers are mounted on the cytometer.

**Table 8-5  Laser specifications**

<table>
<thead>
<tr>
<th>Laser</th>
<th>Manufacturer</th>
<th>Model</th>
<th>Wavelength (nm)</th>
<th>Power (mW)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Excitation Lasers</strong></td>
<td>Coherent®</td>
<td>Sapphire™ 488-20</td>
<td>488</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>JDS Uniphase™</td>
<td>1144-P</td>
<td>633</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Point Source™</td>
<td>iFlex 2000™-P-1-405-0.65-10</td>
<td>405</td>
<td>30</td>
</tr>
<tr>
<td><strong>Illumination Laser</strong></td>
<td>StokerYale/Lasiris</td>
<td>SNF-701L-660-35-1 deg single-line laser</td>
<td>660</td>
<td>35</td>
</tr>
</tbody>
</table>

a. Measured out of fiber optic cable

**NOTE** For specifications on the Near UV laser (375 nm), see Specifications on page 273.

Emission Optics

**Table 8-6  Emission optics specifications**

<table>
<thead>
<tr>
<th>Emission optics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optical coupling</td>
<td>Quartz cuvette flow cell is gel-coupled by refractive index-matching optical gel to the fluorescence objective lens for optimal collection efficiency. Numerical aperture is equal to 1.2.</td>
</tr>
<tr>
<td>Forward Scatter Detector and Filters</td>
<td>Photodiode detector with a 488/10 bandpass filter</td>
</tr>
<tr>
<td>Side Scatter Detector</td>
<td>Photomultiplier with 488/10 bandpass</td>
</tr>
<tr>
<td>Fluorescence Detectors and Filters</td>
<td>Three fixed fiber apertures (200-micron separation)</td>
</tr>
</tbody>
</table>
## Detector Arrays

### Table 8-7 Default setup for detector arrays

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror</th>
<th>BP Filter</th>
<th>Intended Fluorochrome or Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octagon (488-nm blue laser)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td>PE-Cy™7</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>655</td>
<td>695/40</td>
<td>PerCP-Cy5.5™ or PI, PerCP, PE-Cy5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>610</td>
<td>616/23</td>
<td>PE-Texas Red®</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>556</td>
<td>585/42</td>
<td>PE or PI</td>
</tr>
<tr>
<td></td>
<td>E</td>
<td>502</td>
<td>530/30</td>
<td>FITC, GFP, Alexa 488</td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>—</td>
<td>488/10*</td>
<td>Side scatter (SSC)</td>
</tr>
<tr>
<td>Trigon (633-nm red laser)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td>APC-Cy7, APC-H7</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>660/20</td>
<td>APC</td>
<td></td>
</tr>
<tr>
<td>Trigon (405-nm violet laser)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>502</td>
<td>530/30</td>
<td>Alexa Fluor® 430/Am Cyan</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>450/40</td>
<td>Cascade Blue®, Pacific Blue™, DAPI, Hoechst, Alexa Fluor® 405</td>
<td></td>
</tr>
</tbody>
</table>

*a. The optical holder for the 488/10 BP filter also includes a 1.0 ND filter.*
## Fluidics Cart Specifications

<table>
<thead>
<tr>
<th>Table 8-8  Fluidics cart specifications</th>
</tr>
</thead>
</table>
| **Dimensions** | Height: 66 cm (26 in.)  
                  Width: 81 cm (32 in.)  
                  Depth: 66 cm (26 in.) |
| **Weight** | 81.7 kg (180 lb.) fluidics cart only, excluding tanks |
| **Facilities** | No air supply or vacuum required.  
                   (Optional) Can be connected to facility air supply |
| **Containers** |  
                   • One 10-L stainless steel sheath tank  
                   • One 5-L stainless steel ethanol shutdown tank  
                   • One 10-L plastic waste container  
                   • Three 5-L plastic fluid containers, for bleach, DI water, and ethanol |
Appendix A

Supplies and Consumables

This appendix provides a list of supplies and options that are available for the BD FACS Aria II cytometer.

- To order spare parts and consumables from BD Biosciences from within the US, call (877) 232-8995 or go to bdbiosciences.com.

  Outside the US, contact your local BD Biosciences representative.

- To order cytometer options, contact your sales representative.

This information is correct at the time of publication. For up-to-date information, refer to our website (bdbiosciences.com).

- Cytometer Supplies on page 262
- Consumables on page 267
## Cytometer Supplies

### Optical Components

The following filters and mirrors are mounted on the BD FACS Aria II cytometer. Use these part numbers if you need to order any replacement components. See Using Custom Optical Filters on page 230 for instructions.

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror BP Filter</th>
<th>Replacement Part No.</th>
<th>Intended Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octagon (488-nm blue laser)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>735</td>
<td>343787</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>780/60</td>
<td>343788</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>655</td>
<td>343789</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>695/40</td>
<td>343790</td>
<td>PerCP-Cy5.5 or PI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>675/20</td>
<td>343791</td>
<td>PerCP</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>610</td>
<td>640879</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>616/23</td>
<td>640880</td>
<td>PE-Texas Red®</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>556</td>
<td>343794</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>585/42</td>
<td>343796</td>
<td>PE or PI</td>
</tr>
<tr>
<td></td>
<td>E</td>
<td>502</td>
<td>343797</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>530/30</td>
<td>343798</td>
<td>FITC</td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>488/10</td>
<td>343799</td>
<td>SSC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.0 ND filter</td>
<td>53-10057-01</td>
<td></td>
</tr>
<tr>
<td>Trigon (633-nm red laser)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>735</td>
<td>343787</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>780/60</td>
<td>343788</td>
<td>APC-Cy7</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>660/20</td>
<td>343800</td>
<td>APC</td>
</tr>
</tbody>
</table>

262  BD FACS Aria II User’s Guide
The following filters and mirrors are provided with the violet-laser option.

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror BP Filter</th>
<th>Replacement Part No.</th>
<th>Intended Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigon (405-nm violet laser)</td>
<td>A</td>
<td>502</td>
<td>343797</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>530/30</td>
<td>343798</td>
<td>Alexa Fluor® 430</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>450/40</td>
<td>343801</td>
<td>Cascade Blue®, Pacific Blue™, Hoechst, DAPI, Alexa Fluor® 405</td>
</tr>
</tbody>
</table>

The FSC photodiode is provided with a 1.0 ND filter. Other filters are available as options. Use the following part numbers to replace the filter.

<table>
<thead>
<tr>
<th>Detector</th>
<th>ND Filter</th>
<th>Replacement Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSC photodiode</td>
<td>0.5</td>
<td>33710407</td>
</tr>
<tr>
<td></td>
<td>1.0</td>
<td>33710807</td>
</tr>
<tr>
<td></td>
<td>1.5</td>
<td>338651</td>
</tr>
<tr>
<td></td>
<td>2.0</td>
<td>338652</td>
</tr>
</tbody>
</table>

To order a filter holder, use the following part numbers.

<table>
<thead>
<tr>
<th>Holder</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror holder</td>
<td>336103</td>
</tr>
<tr>
<td>Mirror retainer</td>
<td>345662</td>
</tr>
<tr>
<td>Mirror backup spring</td>
<td>344979</td>
</tr>
<tr>
<td>Filter holder</td>
<td>336102</td>
</tr>
<tr>
<td>Filter retainer</td>
<td>333830</td>
</tr>
</tbody>
</table>
## Accessory Kit

The cytometer is shipped with an accessory kit containing the following items. Use these part numbers if you need to order any replacements.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-mL microtube holder</td>
<td>333457</td>
</tr>
<tr>
<td>12 x 75-mm test tube holder</td>
<td>333456</td>
</tr>
<tr>
<td>15-mL centrifuge tube holder</td>
<td>333430</td>
</tr>
<tr>
<td>Four-way 1-mL collection tube holder</td>
<td>641614</td>
</tr>
<tr>
<td>Four-way 12 x 75-mm collection tube holder</td>
<td>641454</td>
</tr>
<tr>
<td>Two-way 12 x 75-mm collection tube holder</td>
<td>641613</td>
</tr>
<tr>
<td>Two-way 15-mL collection tube holder</td>
<td>641612</td>
</tr>
<tr>
<td>O-ring for collection-tube holder (3)</td>
<td>337897</td>
</tr>
<tr>
<td>Spare nozzles:</td>
<td></td>
</tr>
<tr>
<td>• 70 micron</td>
<td>642976</td>
</tr>
<tr>
<td>• 85 micron (2)</td>
<td>642978</td>
</tr>
<tr>
<td>• 100 micron</td>
<td>642977</td>
</tr>
<tr>
<td>• 130 micron</td>
<td>642979</td>
</tr>
<tr>
<td>Nozzle locking lever (spring and plunger included)</td>
<td>643686</td>
</tr>
<tr>
<td>Nozzle O-rings</td>
<td>333084</td>
</tr>
<tr>
<td>Magnifying glass</td>
<td>337599</td>
</tr>
<tr>
<td>Sample injection tubing (12-inch lengths)</td>
<td>641059</td>
</tr>
<tr>
<td>Sample injection tubing (7-inch lengths)</td>
<td>641475</td>
</tr>
<tr>
<td>Ferrule</td>
<td>335108</td>
</tr>
<tr>
<td>Ferrule-removal tool</td>
<td>335690</td>
</tr>
<tr>
<td>Collet</td>
<td>19-66455-00</td>
</tr>
</tbody>
</table>
## Appendix A: Supplies and Consumables

<table>
<thead>
<tr>
<th>Item</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collet nut</td>
<td>19-66456-00</td>
</tr>
<tr>
<td>Pinch valve tubing</td>
<td>641900</td>
</tr>
<tr>
<td>Sample line filters (35 micron)</td>
<td>643152</td>
</tr>
<tr>
<td>Sample line filters (50 micron)</td>
<td>643153</td>
</tr>
<tr>
<td>Contrad 70 detergent</td>
<td>99-30109-00</td>
</tr>
<tr>
<td>Sheath fluid filter</td>
<td>331394</td>
</tr>
<tr>
<td>Fluid filter</td>
<td>643687</td>
</tr>
<tr>
<td>Air filter, inline, 3 micron</td>
<td>641913</td>
</tr>
<tr>
<td>Disposable waste tank caps (pack of 12)</td>
<td>338854</td>
</tr>
<tr>
<td>Cap for 5-L container (5)</td>
<td>335916</td>
</tr>
<tr>
<td>Lubricant for O-rings</td>
<td>347306</td>
</tr>
<tr>
<td>O-ring pick tool</td>
<td>331430</td>
</tr>
<tr>
<td>Deflection plate removal tool</td>
<td>643197</td>
</tr>
<tr>
<td>Allen wrench set</td>
<td>98-10004-00</td>
</tr>
<tr>
<td>Adapter tray for microscope slides</td>
<td>335630</td>
</tr>
<tr>
<td>Power cords:</td>
<td></td>
</tr>
<tr>
<td>• Main power cord</td>
<td>333694</td>
</tr>
<tr>
<td>• Cordset for continental Europe</td>
<td>334140</td>
</tr>
<tr>
<td>• Cordset for UK</td>
<td>334141</td>
</tr>
<tr>
<td>• Cordset for Australia/Asia</td>
<td>334175</td>
</tr>
</tbody>
</table>
Other Replacement Parts

The following items are not included in the accessory kit, but you can use the indicated part numbers to order spare or replacement parts.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoclavable 10-L container</td>
<td>340261</td>
</tr>
<tr>
<td>Auxiliary 5-L container</td>
<td>333504</td>
</tr>
<tr>
<td>Sheath sensor probe</td>
<td>642012</td>
</tr>
<tr>
<td>Waste sensor probe (6-level)</td>
<td>334915</td>
</tr>
<tr>
<td>Auxiliary sensor probe (non-ethanol)</td>
<td>343835</td>
</tr>
<tr>
<td>Auxiliary sensor probe (ethanol)</td>
<td>642874</td>
</tr>
<tr>
<td>Air filter for cabinet (side door)</td>
<td>334351</td>
</tr>
<tr>
<td>Air filter for ACDU cabinet (set of 3)</td>
<td>334821</td>
</tr>
<tr>
<td>ULPA filter and tubing replacement kit (set of 3, for use with the AMO)</td>
<td>334822</td>
</tr>
</tbody>
</table>
## Consumables

### Cytometer Setup Particles

<table>
<thead>
<tr>
<th>Particle</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD Calibrite™ beads</td>
<td>BD Biosciences</td>
<td>349502</td>
</tr>
<tr>
<td>• Two-color kit (unlabeled, FITC, PE)</td>
<td></td>
<td>340486</td>
</tr>
<tr>
<td>• Three-color kit (unlabeled, FITC, PE, PerCP)</td>
<td></td>
<td>340497</td>
</tr>
<tr>
<td>• PerCP beads</td>
<td></td>
<td>345036</td>
</tr>
<tr>
<td>• PerCP-Cy5.5 beads</td>
<td></td>
<td>340487</td>
</tr>
<tr>
<td>• APC beads</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluoresbrite® Yellow-Green 2-µm beads (for the 405-nm laser)</td>
<td>Polysciences Inc. (800) 523-2575</td>
<td>18604</td>
</tr>
<tr>
<td>SPhero Rainbow Calibration Particles, 3.0–3.4 µm</td>
<td>BD Biosciences</td>
<td>559123 (8 peaks)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>556286</td>
</tr>
<tr>
<td></td>
<td></td>
<td>556291 (brightest peak in 556286)</td>
</tr>
<tr>
<td>BD FACS Accudrop beads</td>
<td>BD Biosciences</td>
<td>345249</td>
</tr>
<tr>
<td>BD Cytometer Setup and Tracking (CS&amp;T) beads</td>
<td>BD Biosciences</td>
<td>641319 (1 vial)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>642412 (3 vials)</td>
</tr>
</tbody>
</table>
# Reagents

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD FACSFlow sheath fluid</td>
<td>BD Biosciences</td>
<td>340398 (US and Latin America)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>342003 (other countries)</td>
</tr>
<tr>
<td>BD™ FACSRinse detergent</td>
<td>BD Biosciences</td>
<td>340346</td>
</tr>
<tr>
<td>BD FACSClean solution</td>
<td>BD Biosciences</td>
<td>340345</td>
</tr>
<tr>
<td>Ethanol</td>
<td>Various</td>
<td>–</td>
</tr>
<tr>
<td>Chlorine bleach (5% sodium hypochlorite)</td>
<td>Clorox® or other major supplier (to ensure that the bleach is at the correct concentration and free of particulate matter)</td>
<td>–</td>
</tr>
<tr>
<td>Monoclonal antibodies</td>
<td>BD Biosciences</td>
<td>–a</td>
</tr>
<tr>
<td>Dyes and fluorochromes</td>
<td>Molecular Probes (800) 438-2209</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Sigma (800) 325-3010</td>
<td></td>
</tr>
<tr>
<td>BD FACS™ lysing solutionb</td>
<td>BD Biosciences</td>
<td>349202</td>
</tr>
</tbody>
</table>

a. Refer to the BD Biosciences Immunocytometry Products Catalog or the BD Biosciences website [bdbiosciences.com].
b. US Patent Nos. 4,654,312; 4,902,613; 5,098,849
## Labware

<table>
<thead>
<tr>
<th>Item</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-mL microtubes</td>
<td>Bio-Rad Laboratories</td>
<td>223-9391</td>
</tr>
<tr>
<td></td>
<td>(800) 424-6723</td>
<td>(1,000 per box)</td>
</tr>
<tr>
<td>5-mL polystyrene test tubes,</td>
<td>BD Biosciences</td>
<td></td>
</tr>
<tr>
<td>12 × 75-mm (BD Falcon™)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- uncapped, 125 per bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- capped, 125 per bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- capped, 25 per bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- with cell-strainer cap,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25 per bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15-mL conical centrifuge tubes</td>
<td>BD Biosciences</td>
<td></td>
</tr>
<tr>
<td>(BD Falcon)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Polypropylene, 50/bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Polypropylene, 125/bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Polypropylene, 50/rack</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Polystyrene, 125/bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Polystyrene, 50/rack</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B

Near UV Laser Option

The Near UV laser option for the BD FACS Aria II system features a 375 nm, solid state laser that enables sorting and analysis of side populations. This Near UV laser uses the same emission pathways as the violet laser option, and the laser alignment is fixed and requires no adjustments once it is installed.

The Near UV laser can be added at the factory as an option on a new instrument, or it can be installed by a BD Field Service Engineer into an existing system in the field.

Figure B-1  BD FACS Aria II system with Near UV laser installed
System Laser Configurations

The BD FACSAria II systems can be configured as two-laser, three-laser, or four-laser systems. See Table B-1 for the system configurations. See Figure B-2 for an illustration of the laser power toggle switch on a four-laser system.

Table B-1 BD FACSAria II laser configurations

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Blue Laser (488 nm)</th>
<th>Red Laser (633 nm)</th>
<th>Violet Laser (405 nm)</th>
<th>Near UV Laser (375 nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-laser</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Three-laser (with Violet)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Three-laser (with Near UV)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Four-laser</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**NOTE** In a four-laser system, you can use either the violet or the Near UV laser, but you cannot use them at the same time.

Figure B-2 Violet/Near UV laser toggle switch

272 BD FACSAria II User’s Guide
Specifications

<table>
<thead>
<tr>
<th>Laser</th>
<th>Nominal Wavelength (nm)</th>
<th>Power (mW)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Near UV laser</td>
<td>375</td>
<td>7</td>
</tr>
</tbody>
</table>

Safety

Make sure that everyone working with the system with the Near UV laser installed is familiar with safety details in the *BD FACS Aria II Safety and Limitations Manual*. 
Selecting Optical Filters

When using the Near UV laser for side population studies, you can install a different set of filters in the far-left trigon. The filter set is supplied with the system when the Near UV option is installed. This set is optimized for side population stem cell applications. See Table B-2 for the part numbers and intended dyes and Figure B-3 for the locations in the trigon.

Table B-2 Part numbers for filters for Near UV trigon

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror BP Filter</th>
<th>Replacement Part No.</th>
<th>Intended Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigon (375 nm Near UV laser)</td>
<td>A</td>
<td>610 LP</td>
<td>640879</td>
<td>Hoechst-Red, PI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>670 LP</td>
<td>642328</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>450/20</td>
<td>642329</td>
<td>Hoechst-Blue, DAPI, Pacific Blue™, Cascade Blue®</td>
</tr>
</tbody>
</table>

Figure B-3 Trigon with Near UV filters installed for side population studies
Creating a Custom Configuration

The Near UV laser uses the same PMT detectors as the violet laser, but typically with different filters installed for optimizing side population studies. We recommend that you set up a custom configuration for the Near UV laser in BD FACSDiva software, using the CS&T application. See Figure B-4.

Figure B-4  Three-laser system configuration with Near UV laser
Switching From the Violet to the Near UV Laser

The system should be turned on and all cytometer startup procedures performed before using the Near UV laser. Refer to Cytometer Startup on page 114 for information on these procedures. This section provides an overview of the steps involved in switching to the Near UV laser in a four-laser system.

1. Place the Near UV/OFF/Violet laser switch in the Near UV position.

   This turns on the Near UV laser and turns off the violet laser. Allow the Near UV laser to warm up for 30 minutes before recording data.

2. Set the cytometer configuration to a custom configuration that includes parameters for the Near UV laser.

   It is a good practice to include Near UV in the configuration name, for example, 70-70 Near UV. This is especially helpful in a four-laser system.

⚠️ Verify that the custom configuration contains the correct parameters for use with the Near UV laser. The system will not perform correctly if this is not done.

3. Ensure that the appropriate optical filters for Near UV operation are installed into the far-left trigon. See Figure B-3 on page 274.

4. Make sure the cytometer has a valid performance check or perform QC.

You are now ready to set up and perform your experiment using the Near UV laser.
Switching Back to the Violet Laser

NOTE Depending on the application, the filters for the standard violet laser can also be used with the Near UV laser.

This section provides an overview of the main steps.

1. Place the UV/Off/Violet laser switch in the Violet position.
   This turns off the Near UV laser and turns on the violet laser. Allow the violet laser to warm up for 30 minutes before recording data.

2. Set the cytometer configuration to a configuration with violet laser parameters.

   Verify the configuration contains the correct parameters for use with the violet laser. The system will not perform correctly if this is not done.

3. Install the correct optical filters the violet laser in the far-left trigon.

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror BP Filter</th>
<th>Replacement Part No.</th>
<th>Intended Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigon (405-nm violet laser)</td>
<td>A</td>
<td>502</td>
<td>343797</td>
<td>Alexa Fluor® 430</td>
</tr>
<tr>
<td></td>
<td></td>
<td>530/30</td>
<td>343798</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>450/40</td>
<td>343801</td>
<td>Cascade Blue®, Pacific Blue™, Hoechst, DAPI, Alexa Fluor® 405</td>
</tr>
</tbody>
</table>

4. Make sure the cytometer has a valid performance check or perform QC.
Side Population Application Guidelines

The Near UV laser on the BD FACSAria II cytometer is very effective for use in applications involving side population (SP) studies. See Figure B-5 on page 279 for a typical plot from a side population experiment.

Instrument Setup

1  Turn on Near UV laser and allow it to warm up for 30 minutes.

2  Make sure the cytometer configuration is set to a configuration with Near UV parameters.

3  Ensure that the side population filter set is in the Near UV (far-left) trigon.

   Place the 670 LP filter (Hoechst Red) in detector A with 610 LP mirror in front. Place the 450/20 filter (Hoechst Blue) in detector B. See Figure B-3 on page 274.

4  Make sure the cytometer has a valid performance check or perform QC.

Experiment Setup Tips

1  Set the parameters to linear in the experiment.

2  Create a Hoechst Red vs Hoechst Blue dot plot.

3  Add a FSC vs PI dot plot if you want to discriminate dead cells from viable ones.

4  Set the sample temperature to 4°C by selecting Cytometer > Sample Temperature.

5  Set the sample flow rate to as low as possible to achieve the best CVs.

   Sample concentration should be between 1 and 2 million cells per mL of buffer.
6 Adjust the voltages so that the red blood cells are seen in the lower left corner and the dead cells line up on the vertical line to the far right.

7 The bulk of the rest of the cells can be centered. It should be possible to identify a major G₀/G₁ population with S/G₂.

8 Collect a file of 50,000 to 100,000 of live gated events.

SP prevalence is ~0.02 to 0.05% of total.

9 If sorting, sort into tubes/plate containing small volume of DMEM containing 10% FBS and 10 mmol HEPES. Keep sample chilled at 4°C.

Tip Sort rare event samples into polypropylene tubes. Avoid polystyrene tubes.

Figure B-5 Typical plot from side population experiment
## Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signals dim or noisy</td>
<td>Wrong laser turned on (Near UV instead of violet, or vice-versa).</td>
<td>Turn laser power switch to correct position.</td>
</tr>
<tr>
<td></td>
<td>Laser delay set incorrectly (possible holdover from setting on other laser).</td>
<td>Recalibrate laser delay.</td>
</tr>
<tr>
<td>No signal</td>
<td>Laser shutter closed (presumably because flow cell access door is open).</td>
<td>Close flow cell access door.</td>
</tr>
<tr>
<td></td>
<td>Laser power switch set to OFF.</td>
<td>Turn switch to Near UV.</td>
</tr>
<tr>
<td></td>
<td>Laser power switch set to violet laser instead of Near UV.</td>
<td>Turn switch to Near UV.</td>
</tr>
<tr>
<td>No signals for side population application</td>
<td>Wrong filters installed.</td>
<td>Install filters for side population application.</td>
</tr>
</tbody>
</table>
Appendix C

BD Aerosol Management Option

The BD™ aerosol management option (AMO) is a device that promotes the containment of aerosols by evacuating the sort collection chamber in the BD FACSARia II flow cytometer. The option uses an attached vacuum source to rapidly evacuate aerosolized particles through an ultra-low penetrating air filter during routine sorting or analysis.

The following topics are described in this guide:

- Option Components on page 282
- Operating the BD Aerosol Management Option on page 284
- Maintenance on page 289
- Troubleshooting on page 296
- Specifications on page 299
Option Components

The BD Aerosol Management Option (AMO) includes the following:

- An evacuator to generate negative pressure
- An ultra-low penetrating air (ULPA) filter to trap particles, with attached tubing that connects the evacuator to the instrument
- An air filter for the sort collection chamber door
- A hinged cover on the sample injection chamber

The AMO also requires the splash shield in the BD FACSaria II accessory kit.

⚠️ The BD Aerosol Management Option does not eliminate the health risks of working with biohazardous material and must be used in conjunction with good laboratory practice.

The BD Aerosol Management Option is For Research Use Only. It is not for use in diagnostic or therapeutic procedures.

Evacuator

The evacuator holds the ULPA filter and attached tubing. Air flow is controlled using pushbuttons within a membrane panel on the front of the unit. The evacuator sits on castor wheels for easy maneuverability. It can be moved using the handle attached to the unit. See Figure C-1 on page 283.
ULPA Filter

The ULPA filter used in the BD AMO captures and retains 99.9999% of all particles down to and including particles 0.01 microns in size. For particles of this size, only 1 out of 1,000,000 passes through the ULPA filter (on average).
Operating the BD Aerosol Management Option

Starting Up the Evacuator

**NOTE** Before starting up the evacuator, make sure that the ULPA filter is completely seated against the bottom of the evacuator filter well, and that the tubing is securely attached to the filter and instrument manifold.

! Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling instrument hardware. Wear suitable protective clothing and gloves.

1 Install the splash shield or the tube holder below the aspirator drawer (Figure C-3 on page 285).

The splash shield is required for sorting into a multiwell plate or onto a slide.

To install the splash shield:

a Close the sort block door and open the sort collection chamber door, if needed. (The sort block door must be closed in order to open the collection chamber door.)

b Remove the tube holder, if one is installed.

c Insert the splash shield into the slotted fittings below the sort aspirator drawer. (See Figure C-3 on page 285.) Push the splash shield all the way in.
Ensure that an air filter is installed in the sort collection chamber door. The filter traps airborne dust that could clog the ULPA filter. Note that the filter should be changed on a monthly basis. See Replacing the Air Filter on page 294.

3 Close the sort collection chamber door.

**NOTE** The sort collection chamber door must be closed for the evacuator to generate negative pressure in the chamber.

4 Switch on the main power on the back of the evacuator (Figure C-4 on page 286).
5 Press the POWER button on the membrane panel of the evacuator.

6 Press the up or down arrow button to set the suction control rate to 20%.

   Each time either arrow button is pressed, the suction will increase or decrease by 10%. When two lights are lit on the suction control indicator, the actual air flow is the value between the two illuminated percentages.

⚠ Do not set the suction control rate above 20%. Higher rates could affect the stability of the side streams.

7 Verify that the filter flow gauge reads less than 2.4 inches of H₂O (Figure C-5 on page 287).

   For a new filter, the gauge should read 1.1–1.4 inches of H₂O. As the filter is used, the reading will increase. If the gauge reads 2.4 inches of H₂O or greater, replace the filter. See Replacing the ULPA Filter on page 290.
Setting Up for Sorting

Refer to your instrument manual for instructions.

1 Start up the flow cytometer system.

2 Start up the evacuator as described in the previous section.

3 Follow the standard sort setup procedure.

**NOTE** Always start up the evacuator before setting up for sorting. If you start up the evacuator after sort setup is complete, you will need to repeat the setup procedure.
Opening the Sort Collection Chamber Door

Cell sorters that use droplet generation methods, like the BD FACSaria II, can produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block door and the sort collection chamber door closed during sorting. Follow these steps to stop sample flow and evacuate potential aerosols before opening the sort collection chamber door.

1. Use one of the following options to stop sample flow into the sort collection chamber.
   - Click the Move Drawer control to close the aspirator drawer and sort sample into waste.
   - Click the Acquire button to stop sample acquisition without unloading the sample tube.
   - Click Unload to stop acquisition and unload the sample tube.

2. Press the up arrow button repeatedly to increase the suction to 100%.

3. Wait at least 30 seconds before opening the sort chamber doors to allow potentially hazardous aerosols to evacuate.

4. Place the system in standby by pressing the POWER button on the membrane panel of the evacuator.

5. Open the sort collection chamber door.

Tip Remember to decrease the suction control rate to 20% when you return to sorting samples.
Turning Off the Evacuator

Turn off the evacuator after you have finished running biohazardous samples.

1. Place the system in standby by pressing the POWER button on the membrane panel of the evacuator.

2. Switch off the main power on the back of the evacuator (Figure C-4 on page 286).

Maintenance

Use the following guidelines to ensure optimal performance of the BD Aerosol Management Option.

- Change the ULPA filter and attached tubing when the flow gauge indicator is >2.4 at a 20% flow setting or when the red filter-life indicator LED is blinking. See Replacing the ULPA Filter on page 290.

  Two spare filters and replacement tubing are included with the AMO. To order additional replacement kits, contact your local BD Biosciences representative.

  All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle the ULPA filter and attached tubing as if capable of transmitting infection. Dispose of waste using proper precautions and in accordance with local regulations. Wear suitable protective clothing, eyewear, and gloves.

- Change the air filter in the sort collection chamber door on a monthly basis. The filter traps airborne dust that could clog the ULPA filter. Regular replacement of the air filter will extend the life of your ULPA filter. See Replacing the Air Filter on page 294.

- Do not touch the Filter Life Reset button during normal operation. Doing so could shut down the evacuator and prevent the collection of aerosols.
• Do not disconnect the tubing from the instrument manifold outlet or the ULPA filter unless you are changing the filter. Repeated removal and reattachment of the tubing could loosen the connection and disrupt airflow.

• To ensure optimal airflow, keep the tubing free of kinks and away from sharp or heavy objects. Do not crush or puncture the tubing. Ensure that the tubing is securely attached at both ends before turning on the evacuator power.

• Keep the sort collection chamber free of potentially obstructive debris, such as Kimwipes® or disposable pipettes.

Replacing the ULPA Filter

Replace the filter when either of the following conditions occur:

• The filter-flow gauge reads 2.4 inches of H₂O or greater at 20% suction.

• The red filter-life indicator LED is blinking.

**NOTE**  When the red light turns on and is not blinking, you have approximately 1 hour of filter life remaining. If the red light comes on during sorting, the filter will not stop working. Replace the filter as soon as possible when the red light starts blinking.

To replace the ULPA filter, do the following:

1. **Turn off the evacuator main power and disconnect the electrical plug.**

   To prevent potential shock, always turn off the evacuator main power and disconnect the electrical plug from the power source before installing or removing any filter.

2. **Disconnect the tubing from the manifold (Figure C-6 on page 291).**

   The manifold is located in the connection panel on the left side of the instrument.
3 Remove the spring-loaded filter hold-down. While pushing down on the filter, pull up on the spring-loaded handle (Figure C-7A), and guide the handle over the top of the filter and behind the metal plate in the back of the evacuator (Figure C-7B).

**Figure C-6** Disconnecting tubing (side of instrument)

**Figure C-7** Removing the filter hold-down
4 Lift off the ULPA filter and attached tubing from the evacuator and dispose of both the filter and the tubing.

⚠️ All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle the ULPA filter, attached tubing, and all instrument hardware as if capable of transmitting infection. Dispose of waste using proper precautions and in accordance with local regulations. Wear suitable protective clothing, eyewear, and gloves.

5 Insert the new ULPA filter into the evacuator filter well (Figure C-8).

Figure C-8 Inserting new filter

6 Push down on the filter to ensure that it is seated against the bottom of the filter chamber (Figure C-9 on page 293).
NOTE For optimal evacuation of aerosols, the filter must be completely seated in the evacuator filter well.

7 Lift the spring-loaded filter hold-down and place it on top of the filter.

8 Press and hold the Filter Life Reset button on the membrane panel for 5–10 seconds.

The green and amber LED lights will turn off, and then on. Hold down the button until the 100% indicator light is lit. This resets the 180-hour filter life clock.

9 Connect one end of the replacement tubing to the ULPA filter, and the other end to the tubing manifold (Figure C-10 on page 294).
NOTE For optimal evacuation of aerosols, ensure that the tubing is securely connected at both ends.

10 Connect the evacuator power plug to the power source.

Replacing the Air Filter

To extend the life of your ULPA filter, we recommend that you replace the air filter on a monthly basis. The filter traps airborne dust that could clog the ULPA filter. Regular replacement of the air filter will extend the life of your ULPA filter.

1 Open the sort collection chamber door and remove the air filter.

Push the filter toward the left side of the door until you can grasp it, and then slide the filter out of the door.
2 Install a new air filter in the door.

Slide the new filter in from the left.

**NOTE** Make sure to install the filter with the grid side facing up when the door is open.

Grid side (faces up when door open)  Non-grid side (faces out when door closed)
Troubleshooting

The tips in this section are provided to help you troubleshoot issues that arise when using the BD Aerosol Management Option. For instrument-specific troubleshooting, refer to your instrument manual.

If additional assistance is required, contact your local BD Biosciences technical support representative or supplier.

⚠️ If any of the following are observed, assume the AMO is not evacuating properly, and do not open the doors to the sort chamber.

Control Panel Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evacuator indicator lights off</td>
<td>Evacuator power cord unplugged</td>
<td>Connect the evacuator power cord to the power source.</td>
</tr>
<tr>
<td></td>
<td>Evacuator power switched off</td>
<td>Switch on the evacuator main power. See Figure C-4 on page 286.</td>
</tr>
<tr>
<td></td>
<td>Evacuator motor failure</td>
<td>Contact your local BD technical support representative.</td>
</tr>
<tr>
<td></td>
<td>Circuit breaker tripped</td>
<td>Depress the circuit breaker on the rear of the evacuator into its original position.</td>
</tr>
<tr>
<td></td>
<td>Site power failure</td>
<td>Turn off the evacuator power switch and wait for site power to be restored.</td>
</tr>
<tr>
<td>Evacuator indicator lights pulsing</td>
<td>Erratic power source</td>
<td>Plug the power cord into a different outlet.</td>
</tr>
</tbody>
</table>

296  BD FACSARia II User’s Guide
Control Panel Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys not responding</td>
<td>Improper operation</td>
<td>Push each button firmly before removing your finger from the control.</td>
</tr>
<tr>
<td></td>
<td>Defective membrane panel</td>
<td>Contact your local BD technical support representative.</td>
</tr>
<tr>
<td>Red filter-life indicator light on</td>
<td>Approaching 180 hours of filter use</td>
<td>Monitor the light. When it blinks, change the filter.</td>
</tr>
<tr>
<td></td>
<td>Filter life not reset after filter change</td>
<td>After changing the filter, press and hold the Filter Life Reset button until the 100% indicator light is lit.</td>
</tr>
<tr>
<td>Red filter-life indicator blinking</td>
<td>Filter used over 180 hours</td>
<td>Replace the filter.</td>
</tr>
</tbody>
</table>
## Filter Flow Gauge Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero reading on filter flow gauge</td>
<td>Power off</td>
<td>Press the POWER button on the membrane panel of the evacuator.</td>
</tr>
<tr>
<td>Filter defective</td>
<td>Replace the filter.</td>
<td></td>
</tr>
<tr>
<td>Filter improperly seated in evacuator</td>
<td>Reseat the filter with the evacuator power off.</td>
<td></td>
</tr>
<tr>
<td>Tubing loose or not connected</td>
<td>Ensure that the tubing is securely connected below the sort chamber and to the filter module.</td>
<td></td>
</tr>
<tr>
<td>Tubing kinked or damaged</td>
<td>Inspect the tubing for kinks or punctures. Replace the tubing, if needed.</td>
<td></td>
</tr>
<tr>
<td>Wrong tubing type or part</td>
<td>Ensure that the correct type of tubing is in use.</td>
<td></td>
</tr>
<tr>
<td>Erratic reading on filter flow gauge</td>
<td>Defective filter</td>
<td>Replace the filter.</td>
</tr>
<tr>
<td>Filter improperly seated in evacuator</td>
<td>Reseat the filter with the evacuator power off.</td>
<td></td>
</tr>
</tbody>
</table>
| Off-scale reading on filter flow gauge | Tubing or sort collection chamber obstructed | • Inspect the tubing for kinks or punctures. Replace the tubing, if needed.  
• Check for obstructions in the sort collection chamber. Remove any obstruction. |
| Filter clogged or saturated | Replace the filter as described on page 290. |
Specifications

Specifications for the BD Aerosol Management Option are as follows.

Evacuator

- ≥7 CFM (ft³/min) normal operation rate (20% suction control)
- ≥30 CFM boost evacuation (100% suction control)
- <35 lb unpacked weight

ULPA Filter Module

- VLSI grade
- Traps particles ≥0.01 µm
- Three-stage filtration (pre-filter, ULPA, post filter)
- Particulate removal efficiency >99.9999%

Air Filter

- Filter media is an open-cell polyurethane foam
- Media specially coated for improved fire-retardation and fungi resistance
- High dust-trapping capacity, low air resistance
- Can be used in a wide variety of climatic conditions
- Rated UL 94 HF-1
Appendix D

Temperature Control Option

The BD™ temperature control option can be used to control the temperature of sorted samples in the BD FACSArria II flow cytometer.

The following topics are described in this guide:

- Option Components on page 302
- Using the BD Temperature Control Option on page 303
- Maintenance on page 310
- Specifications on page 311
Option Components

The BD temperature control option includes the following:

- A recirculating water bath
- Specially designed collection tube holders with ports for recirculating water

Tube holders are available for 15-mL two-way sorting and 12 x 75-mm four-way sorting.

Figure D-1 Temperature control option components

When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block door and the sort collection chamber door closed during sorting. We recommend that you use the BD Aerosol Management Option when sorting biohazardous samples into the temperature control tube holders.

The BD temperature control option is For Research Use Only. It is not for use in diagnostic or therapeutic procedures.
Using the BD Temperature Control Option

Note that before you start the recirculating water bath, you must attach the tubing to the appropriate collection device.

Setting Up the Water Bath

1. Remove the threaded plug from the output port on the water bath.

2. Ensure that the drain cock on the back of the water bath is closed by turning it fully clockwise.

3. Set the pump outflow to maximum by turning the knob fully counterclockwise.

   Remove the top cover to access the knob, which is located inside the water bath towards the back. See the Operating Instructions supplied with water bath for additional details on this process. This is referred to as position 1.

4. Connect the clear tubing end of the insulated hoses to the input and output ports on the water bath. (See Figure D-2 on page 304.)

   Slide the tubing over the hose barbs and twist gently while installing to get the tubing completely over the barbs.
5 Connect the insulated hoses from the recirculating water bath to the cytometer control panel.

**NOTE** Make sure you match the flow direction from the water bath port to the flow direction on the instrument manifold. The instrument ports are labeled “cooling in” and “cooling out.”

6 Fill the water bath with distilled water containing 0.1 g/L sodium carbonate.

Sodium carbonate helps reduce corrosion. Refer to the water bath manufacturer’s documentation for fill levels and other setup information.

7 Plug in the water bath power cord.
NOTE Do not start up the water bath until after you have connected the recirculating water tubing, as described in the following sections.

Setting Up the Tube Holder

This section describes how to install the temperature control tube holder on the instrument and how to attach the recirculating water tubing to the tube holder.

Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1 Place collection tubes in the temperature control tube holder.

Tube holders are available for 15-mL two-way sorting and 12 x 75-mm four-way sorting. For compatible tubes, refer to Appendix A.

2 Attach the recirculating water tubing to the tube holder.

Close the sort block door and open the sort collection chamber door, if needed. (The sort block door must be closed in order to open the collection chamber door.)

Note that the tubing ports are labeled In and Out. Attach the input tubing to the port on the left side of the collection tube holder, and the output tubing to the port on the right side, as shown in Figure D-4 on page 306.

To attach the tubing, push it into the port until the tubing snaps into place.
If you need to remove the tubing, push in the orange collar as you pull the tubing out of the port.

3 Install the tube holder on the instrument.

Remove the current tube holder (if one is installed), and slide the temperature control tube holder into the slotted fittings below the sort aspirator drawer. Push the tube holder all the way in.

4 Close the sort collection chamber door and start up the water bath.
Setting Up the ACDU Stage

This section describes how to attach the recirculating water tubing to the stage used with the automated cell deposition unit (ACDU).

⚠️ Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1. Install the splash shield below the aspirator drawer.
   - a. Close the sort block door and open the sort collection chamber door, if needed. (The sort block door must be closed in order to open the collection chamber door.)
   - b. Remove the tube holder, if one is installed.
   - c. Insert the splash shield into the slotted fittings below the sort aspirator drawer. Push the splash shield all the way in.

2. Click the Access Stage button to bring the ACDU stage to the front.
   - a. Open an Experiment, if one is not already open, and create a sort layout for any of the Tubes.
   - b. In the Sort Layout view, click the Access Stage button ( ) to move the stage to the front of the sort collection chamber.

3. Attach the recirculating water tubing to the ACDU stage.

   Note that the tubing ports are labeled In and Out. Attach the input tubing to the port on the left side of the stage, and the output tubing to the port on the right side, as shown in Figure D-5 on page 308.

   To attach the tubing, push it into the port until the tubing snaps into place.
If you need to remove the tubing, push in the orange collar as you pull the tubing out of the port.

4 Install the required collection device on the stage.

5 Close the sort collection chamber door and start up the water bath.
Starting Up the Water Bath

NOTE To ensure that the sample collection device is at the correct temperature, start up the water bath at least 30 minutes (115 V model) or 60 minutes (110 V model) before you start sorting.

1 Switch on the main power on the water bath control panel.

2 Use the up or down arrow keys to set the required temperature.

NOTE To achieve the required sample temperature, you will need to set the water bath temperature slightly higher or lower (see Table D-1). These settings might need adjustment depending on the ambient temperature in your laboratory. We recommend that you calibrate the water bath for your operating environment.

Table D-1 Water bath settings for corresponding sample temperature

<table>
<thead>
<tr>
<th>Required Sample Temp (°C)</th>
<th>Water Bath Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>37</td>
<td>37.5</td>
</tr>
<tr>
<td>42</td>
<td>43.2</td>
</tr>
</tbody>
</table>
3 Wait at least 30 minutes (115 V model) or 60 minutes (110 V model) to allow the recirculating water reach the required temperature.

Maintenance

To maintain the recirculating water bath, refer to the documentation provided by the manufacturer.

Tube Holders

Remove the tube holders when you are finished using them, and clean them periodically before storage.

⚠ When you detach the recirculating water tubing from the tube holder, any fluid remaining in the tubing can leak into the sort collection chamber. To ensure that fluid is aspirated from the sort collection chamber, make sure the sort chamber aspirator pump is on (ie, do not turn off the instrument main power) before you detach the tubing. Use caution when handling tubing containing hot water.

To detach the recirculating water tubing, push in the orange collar as you pull the tubing out of the port.

Clean the temperature control tube holders by wiping them down with an appropriate cleaning fluid (ie, 70% ethanol, 5% bleach, deionized water). Dry them with a lint-free cloth before storage.

Recirculating the Water Tubing

Inspect the tubing periodically for leaks, plugs, or contaminants. If needed, remove the tubing and clean it with an appropriate cleaning solution, or replace the tubing. Contact your BD Biosciences service representative for replacement tubing.
Specifications

Specifications for the recirculating water bath are as follows.

**NOTE** The following specifications are for the US version only.

The temperature control option includes the Lauda® Ecoline cooling/heating bath, model RE 106.

- Operating temperature range: –20 to 120°C
- Ambient temperature range: 5 to 40°C
- Heater power for 115 V/60 Hz: 1.3 kW
- Maximum flow rate at pump output of 5: 17 L/min
- Maximum bath volume: 4–6 L
- Power consumption for 115 V/60 Hz: 1.4 kW

For more information, refer to the manufacturer’s documentation.
Appendix E

QC Using BD FACSDiva Software

This appendix contains information on performing the quality control procedure using BD FACSDiva software.
Perform cytometer quality control (QC) to ensure consistent performance over time. During cytometer QC, you want to keep as many variables as constant as possible. For example, always use the same QC particle type and lot number, sheath pressure, and PMT settings. If you work with different sheath pressures, you might consider having a separate QC experiment for each pressure.

When the experiment, cytometer settings, and QC sample are constant, changes in the recorded means and coefficients of variation (CVs) indicate changes in cytometer performance over time. QC data should be analyzed for trends over 30–60 runs.

This section describes how to use a QC experiment template to verify laser delay and area scaling values, and how to record parameter means and CVs for a fluorescent bead. For examples of fluorescent particles that can be used for cytometer QC, see Cytometer Setup Particles on page 267.

**NOTE** QC results are affected by laser and fluidics performance. We strongly recommend following the laser and fluidics maintenance procedures in Chapter 6.

### Setting Up the Cytometer Configuration

The cytometer configuration includes these settings:

- Fluorochromes
- Filters and mirrors
- Sheath pressure (must match sheath pressure in sort setup)
- Nozzle size
- Window extension
The steps in this section show you how to set up the cytometer configuration in preparation for performing QC.

1. Select Cytometer > View Configurations, which opens the Cytometer Configuration window in the CS&T module. See Figure 3-5 on page 86.

   **NOTE** When you select Cytometer > View Configurations, the cytometer disconnects from the BD FACSDiva interface and connects to the CS&T interface. While the CS&T module is running, BD FACSDiva is in a holding mode and does not accept any user input. When CS&T is closed, BD FACSDiva becomes active again.

2. Select a cytometer configuration that contains appropriate settings for the samples you are running.

3. Once the appropriate configuration is selected, click OK in the Cytometer Configuration window to close it.

4. Close the CS&T application by selecting File > Exit. The BD FACSDiva interface is now active and accepting user input.

For accurate data results, the cytometer optics must match the current cytometer configuration. Also, the sheath pressure and sort setup must match the settings in BD FACSDiva.

See Figure E-1 and Figure E-2 for error messages that can occur if the sort setup or sheath pressure are different between the cytometer configuration in CS&T and the values in BD FACSDiva.

**Figure E-1** Possible error message when closing CS&T
Preparing QC Particles

Prepare QC particles, also known as beads, in a 12 x 75-mm tube according to the manufacturer’s instructions. See Table E-1 for one brand of beads that can be ordered from BD.

Table E-1  Bead information

<table>
<thead>
<tr>
<th>BD FACSFlow™ Solution</th>
<th>SPHERO Rainbow Particles (3.0–3.4 microns)</th>
<th>Ordering Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mL</td>
<td>2 to 3 drops</td>
<td>BD Biosciences Cat. No. 556291</td>
</tr>
</tbody>
</table>

Adjusting Area Scaling and Laser Delay

The required area scaling factor changes based on sheath pressure and particle size. The area scaling factors should be verified for each experiment performed on the cytometer.
This section describes how to optimize area scaling and laser delay using the QC template that is included with BD FACSDiva software.

**Setting Up the QC Experiment**

Follow the steps in this section to set up an experiment for instrument QC.

1. Click the corresponding buttons on the Workspace toolbar to display the Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and Acquisition Dashboard ( ) windows, as needed.

   **Tip** As you work in the software, windows can become hidden. You can easily bring a window to the forefront by double-clicking the corresponding button on the Workspace toolbar.

2. Create a folder for the QC experiment.

   In the Browser, select the icon for your database and click the New Folder button on the Browser toolbar.

   Rename the folder *Cytometer QC* or create a Cytometer QC folder inside another folder. Refer to the *BD FACSDiva Software Reference Manual* for ideas on how to organize experiments.

3. Create an experiment from the QC Experiment template.

   Select Experiment > New Experiment, click the General tab, and select the QC Experiment template (Figure E-3). Click OK to add a copy of the template to the Browser.
Add the current month and year to the experiment name, rename the specimen with the type of bead you are running (such as Rainbow beads), and rename the tube with today’s date.

**Adjusting Area Scaling for the Blue Laser**

1. Open the QC experiment by double-clicking the experiment icon. Verify that the Area Scaling worksheet is displayed in the Worksheet window.

2. Click to set the current tube pointer next to the tube with today’s date in the Browser.

3. Install the tube of beads onto the loading port.

4. Click Load in the Acquisition Dashboard.
The loading port rises to enclose the tube within the chamber. Once the tube is loaded, acquisition starts automatically.

5 Set the Events to Display to 500 events.

6 Adjust the FSC and SSC voltages to place the particles within the P1 gate at approximately $100 \times 10^3$ on scale in the FSC-H vs SSC-H dot plot.

a Click the Parameters tab in the Cytometer window.

b Select the voltage field for the parameter you need to adjust.

c To adjust the values you can:

- Click the up and down arrows to adjust the voltages in increments of 1.
- Drag the sliders to adjust the voltages.
- Press the Ctrl key while clicking the on-screen arrows to increase or decrease in increments of 10.
- Press the Ctrl key while pressing the keyboard arrows to increase or decrease in increments of 10.
7 Adjust the FSC area scaling until the FSC-A signal matches the FSC-H signal, if needed.

   a Click the Laser tab in the Cytometer window and check the FSC Area Scaling value.

• If the FSC-A signal is lower than FSC-H, increase FSC area scaling.
• If the FSC-A signal is higher than FSC-H, decrease FSC area scaling.
Figure E-4 FSC area scaling factor set incorrectly (left) and correctly (right)
8. Adjust the FITC voltage to place the FITC-H signal at approximately $100 \times 10^3$.
   
   a. Click the Parameters tab in the Cytometer window.
   
   b. Select the FITC voltage field and adjust the voltage.

9. Adjust the blue laser area scaling until the FITC-A signal matches the FITC-H signal, if needed.

   The blue laser area scaling can be adjusted using any parameter excited by the blue laser.

   a. Click the Laser tab in the Cytometer window.
   
   b. Adjust the area scaling factor for the blue laser.

   - If the FITC-A signal is lower than FITC-H, increase area scaling.
   - If the FITC-A signal is higher than FITC-H, decrease area scaling.
Adjusting Area Scaling and Laser Delay for the Red and Violet Lasers

The laser delay factor in BD FACSDiva software is used to realign the signals so they can be measured and displayed on the same time scale. Signals are aligned with respect to the blue laser, so the blue laser will have a 0 delay value, the red laser will have a negative delay value, and the violet (or Near UV) laser will have a positive delay value.

1. Adjust the APC voltage to place the APC-H signal at approximately $100 \times 10^3$.

   The red laser area scaling and laser delay can be adjusted using any parameter excited by the red laser.

2. Adjust the delay setting for the red laser, if needed.
The Sort Setup enters area scaling and laser delay values from the last time the Sort Setup was used. For this reason, the settings should be close to the appropriate values. You are simply confirming that the values are correct as part of your QC. If adjustments are needed, they should be slight. The delay is properly adjusted when the fluorescence signal intensity is at its highest.

a. Click the Laser tab in the Cytometer window.

b. Change the window extension to 0.
   - If the APC-A signal stayed the same, then go to step e.
   - If the APC-A signal decreased, then follow step c through step e.

c. Click in the Delay field for the red laser.

d. Adjust the laser delay value until the maximum APC-A signal is achieved.
e  Reset the window extension to the appropriate setting (typically 2).

3  Adjust the red laser area scaling until the APC-A signal matches the APC-H signal, if needed.

   Click the Laser tab in the Cytometer window.

   • Increase the area scaling factor if the APC-A signal is lower than APC-H.

   • Decrease the area scaling factor if the APC-A signal is higher than APC-H.

4  Repeat step 1 through step 3 to adjust area scaling and laser delay for the violet (or Near UV) laser, using the appropriate parameter instead of APC.

Recording QC Data

The QC experiment template includes Browser elements, as well as plots and instrument settings. The first time you use the QC experiment template, adjust the settings by placing the signals for each parameter to channel 100,000. The instrument settings you establish will be used for subsequent QC runs.

1  Display the QC worksheet by clicking the QC tab in the Worksheet window.
2 Adjust the PMT voltage for each parameter to set the signal to approximately $100 \times 10^3$.

3 Set the Flow Rate to 1.0 in the Dashboard.

4 Ensure that the current tube pointer is still set to the first tube, and then click Record Data.

   Once the tube has finished recording, the tube icon changes to a tube with a disk. Also, the tube will now have cytometer settings associated with it.

5 After data has been recorded, click Unload in the Dashboard and remove the tube.

6 (Optional) Select File > Print.

   Keep a record of the daily QC results for future reference. By comparing results from day to day, you will be able to monitor instrument performance.

   An example of recorded data is shown in Figure E-6.
Figure E-6  Recorded QC data
Reusing the QC Experiment

The QC experiment was designed so you can reuse it for subsequent QC runs by duplicating the tube without data. Collecting all QC data in the same experiment makes it easy to export the statistics to a QC log.

1  Verify that the cytometer configuration is set to the appropriate configuration for QC.

2  Open the QC experiment.

3  Right-click the most recent tube and select Duplicate without Data.

4  Rename the tube with the current date.

5  Verify that area scaling and laser delay are correct.
   a  Verify that the Area Scaling worksheet is displayed.
   b  Prepare and load a tube with QC particles.
   c  Verify that the FSC and blue laser area scaling factors are set correctly.

**Tip**  You can use the same area scaling values that were determined the last time you ran the QC particles. Highlight the last recorded data file in your QC experiment and find the area scaling values in the Tube tab. Type these numbers into the Cytometer window, Laser tab.
Appendix E: QC Using BD FACSDiva Software

329

Ensure that the red and violet (or Near UV) laser delays are set appropriately by setting the window extension to 0 and verifying that the area signal is not lost. Adjust the laser delay, if necessary.

e Reset the window extension to the appropriate value before verifying the remaining area scaling factors.

f Verify the red and violet laser area scaling factors.

6 Set the Flow Rate to 1.0.

7 Record 10,000 events.

Do not adjust any voltages. You may need to adjust the singlet gate to capture the population in the FSC-A vs SSC-A dot plot.

Tracking QC Results

Monitoring cytometer QC results can provide you with information regarding your instrument’s performance. Changes in mean fluorescence intensity or CV can alert you to possible instrument issues or service procedures that may need to

Appendix E: QC Using BD FACSDiva Software  329
be addressed. To track cytometer performance over time, copy means and CVs for each parameter onto a QC log.

You can also perform batch analysis, which allows you to automatically export a statistics file in comma separated value (CSV) format for a group of tubes. The CSV file can be opened in a spreadsheet application. See Performing a Batch Analysis on page 159 for instructions on this process.
index
amplitude
  about  63
  adjusting  64, 119
analysis
  data  151
  printing  157
  sorting  156, 163, 173
application settings
  about  136
  adjusting area scaling  137
  creating  136
  optimizing PMT voltages  141
  saving  143
applications
  custom  90
  recommended flow rates  47
  recommended sort setup  101
area parameters  58
area scaling
  adjusting  316
  primary laser  318
aspiration sorting  197
aspirator drawer
  about  30
  opening  66, 108, 176
assistance, technical  xv
attenuation control  66
auto drop delay
  about  68
  graph  172
  overview  171
  using  171
autoclaving sheath tank  197
automated cell deposition  See ACDU.

B
backflush, sample line  195
bandpass filters  53
batch analysis, performing  159
BD FACSaria II
  about  17
  cytometer  22
  fluidics cart  18
  workstation  41
BD FACSDiva software  See software.
beads
  Accudrop  168
  calibration  267
  beam splitters  52
  biexponential sort gates  173
  bleeding filters  200
  breaker, circuit  39
  breakoff
    drop  61
    setting up  119
    troubleshooting  119, 238
    window  62
buttons
  See also controls,
  chamber light  25
  emergency stop  40
  Load  98
  power  39

C
  calculating compensation  148
cameras
  about  38, 67
  cleaning windows  225
cap, waste  128
cart, fluidics  18
chambers
  ACDU  32
  sample injection  25
  sort block  29
  sort collection  32
changing
- air filters 211
- fluid filters 202
- nozzles 214
- optical filters 230
- sample lines 204
- waste cap 128
changing drops 68
changing circuit breaker 39
cleaning
- camera windows 225
- cytometer 193, 194
- flow cell 188
- fluidics 197
- mode failure 251
- modes 194
- nozzles 216
- optical filters 231
- strobe lens 226
clogged nozzle 216
closed-loop nozzle
  cleaning 218
  for shutdown 188
  maintenance 218
  replacing tubing 219
coefficient of variation (CV), high 248
collection
- devices 32, 103
- optics 35
compensation
- calculating 148
- controls, creating 147
- gating data 150
- setup 150
components
- BD FACS Aria II system 17
- BD FACS Diva workspace 78, 98
- cytometer 22
- electronics 39
- fluidics 23
- optics 33
- workstation 41
computer
- about 41
- shutting down 189, 193, 201
configuration, cytometer
- about 56, 84, 85
- adding 90
- editing 92
conflicts, sort
- about 69
- counting 108
- printing 110
- saving 106, 174
- troubleshooting 242
connecting
- external air 20
- fluidics cart 19
- power cords 19, 39
containers
- about 18
- autoclaving 197
- emptying waste 127
- refilling 126
controls

See also buttons,
ACDU stage 108
acquisition 97
aspirator drawer 66, 108
attenuation 66
compensation 147
cytometer (software) 79
fluidics 79
optical filter 66, 67
sorting 98, 107
stream 63
Sweet Spot 63
test sort 66
voltage 66

conventions, user’s guide xiv
cooling samples 82, 114
cord
fluidics cart 19, 21
counters, sort 108
creating
analysis objects 156
application settings 136
compensation controls 147
custom devices 100, 184
experiments 317
folders 145, 317
sort layouts 105, 174
sort precision modes 75
statistics view 157
CS&T
See Cytometer Setup and Tracking
custom devices 100, 184
customer support xv
cuvette flow cell
about 27
cleaning 188
cytometer
about 22
adding configurations 90
cleaning 193, 194
configuration 56, 84, 85
controls, software 79
disconnect error 252
doors 22
electronics 39
fluidics 23, 44
not responding 252
optics 33
power 39
QC particles 267
quality control 314
shutting down 188, 190
starting 114
status report 88
supplies 262
workstation 41
Cytometer Setup and Tracking
menu selections 84
overview 130

daily shutdown procedure 188
data
analyzing 151, 156
gating 150, 156
recording 151, 155
recording QC 325
data collection, overview 144
deflection
drop 69
plates 30, 164
troubleshooting 241
deflection plate removal tool 228
deflection plates
removing 228
delay
  drop 66, 67, 166
  See also Accudrop.
laser 59, 323
deleting
  custom devices 186
  sort populations 107
  sort precision modes 75
detectors 36, 50, 56
devices, sorting 103
diode laser 38, 67
discriminating filters 53
doors, sort collection chamber 33
doublets
  discrimination experiment 112
  discrimination gating 145
  eliminating 155
drop
  auto delay 171
  breakoff 61
  charging 68
  conflicts 69
  correction factors 67, 166
  deflection 69
  delay 66, 67, 166
  See also Accudrop.
satellites 120
Drop 1
  about 62, 64
  adjusting 64, 120

E
editing
  cytometer configurations 92
  sort layouts 107
  statistics view 157
electronics
  aborts 249
  about 39
  troubleshooting 252
  emergency stop button 40
  emission spectra 49
  emptying waste 127
error messages
  cleaning mode failure 251
  cytometer disconnected 252
  cytometer not responding 252
  Master DAQ overflow 252
ethanol shutdown tank
  capacity 122
  refilling 125
events
  not showing in plots 244, 246
  rate, troubleshooting 247, 248
  troubleshooting 249
excitation optics 33
Experiment Layout 152
experiments
  Accudrop 112, 167
  creating 317
  cytometer QC 112
  doublet discrimination 112
  QC, setting up 317
  reusing 328
  setting up 152
  sorting 174
  templates 112
exporting sort reports 111, 177

F
FACSAria II See BD FACSAria II
FACSDiva software See software.
ferrules, removing 207, 209
fiber optics 34
filling containers 126
filters

- about 51
- air, changing 211
- bandpass 53
- changing 202, 230
- default setup 258
- discriminating 53
- fluid, changing 202
- holders 263
- longpass 52
- neutral density (ND) 55, 232, 263
- optical, cleaning 231
- purging 200
- removing 202, 232

Fine Tune mode 74

flow cell

- about 27
- cleaning 188
- preventive cleaning 201

flow rate

- adjusting 46, 98
- recommendations 47

fluidics

- about 44
- cart 18
- cleaning 197
- components 23
- connections 19
- containers 18
- controls 79
- daily shutdown 188
- level indicators 83
- power 21
- shutdown 80, 190
- startup 44, 79, 115
- system 44

fluidics cart

- about 18
- dimensions 259
- power 19
- setting up 122
- troubleshooting 251

fluids

- containers 18
- level indicators 83
- movement 44
- priming 127, 196
- recommended 122
- refilling 126

fluorescence

- about 49
- emission spectra 49
- signal, troubleshooting 245

folders, adding 145, 317

forward scatter (FSC)

- detector 56
- ND filter 232, 263
- removing 232

frequency, drop drive 63

FSC See forward scatter.

G

Gap 62, 64

gating

- compensation controls 150
- data 156
- during sorting 173

general safety 40

global worksheets

- adding sort layouts 105, 174
- previewing data 151
- viewing 153

H

hardware, ACDU 179
hazards
  mechanical 40
heating samples 82, 114
height parameters 58
holders
  collection tube 32, 164, 306
  optical filter 263
  sample tube 26
Home Device 100, 181
hydrodynamic focusing 47

I
Initial mode 74
installing
  collection tube holders 164, 306
  nozzle 214
  plates 180, 308
  sample tubes 26
  slides 180, 308
  splash shield 179
instrument
  See cytometer.
specifications 254, 259
interrogation point 27

L
labels
  parameter 152
  label-specific tubes 147
laser delay, adjusting 316
lasers
  about 33
  delay 59, 323
  diode 38, 67
  power 39
  shutting down 189, 193, 201
specifications 257
starting 114
warmup time 114
layout, sort See sort layouts.
leaks, troubleshooting 251
levels
  fluid 83
  sample 25
lever, nozzle 214
light
  detection 50
  injection chamber 25
  scatter signals 48
  voltage warning 30
limitations xvi
Load button 98
loading tubes 26, 46
long clean 251
longpass filters 52

M
maintenance
  scheduled 194
  unscheduled 213
managing aerosols 31
Masks
  about 69
  default precision modes 73
  Phase 72
  Purity 71
  Yield 70
Master DAQ overflow error 252
micrometer dial 38, 169, 172
mirrors, dichroic 52
modes
  defining 75
  deleting 75
  sort precision 69, 73
monitoring sorts 109, 177
Near UV laser
  about 271
  configurations 272
  optical filters 274
  side population guidelines 278
  specifications 273
neutral density filters 55, 232, 263
nozzles
  about 28
  breakoff patterns 121
  changing 214
  cleaning 216
  lever 214
  O-ring 214, 264
recommended sizes 101, 214
spare 264

octagon
  about 35, 36, 50
  default filters 258
opening
  aspirator drawer 66, 108, 176
  sample injection chamber 26
Optical Filter control 66, 67
optical filters
  about 51
  changing 230
  cleaning 231
  default setup 258
  Near UV laser 274

optics
  collection 35
  cytometer 33
  default setup 258
  excitation 33
  fiber 34
  filter holders 263
  reordering 262
  stream-viewing 38
optimizing
  cytometer performance 314
  cytometer settings 144
  drop delay 168
  streams 181
ordering supplies 261
O-ring, nozzle 214, 264

parameters
  about 58
  assigning 56, 85, 90
  labels 152
  measuring 58
  scatter, distorted 248
pausing sorting 62, 108
performance tracking 84
phase 67
Phase Masks
  about 72
  Yield Masks, using with 70, 73
photodiodes 56
photomultiplier tubes (PMTs)
  about 36, 56
  applying voltages 58
  assigning 56, 85, 90
  optimizing for application
  settings 141
pinch valve
  changing tubing 223
  collet fitting 225
plate voltage 67
plates
  deflection 30, 164
  installing 180, 308
  sorting into 179
plots
  excessive debris 249
  no events in 244
  unexpected events in 246
PMTs
  see photomultiplier tubes
populations
  sorting 68, 105, 173, 174
  troubleshooting 242, 249
power
  buttons 39
  cytometer 39
  fluidics cart 19, 21
  laser 39
precision modes 69, 73
  See also sort precision modes.
preferences, default gate color 156
pressure
  air 18, 21
  sample 46
  sheath 44, 80
  troubleshooting 251
preventive cleaning, of flow cell 201
primary laser, verifying area scaling 318
priming fluids 127, 196
printing
  sort reports 111, 177
  worksheets 157
pulse, electronic 57
purging filters 200
Purity Masks 71
Purity mode 73, 174

Q
quality control (QC)
  about 314
  beads 316
  experiment 112
  particles 267
  tracking results 329

R
recording
  data 151, 155
  during sorting 177
  QC data 325
refilling containers 126
removing
  deflection plates 228
  ferrules 207, 209
  filters 202, 230, 232
reports
  cytometer status 88
  printing 111, 177
  sort 110
results, troubleshooting 243
rotating sort block 29, 215

S
safety
  general 40
sample
  agitation 81
  core diameter 47
  flow 46
  injection chamber
    about 25
    lubricating O-ring 229
  interrogation 27
  line
    backflush 195
    changing 204
  pressure 46
  temperature 82, 114
sample line filter
  installing or removing 220
samples, running 155
satellites, drop 120
Save Conflicts 106, 174
saving
  application settings 143
  sort conflicts 106, 174
scaling, area
  primary laser 318
scatter parameters, distorted 248
second laser, adjusting delay 323
sensitivity, cytometer performance 255
settings, optimizing 144
setup, compensation 150
sheath
  flow 44
  fluid 122
  pressure 44, 80
  refilling 126
  reservoir, autoclaving 197
sheath filter, changing 203
sheath tank
  capacity 122
  changing air filter 212
  changing filter 203
  connectors 123
  purging fluid filter 200
  refilling 123
  required location 124
shutdown
  daily procedure 188
shutdown tank, ethanol 122, 125
shutting down
  computer 189, 193, 201
  fluidics 80, 188, 190
  lasers 189, 193, 201
side streams
  optimizing 181
  window 65
signals
  about 48
  detection 50
  fluorescent 49
  generating 57
  low Area 246
  no fluorescent 245
  scattered light 48
  troubleshooting 250
Single Cell mode 74
slides
  installing 180, 308
  sorting into 179
software
  about 41
  cleaning modes 194
  components 78, 98
  cytometer controls 79
  templates 112
sort
  block 29
  collection chamber 32
Sort button 107
sort layouts
  about 68, 103
  creating 105, 174
  custom 100, 184
  editing 107
  entering populations 105, 174
sort precision modes
  4-Way Purity 73, 174
  about 69
  creating 75, 100
  defaults 73
  deleting 75
  Fine Tune 74
  Initial 74
  Purity 73
  Single Cell 74
  Yield 74
sort reports
  about 110
  exporting 111, 177
  printing 111, 177
sort setup values 101, 102
sorting
  about 60, 161
  analysis 156, 163, 173
  aseptic 197
  aspirator drawer control 66, 108
  collection devices 103
  conflicts 69, 106, 108, 174
  controls 98, 107
  counters 108
  experiment 174
  gates 173
  into plates 179
  into slides 179
  into tubes 164
  monitoring 109, 177
  pausing 62, 108
  populations 68, 105, 173, 174
  recording data 177
  report 110
  setup 162
  starting 107, 176
  stopping 107
  troubleshooting 239
specifications
  cytometer 254
  fluidics cart 259
  splash shield, installing 179
  stage, accessing 108
starting
  cytometer 114
  fluidics 44, 79, 115
  lasers 114
  sorting 107, 176
  stream 117
statistics view, creating 157
Stokes shift 49
stop button 40
stopping sorting 107
stream
  centering 66, 166
  control 63
  deflecting 67
  flow rate 45
  starting 117
  troubleshooting 118, 234
  viewing 38
strobe lens, cleaning 226
supplies, cytometer 262
Sweet Spot
  about 61, 62
  control 63
T
tanks See containers.
target events 105, 174
technical assistance xv
temperature
  sample 82
temperature control option
  about 32
  using 302–311
templates, experiment 112
test sort 66
threshold, troubleshooting 250
trigons
  about 35, 36, 50
  default filters 258
troubleshooting
  ACDU 240
  acquisition 244
  breakoff 119, 238
  CVs 248
  deflection 241
  electronic aborts 249
  electronics 252
  event rate 247, 248
  fluidics cart 251
  leaks 251
  low Area signal 246
  populations 242, 249
  pressure 251
  scatter parameters 248
  signals 245, 250
  sort
    conflict rate 242
    counters 242
    results 243
  sorting 239
  stream 118, 234
  threshold 250
tubes
  adding sort layouts 105, 174
  agitating 81
  compensation 147
  heating/cooling 82, 114
  holders 26, 32
  label-specific 147
  loading 26, 46
  sorting into 32, 164
typographical conventions xiv
U
Unload button 98
unloading tubes 26, 46
user preferences 156
V
View Configurations selection 84
viewing global worksheets 153
views
   See also windows.
sort layout 103
voltage
   adjusting PMT 58
   controls 66
   warning light 30

W
waste
   aspirator 30
   cap, changing 128
   emptying 127
width parameters 58
Window Extension, adjusting 324
windows
   See also views.
   about 78, 98
   Acquisition Dashboard 97
   Breakoff 62
   showing 317
   Side Stream 65
worksheets
   printing 157
   viewing 153
workspace
   components 78, 98
   setting up 144
workstation
   about 41
   shutting down 189, 193, 201

Y
Yield Masks
   about 70
   Phase Masks, using with 70, 73
Yield mode 74